OpenEdge Development: Debugging and Troubleshooting
These materials and all Progress® software products are copyrighted and all rights are reserved by Progress Software Corporation. The information in these materials is subject to change without notice, and Progress Software Corporation assumes no responsibility for any errors that may appear therein. The references in these materials to specific platforms supported are subject to change.

Third party acknowledgements — See the “Third party acknowledgements” section on page Preface–9.
# Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>Preface</td>
<td>Preface–1</td>
</tr>
<tr>
<td>Part I</td>
<td>OpenEdge Debugger</td>
<td></td>
</tr>
</tbody>
</table>

## 1. Introduction
- Debugger system requirements | 1–1
- Debugger features and functions | 1–3
  - Application control | 1–3
  - Application data management | 1–5
  - Execution monitoring | 1–5
  - Session management and information | 1–6
- Enabling debugging | 1–7
- Understanding debugging sessions | 1–9
  - Interaction between Debugger and client | 1–9
  - Debugger and application control | 1–9
- Procedures and the Debugger context | 1–11
  - The Debugger context | 1–11
  - Debugger context and the procedure call stack | 1–13
- Debugging in a distributed environment | 1–14
  - Distributed debugging | 1–14
  - Remote debugging | 1–15
  - Compatibility issues | 1–15

## 2. Starting and Stopping the Debugger
- Debugging modes | 2–1
  - Application mode | 2–2
  - Stand-alone mode | 2–3
  - Attachable mode | 2–4
  - Making the process ready for debugging | 2–5
- Stacked applications | 2–9
- Debugging from the Procedure Editor | 2–10
- Debugging from the AppBuilder | 2–11
- Debugging from the ADE Desktop | 2–12
Debugging from the OpenEdge command line ........................................... 2–13
Debugging from alert dialog boxes ......................................................... 2–14
Debugging from an ABL procedure ......................................................... 2–17
Debugging in attachable mode ................................................................. 2–18
  Detaching from the process ............................................................... 2–18

3. **Debugger Window and Files** ................................................................. 3–1
   Debugger window layout ................................................................. 3–2
   Debugger window panes ................................................................. 3–3
     Source code pane ................................................................. 3–3
     ABL stack trace pane ............................................................. 3–4
     Variables pane ................................................................. 3–5
     Watches pane ................................................................. 3–8
   Debugger title bar ................................................................. 3–12
   Debugger menu bar options .......................................................... 3–13
     Accelerator keys and mnemonics ................................................... 3–13
     File menu ................................................................. 3–13
     Edit menu ................................................................. 3–14
     Search menu ................................................................. 3–14
     View menu ................................................................. 3–15
     Debug menu ................................................................. 3–15
     Diagnostics menu ............................................................. 3–17
     Data menu ................................................................. 3–17
     Window menu ................................................................. 3–17
     Help menu ................................................................. 3–18
   Debugger toolbar buttons .............................................................. 3–19
   Debugger status bar ................................................................. 3–21
   Debugger dialog boxes ................................................................. 3–22
     Add Watch dialog box ............................................................ 3–22
     Attach to Process dialog box .................................................... 3–23
     Breakpoints dialog box .......................................................... 3–25
     Dataview dialog box .............................................................. 3–26
     Dynamic Object Tracking dialog box ........................................ 3–32
     Edit Breakpoint dialog box ...................................................... 3–36
     Find dialog box ................................................................. 3–37
     New Breakpoint dialog box ....................................................... 3–38
     Open dialog box ................................................................. 3–44
     Preferences dialog box ............................................................ 3–45
     Select Process dialog box .......................................................... 3–47
   Debugger files ........................................................................... 3–48
     Debug listing files ................................................................. 3–48
     Locating debug listing files in attachable mode ......................... 3–49
     Procedure files and listing generation .................................... 3–49

4. **Using System Handles for Debugging** ................................................. 4–1
   DEBUGGER system handle attributes and methods ................................... 4–2
   Using the DEBUGGER system handle to start and control the Debugger .......... 4–4
     Using the DEBUGGER system handle in application mode .................. 4–4
     Using the DEBUGGER system handle in stand-alone mode .................. 4–6
   Using the SESSION handle to start the Debugger .................................... 4–8
Part II Troubleshooting Resources

5. Logging in OpenEdge .......................................................... 5–1
   Logging infrastructure overview ...................................... 5–2
   LOG-MANAGER system handle attributes and methods ........ 5–3
   DSLOG-MANAGER system handle attributes and methods ...... 5–4
   Log files ................................................................. 5–6
   Specifying the log filename ......................................... 5–6
   Clearing the log file .................................................. 5–7
   Writing user messages to the log file .............................. 5–8
   Closing the log file ................................................... 5–9
   Log size threshold ...................................................... 5–10
   Specifying the log size threshold .................................. 5–10
   Specifying the number of log files retained ..................... 5–11
   Filename for rolled-over log files ................................ 5–12
   srvrLogWatchDogInterval property ................................ 5–12
   Log entry types ......................................................... 5–13
   Specifying log entry types ......................................... 5–16
   Logging levels ........................................................ 5–18
   Specifying the logging level ....................................... 5–18
   Progress Explorer and logging settings ......................... 5–20

6. Log Entry Types Detail ....................................................... 6–1
   ABL message logging .................................................. 6–3
   ABL trace logging ...................................................... 6–4
   ABL transaction logging .............................................. 6–7
   AIA logging .............................................................. 6–9
   AppServer logging ..................................................... 6–10
   Database connection logging ....................................... 6–11
   DataServer logging .................................................... 6–12
   Dynamic object logging .............................................. 6–13
   Logging dynamic object creation and deletion ................... 6–15
   Deleted objects ........................................................ 6–16
   Objects created and deleted implicitly ........................... 6–16
   Logging levels for dynamic objects ............................... 6–17
   Event logging .......................................................... 6–20
   Event generation ....................................................... 6–20
   Event stack .............................................................. 6–20
   Logged events .......................................................... 6–21
   Logged information .................................................. 6–22
   Event log entry types and logging levels ......................... 6–25
   Starting event logging ................................................. 6–26
   Event message formats ............................................... 6–26
   Sample Event logs ..................................................... 6–30
   File access logging .................................................... 6–32
   Ignored operation logging .......................................... 6–33
   NameServer logging ................................................... 6–34
   Query information logging ......................................... 6–35
   Query information log entry type and logging levels .......... 6–35
   Starting query information logging ................................ 6–36
   Generating query information ...................................... 6–38
   Query information logged .......................................... 6–40
   Query plan .............................................................. 6–40
   Query statistics ......................................................... 6–42
   Sample query information logs .................................... 6–47
## Figures

| Figure 1–1: | Debugger/client interaction | 1–9 |
| Figure 1–2: | Procedures inside and outside the Debugger context | 1–13 |
| Figure 2–1: | Debugging in application mode | 2–2 |
| Figure 2–2: | Debugging in stand-alone mode | 2–4 |
| Figure 2–3: | Debugging from the Procedure Editor | 2–10 |
| Figure 2–4: | Debugging from the AppBuilder in Windows | 2–11 |
| Figure 2–5: | Debugging from the ADE Desktop | 2–12 |
| Figure 2–6: | Alert dialog box with Stack Trace Help button | 2–14 |
| Figure 2–7: | Stack Trace dialog box | 2–16 |
| Figure 3–1: | Debugger window | 3–2 |
| Figure 3–2: | Add Watch dialog box | 3–22 |
| Figure 3–3: | Attach to Process dialog box | 3–23 |
| Figure 3–4: | Breakpoints dialog box | 3–25 |
| Figure 3–5: | Dataview dialog box with Attributes tab | 3–27 |
| Figure 3–6: | Dataview dialog box with Fields tab | 3–28 |
| Figure 3–7: | Array elements in the Dataview Array tab | 3–29 |
| Figure 3–8: | Dataview dialog box with Value tab | 3–30 |
| Figure 3–9: | ProDataSet methods and attributes in the Dataview dialog box | 3–31 |
| Figure 3–10: | Dynamic Object Tracking dialog box with Control Monitoring tab | 3–32 |
| Figure 3–11: | Dynamic Object Tracking dialog box with View Objects tab | 3–35 |
| Figure 3–12: | Edit Breakpoint dialog box | 3–36 |
| Figure 3–13: | Find dialog box | 3–37 |
| Figure 3–14: | New Breakpoint dialog box with At Line tab | 3–38 |
| Figure 3–15: | New Breakpoint dialog box with On Error tab | 3–38 |
| Figure 3–16: | New Breakpoint dialog box with Watchpoint tab | 3–39 |
| Figure 3–17: | Watchpoint example | 3–43 |
| Figure 3–18: | Open dialog box | 3–44 |
| Figure 3–19: | Preferences dialog box with Font tab | 3–45 |
| Figure 3–20: | Preferences dialog box with Settings tab | 3–46 |
| Figure 3–21: | Preferences dialog box with Attachable tab | 3–46 |
| Figure 3–22: | Select Process dialog box | 3–47 |
Tables

Table 1–1: The Debugger and mixed client/AppServer releases . . . . . . . . . . . . . . 1–16
Table 3–1: Listing indicators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3–4
Table 3–2: ABL functions supported by the Debugger . . . . . . . . . . . . . . . . . . . . 3–10
Table 3–3: File menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3–13
Table 3–4: Edit menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3–14
Table 3–5: Search menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3–14
Table 3–6: View menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3–15
Table 3–7: Debug menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3–15
Table 3–8: Diagnostics menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3–17
Table 3–9: Help menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3–18
Table 3–10: Toolbar buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3–19
Table 4–1: DEBUGGER system handle attributes . . . . . . . . . . . . . . . . . . . . . . . . 4–2
Table 4–2: DEBUGGER system handle methods . . . . . . . . . . . . . . . . . . . . . . . . . . 4–2
Table 5–1: Specifying component logging characteristics . . . . . . . . . . . . . . . . . . 5–2
Table 5–2: LOG-MANAGER system handle attributes . . . . . . . . . . . . . . . . . . . . . 5–3
Table 5–3: LOG-MANAGER system handle methods . . . . . . . . . . . . . . . . . . . . . . 5–3
Table 5–4: DSLOG-MANAGER system handle attributes . . . . . . . . . . . . . . . . . . . 5–4
Table 5–5: DSLOG-MANAGER system handle methods . . . . . . . . . . . . . . . . . . . . 5–5
Table 5–6: Specifying the log filename . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5–7
Table 5–7: Clearing the log file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5–8
Table 5–8: Writing messages to the log file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5–8
Table 5–9: Closing the log file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5–9
Table 5–10: Specifying the logsize threshold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5–10
Table 5–11: Specifying the number of retained log files . . . . . . . . . . . . . . . . . . . . 5–11
Table 5–12: Log entry types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5–13
Table 5–13: Specifying log entry types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5–17
Table 5–14: Logging levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5–18
Table 5–15: Specifying logging levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5–19
Table 6–1: ABL trace log message entry types . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6–4
Table 6–2: Dynamic objects that are logged . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6–13
Table 6–3: Windows GUI events that are logged . . . . . . . . . . . . . . . . . . . . . . . . . . 6–21
Table 6–4: Information logged for each type of action . . . . . . . . . . . . . . . . . . . . . . 6–23
Table 6–5: Events logged by log entry type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6–25
Table 6–6: SAX parser logging messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6–50
Table 7–1: Program failures and resulting dump files . . . . . . . . . . . . . . . . . . . . . . 7–5
## Examples

Example 7–1: Sample procore file ........................................ 7–2  
Example 7–2: Sample protrace file ........................................ 7–3  
Example 7–3: Sample executable procedure ............................... 7–6  
Example 7–4: Sample -y startup parameter statistics .................... 7–7  
Example 7–5: Sample r-code segment statistics ........................... 7–9  
Example 7–6: Sample procedure call statistics ............................ 7–9  
Example 7–7: Sample STARTUP-PARAMETERS output .................. 7–10  
Example 7–8: Sample XREF option output ................................. 7–12
Preface

This Preface contains the following sections:

- Purpose
- Audience
- Organization
- Using this manual
- Typographical conventions
- Examples of syntax descriptions
- OpenEdge messages
- Third party acknowledgements
Purpose

This book describes the OpenEdge® Debugger and how to use it to find logic errors in ABL (Advanced Business Language) applications. This is both a guide and reference that provides complete information on the Debugger and techniques for using it to monitor and control the execution of ABL procedures.

Audience

The primary audiences for this book are business application developers and OpenEdge system administrators. The secondary audiences are OpenEdge developers and technical support engineers.

Organization

Part I describes how to start, stop, and interact with the Debugger as you debug your code. It is a complete guide to the features, terms, and principles of operation you need to know to use the Debugger effectively. Once you have begun a debugging session, the Debugger online help available from the Help menu of the Debugger window provides most of the information you need to use the Debugger.

Part II describes the logging infrastructure and various types of logging available to troubleshoot your code. It also provides guidelines and direction for using other diagnostic tools available for troubleshooting purposes.

Part I, OpenEdge Debugger

Chapter 1, “Introduction”

Describes the features of the Debugger and how it interacts with an ABL application.

Chapter 2, “Starting and Stopping the Debugger”

Describes how to start and end a debugging session in all supported operating environments.

Chapter 3, “Debugger Window and Files”

Describes the Debugger user interface and files created or referenced by the Debugger.

Chapter 4, “Using System Handles for Debugging”

Describes how to use the DEBUGGER and SESSION handles, which are ABL system handles that allow you to start the Debugger and control some Debugger features from an procedure.
Part II, Troubleshooting Resources

Chapter 5, “Logging in OpenEdge”

Describes the enhanced logging infrastructure.

Chapter 6, “Log Entry Types Detail”

Describes the various types of logging that enhanced logging supports.

Chapter 7, “Other Diagnostics Resources”

Describes other diagnostics tools and aids available to developers.

Using this manual

OpenEdge provides a special purpose programming language for building business applications. In the documentation, the formal name for this language is ABL (Advanced Business Language). With few exceptions, all keywords of the language appear in all UPPERCASE, using a font that is appropriate to the context. All other alphabetic language content appears in mixed case.

For the latest documentation updates see the OpenEdge Product Documentation Overview page on PSDN: http://communities.progress.com/pcom/docs/DOC-16074.

References to ABL compiler and run-time features

ABL is both a compiled and an interpreted language that executes in a run-time engine. The documentation refers to this run-time engine as the ABL Virtual Machine (AVM). When the documentation refers to ABL source code compilation, it specifies ABL or the compiler as the actor that manages compile-time features of the language. When the documentation refers to run-time behavior in an executing ABL program, it specifies the AVM as the actor that manages the specified run-time behavior in the program.

For example, these sentences refer to the ABL compiler’s allowance for parameter passing and the AVM’s possible response to that parameter passing at run time: “ABL allows you to pass a dynamic temp-table handle as a static temp-table parameter of a method. However, if at run time the passed dynamic temp-table schema does not match the schema of the static temp-table parameter, the AVM raises an error.” The following sentence refers to run-time actions that the AVM can perform using a particular ABL feature: “The ABL socket object handle allows the AVM to connect with other ABL and non-ABL sessions using TCP/IP sockets.”
References to ABL data types

ABL provides built-in data types, built-in class data types, and user-defined class data types. References to built-in data types follow these rules:

- Like most other keywords, references to specific built-in data types appear in all UPPERCASE, using a font that is appropriate to the context. No uppercase reference ever includes or implies any data type other than itself.
- Wherever integer appears, this is a reference to the INTEGER or INT64 data type.
- Wherever character appears, this is a reference to the CHARACTER, LONGCHAR, or CLOB data type.
- Wherever decimal appears, this is a reference to the DECIMAL data type.
- Wherever numeric appears, this is a reference to the INTEGER, INT64, or DECIMAL data type.

References to built-in class data types appear in mixed case with initial caps, for example, Progress.Lang.Object. References to user-defined class data types appear in mixed case, as specified for a given application example.

Typographical conventions

This manual uses the following typographical conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Bold typeface indicates commands or characters the user types, provides emphasis, or the names of user interface elements.</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>Italic typeface indicates the title of a document, or signifies new terms.</td>
</tr>
<tr>
<td>SMALL, BOLD CAPITAL LETTERS</td>
<td>Small, bold capital letters indicate OpenEdge key functions and generic keyboard keys; for example, <strong>GET</strong> and <strong>CTRL</strong>.</td>
</tr>
<tr>
<td>KEY1+KEY2</td>
<td>A plus sign between key names indicates a <strong>simultaneous</strong> key sequence: you press and hold down the first key while pressing the second key. For example, <strong>CTRL+X</strong>.</td>
</tr>
<tr>
<td>KEY1 KEY2</td>
<td>A space between key names indicates a <strong>sequential</strong> key sequence: you press and release the first key, then press another key. For example, <strong>ESCAPE II</strong>.</td>
</tr>
<tr>
<td>Syntax:</td>
<td></td>
</tr>
<tr>
<td><strong>Fixed width</strong></td>
<td>A fixed-width font is used in syntax statements, code examples, system output, and filenames.</td>
</tr>
<tr>
<td><strong>Fixed-width italics</strong></td>
<td>Fixed-width italics indicate variables in syntax statements.</td>
</tr>
<tr>
<td><strong>Fixed-width bold</strong></td>
<td>Fixed-width bold indicates variables with special emphasis.</td>
</tr>
</tbody>
</table>
Examples of syntax descriptions

In this example, ACCUM is a keyword, and aggregate and expression are variables:

Syntax

```
ACCUM aggregate expression
```

FOR is one of the statements that can end with either a period or a colon, as in this example:

```
FOR EACH Customer:
    DISPLAY Name.
END.
```

In this example, STREAM stream, UNLESS-HIDDEN, and NO-ERROR are optional:

Syntax

```
DISPLAY [ STREAM stream ] [ UNLESS-HIDDEN ] [ NO-ERROR ]
```
In this example, the outer (small) brackets are part of the language, and the inner (large) brackets denote an optional item:

**Syntax**

\[
\text{INITIAL [ constant , constant ]}
\]

A called external procedure must use braces when referencing compile-time arguments passed by a calling procedure, as shown in this example:

**Syntax**

\[
\{ \&argument-name \}
\]

In this example, EACH, FIRST, and LAST are optional, but you can choose only one of them:

**Syntax**

\[
\text{PRESELECT [ EACH | FIRST | LAST ] record-phrase}
\]

In this example, you must include two expressions, and optionally you can include more. Multiple expressions are separated by commas:

**Syntax**

\[
\text{MAXIMUM ( expression , expression , expression ... )}
\]

In this example, you must specify MESSAGE and at least one expression or \( \text{SKIP [ (n) ]} \), and any number of additional expression or \( \text{SKIP [ ( n ) ]} \) is allowed:

**Syntax**

\[
\text{MESSAGE \{ expression | SKIP [ ( n ) ] \} ...}
\]

In this example, you must specify \{include-file, then optionally any number of argument or \&argument-name = "argument-value", and then terminate with \}:  

**Syntax**

\[
\{ include-file
\[ argument | \&argument-name = "argument-value" \] ... \}
\]
Long syntax descriptions split across lines

Some syntax descriptions are too long to fit on one line. When syntax descriptions are split across multiple lines, groups of optional and groups of required items are kept together in the required order.

In this example, WITH is followed by six optional items:

Syntax

```
WITH [ ACCUM max-length ] [ expression DOWN ]
[ CENTERED ] [ n COLUMNS ] [ SIDE-LABELS ]
[ STREAM-IO ]
```

Complex syntax descriptions with both required and optional elements

Some syntax descriptions are too complex to distinguish required and optional elements by bracketing only the optional elements. For such syntax, the descriptions include both braces (for required elements) and brackets (for optional elements).

In this example, ASSIGN requires either one or more field entries or one record. Options available with field or record are grouped with braces and brackets:

Syntax

```
ASSIGN { [ FRAME frame ] { field [ = expression ] } }
  [ WHEN expression ] } ...
| { record [ EXCEPT field ... ] }
```
OpenEdge messages

OpenEdge displays several types of messages to inform you of routine and unusual occurrences:

- **Execution messages** inform you of errors encountered while OpenEdge is running a procedure; for example, if OpenEdge cannot find a record with a specified index field value.

- **Compile messages** inform you of errors found while OpenEdge is reading and analyzing a procedure before running it; for example, if a procedure references a table name that is not defined in the database.

- **Startup messages** inform you of unusual conditions detected while OpenEdge is getting ready to execute; for example, if you entered an invalid startup parameter.

After displaying a message, OpenEdge proceeds in one of several ways:

- Continues execution, subject to the error-processing actions that you specify or that are assumed as part of the procedure. This is the most common action taken after execution messages.

- Returns to the Procedure Editor, so you can correct an error in a procedure. This is the usual action taken after compiler messages.

- Halts processing of a procedure and returns immediately to the Procedure Editor. This does not happen often.

- Terminates the current session.

OpenEdge messages end with a message number in parentheses. In this example, the message number is 200:

```
** Unknown table name table. (200)
```

If you encounter an error that terminates OpenEdge, note the message number before restarting.

**Obtaining more information about OpenEdge messages**

In Windows platforms, use OpenEdge online help to obtain more information about OpenEdge messages. Many OpenEdge tools include the following Help menu options to provide information about messages:

- Choose **Help→Recent Messages** to display detailed descriptions of the most recent OpenEdge message and all other messages returned in the current session.

- Choose **Help→Messages** and then type the message number to display a description of a specific OpenEdge message.

- In the Procedure Editor, press the **HELP key** or **F1**.

On UNIX platforms, use the OpenEdge *pro* command to start a single-user mode character OpenEdge client session and view a brief description of a message by providing its number.
To use the pro command to obtain a message description by message number:

1. Start the Procedure Editor:

```
OpenEdge-install-dir/bin/pro
```

2. Press F3 to access the menu bar, then choose Help → Messages.

3. Type the message number and press ENTER. Details about that message number appear.

4. Press F4 to close the message, press F3 to access the Procedure Editor menu, and choose File → Exit.

Third party acknowledgements

OpenEdge includes AdventNet - Agent Toolkit licensed from AdventNet, Inc.
http://www.adventnet.com. All rights to such copyright material rest with AdventNet.

OpenEdge includes ANTLR (Another Tool for Language Recognition) software Copyright © 2003-2006, Terence Parr All rights reserved. Neither the name of the author nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. Software distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes software developed by the Apache Software Foundation (http://www.apache.org/). Copyright © 1999 The Apache Software Foundation. All rights reserved (Xerces C++ Parser (XML) and Xerces2 Java Parser (XML)); Copyright © 1999-2002 The Apache Software Foundation. All rights reserved (Xerces Parser (XML); and Copyright © 2000-2003 The Apache Software Foundation. All rights reserved (Ant). The names “Apache,” “Xerces,” “ANT,” and “Apache Software Foundation” must not be used to endorse or promote products derived from this software without prior written permission. Products derived from this software may not be called “Apache”, nor may “Apache” appear in their name, without prior written permission of the Apache Software Foundation. For written permission, please contact apache@apache.org. Software distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes Concurrent Java software Copyright 1994-2000 Sun Microsystems, Inc. All Rights Reserved. -Neither the name of or trademarks of Sun may be used to endorse or promote products including or derived from the Java Software technology without specific prior written permission; and Redistributions of source or binary code must contain the above copyright notice, this notice and the following disclaimers: This software is provided "AS IS," without warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN Microsystems, Inc. AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY
LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THE SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN MICROSYSTEMS, INC. OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE SOFTWARE, EVEN IF SUN MICROSYSTEMS, INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

OpenEdge includes DataDirect software Copyright © 1991-2007 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect for JDBC Type 4 driver); Copyright © 1993-2009 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect for JDBC); Copyright © 1988-2007 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect for ODBC); and Copyright © 1988-2007 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights Reserved. (DataDirect Connect64 for ODBC).

OpenEdge includes DataDirect Connect for ODBC and DataDirect Connect64 for ODBC software, which include ICU software 1.8 and later - Copyright © 1995-2003 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.

OpenEdge includes DataDirect Connect for ODBC and DataDirect Connect64 for ODBC software, which include software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/). Copyright © 1998-2006 The OpenSSL Project. All rights reserved. And Copyright © 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

OpenEdge includes DataDirect products for the Microsoft SQL Server database which contain a licensed implementation of the Microsoft TDS Protocol.

OpenEdge includes software authored by David M. Gay. Copyright © 1991, 2000, 2001 by Lucent Technologies ( dtoa.c); Copyright © 1991, 1996 by Lucent Technologies ( g_fmt.c); and Copyright © 1991 by Lucent Technologies ( rnd_prod.s). Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR LUCENT MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

OpenEdge includes software authored by David M. Gay. Copyright © 1998-2001 by Lucent Technologies All Rights Reserved ( decsrtod.c; strtodg.c); Copyright © 1998, 2000 by Lucent Technologies All Rights Reserved ( decsrtodf.c; strtord.c); Copyright © 1998 by Lucent Technologies All Rights Reserved ( dmisc.c; gdtoa.h; gethex.c; gmisc.c; sum.c); Copyright © 1998, 1999 by Lucent Technologies All Rights Reserved ( gdtoa.c; misc.c; smisc.c; ulp.c); Copyright © 1998-2000 by Lucent Technologies All Rights Reserved ( gdtoaimp.h); Copyright
© 2000 by Lucent Technologies All Rights Reserved (hd_init.c). Full copies of these licenses can be found in the installation directory, in the c:/OpenEdge/licenses folder. Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

OpenEdge includes http package software developed by the World Wide Web Consortium. Copyright © 1994-2002 World Wide Web Consortium, (Massachusetts Institute of Technology, European Research Consortium for Informatics and Mathematics, Keio University). All rights reserved. This work is distributed under the W3C® Software License [http://www.w3.org/Consortium/Legal/2002/copyright-software-20021231] in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

OpenEdge includes ICU software 1.8 and later - Copyright © 1995-2003 International Business Machines Corporation and others. All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation.


OpenEdge includes Infragistics NetAdvantage for .NET v2009 Vol 2 Copyright © 1996-2009 Infragistics, Inc. All rights reserved.

OpenEdge includes JSTL software Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Software distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes OpenSSL software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/). Copyright © 1998-2007 The OpenSSL Project. All rights reserved. This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com). Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved. The OpenSSL Toolkit” and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project. Software distributed on an "AS IS" basis, WITHOUT
WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product.

OpenEdge includes Quartz Enterprise Job Scheduler software Copyright © 2001-2003 James House. All rights reserved. Software distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product. This product uses and includes within its distribution, software developed by the Apache Software Foundation (http://www.apache.org/).

OpenEdge includes code licensed from RSA Security, Inc. Some portions licensed from IBM are available at http://oss.software.ibm.com/icu4j/.

OpenEdge includes the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Copyright ©1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.

OpenEdge includes Sonic software, which includes software developed by Apache Software Foundation (http://www.apache.org/). Copyright © 1999-2000 The Apache Software Foundation. All rights reserved. The names “Ant”, “Axis”, “Xalan,” “FOP,” “The Jakarta Project”, “Tomcat”, “Xerces” and/or “Apache Software Foundation” must not be used to endorse or promote products derived from the Product without prior written permission. Any product derived from the Product may not be called “Apache”, nor may “Apache” appear in their name, without prior written permission. For written permission, please contact apache@apache.org.

OpenEdge includes Sonic software, which includes software Copyright © 1999 CERN - European Organization for Nuclear Research. Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. CERN makes no representations about the suitability of this software for any purpose. It is provided "as is" without expressed or implied warranty.

OpenEdge includes Sonic software, which includes software developed by ExoLab Project (http://www.exolab.org/). Copyright © 2000 Intalio Inc. All rights reserved. The names “Castor” and/or “ExoLab” must not be used to endorse or promote products derived from the Products without prior written permission. For written permission, please contact info@exolab.org. Exolab, Castor and Intalio are trademarks of Intalio Inc.

OpenEdge includes Sonic software, which includes software developed by IBM. Copyright © 1995-2003 International Business Machines Corporation and others. All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation. Software distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License agreement that accompanies the product. Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.
OpenEdge includes Sonic software, which includes the JMX Technology from Sun Microsystems, Inc. Use and Distribution is subject to the Sun Community Source License available at http://sun.com/software/communitysource.

OpenEdge includes Sonic software, which includes software developed by the ModelObjects Group (http://www.modelobjects.com). Copyright © 2000-2001 ModelObjects Group. All rights reserved. The name “ModelObjects” must not be used to endorse or promote products derived from this software without prior written permission. Products derived from this software may not be called “ModelObjects”, nor may “ModelObjects” appear in their name, without prior written permission. For written permission, please contact djacobs@modelobjects.com.

OpenEdge includes Sonic software, which includes code licensed from Mort Bay Consulting Pty. Ltd. The Jetty Package is Copyright © 1998 Mort Bay Consulting Pty. Ltd. (Australia) and others.

OpenEdge includes Sonic software, which includes files that are subject to the Netscape Public License Version 1.1 (the “License”); you may not use this file except in compliance with the License. You may obtain a copy of the License at http://www.mozilla.org/NPL/. Software distributed under the License is distributed on an “AS IS” basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License. The Original Code is Mozilla Communicator client code, released March 31, 1998. The Initial Developer of the Original Code is Netscape Communications Corporation. Portions created by Netscape are Copyright 1998-1999 Netscape Communications Corporation. All Rights Reserved.

OpenEdge includes Sonic software, which includes software developed by the University Corporation for Advanced Internet Development http://www.ucaid.edu Internet2 Project. Copyright © 2002 University Corporation for Advanced Internet Development, Inc. All rights reserved. Neither the name of OpenSAML nor the names of its contributors, nor Internet2, nor the University Corporation for Advanced Internet Development, Inc., nor UCAID may be used to endorse or promote products derived from this software and products derived from this software may not be called OpenSAML, Internet2, UCAID, or the University Corporation for Advanced Internet Development, nor may OpenSAML appear in their name without prior written permission of the University Corporation for Advanced Internet Development. For written permission, please contact opensaml@opensaml.org.

OpenEdge includes the UnixWare platform of Perl Runtime authored by Kiem-Phong Vo and David Korn. Copyright © 1991, 1996 by AT&T Labs. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED “AS IS”, WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHORS NOR AT&T LABS MAKE ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

OpenEdge includes Vermont Views Terminal Handling Package software developed by Vermont Creative Software. Copyright © 1988-1991 by Vermont Creative Software.

OpenEdge includes XML Tools, which includes versions 8.9 of the Saxon XSLT and XQuery Processor from Saxonica Limited (http://www.saxonica.com/) which are available from SourceForge (http://sourceforge.net/projects/saxon/). The Original Code of Saxon
comprises all those components which are not explicitly attributed to other parties. The Initial Developer of the Original Code is Michael Kay. Until February 2001 Michael Kay was an employee of International Computers Limited (now part of Fujitsu Limited), and original code developed during that time was released under this license by permission from International Computers Limited. From February 2001 until February 2004 Michael Kay was an employee of Software AG, and code developed during that time was released under this license by permission from Software AG, acting as a "Contributor". Subsequent code has been developed by Saxonica Limited, of which Michael Kay is a Director, again acting as a "Contributor". A small number of modules, or enhancements to modules, have been developed by other individuals (either written especially for Saxon, or incorporated into Saxon having initially been released as part of another open source product). Such contributions are acknowledged individually in comments attached to the relevant code modules. All Rights Reserved. The contents of the Saxon files are subject to the Mozilla Public License Version 1.0 (the "License"); you may not use these files except in compliance with the License. You may obtain a copy of the License at http://www.mozilla.org/MPL/ and a copy of the license can also be found in the installation directory, in the c:/OpenEdge/licenses folder. Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License.

OpenEdge includes XML Tools, which includes Xs3P v1.1.3. The contents of this file are subject to the DSTC Public License (DPL) Version 1.1 (the "License"); you may not use this file except in compliance with the License. A copy of the license can be found in the installation directory, in the c:/OpenEdge/licenses folder. Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License. The Original Code is xs3p. The Initial Developer of the Original Code is DSTC. Portions created by DSTC are Copyright © 2001, 2002 DSTC Pty Ltd. All rights reserved.

OpenEdge includes YAJL software Copyright 2007, Lloyd Hilaiel. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. Neither the name of Lloyd Hilaiel nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Part I

OpenEdge Debugger

Chapter 1, Introduction
Chapter 2, Starting and Stopping the Debugger
Chapter 3, Debugger Window and Files
Chapter 4, Using System Handles for Debugging
The OpenEdge® Debugger is an interactive tool that allows you to control and monitor the execution of compilable ABL (Advanced Business Language) procedures. With the Debugger, you can execute a procedure and its subprocedures, stepping through procedures line by line or stopping at specified lines and then resuming execution from those points. You can also examine data from the procedure you are running, including the names and contents of variables it defines, and you can modify this data.

In addition, you can use two debugging modes, distributed debugging and remote debugging, to examine code associated with a distributed application.

This chapter contains the following sections:

- Debugger system requirements
- Debugger features and functions
- Enabling debugging
- Understanding debugging sessions
- Procedures and the Debugger context
- Debugging in a distributed environment
Debugger system requirements

The Debugger runs in Windows and on UNIX. The Windows version of the Debugger can debug either GUI or character-mode applications. The UNIX version of the Debugger can debug only character-mode applications.

The Debugger is a Java™ application. As such, it requires that the Java Run-time Environment (JRE) component be installed on the same machine. The JRE is the run-time part of Java and consists of the Java Virtual Machine, the Java Core Classes, and supporting files. Depending on the platform on which you install the Debugger, the JRE might not have been included in the installation. In Windows, the OpenEdge installation program automatically installs these Java components. On UNIX, the OpenEdge installation program automatically installs these Java components only on certain platforms.

For more information, see OpenEdge Getting Started: Installation and Configuration.
Debugger features and functions

The Debugger is a utility you can run with any OpenEdge application. When you invoke the Debugger, it runs in a separate process with its own window. The Debugger window provides access to all Debugger features and functions through menu options, toolbar buttons, or accelerator keys. The Debugger window also provides access to online help information on all Debugger features and functions. For more information on the Debugger window and how to access all Debugger features and functions, see Chapter 3, “Debugger Window and Files.”

You can invoke the Debugger while running in an OpenEdge session, from the Procedure Editor or AppBuilder, for example. You can run the Debugger in attachable mode; that is, you open the Debugger first and then attach to a running client process. For more information, see the “Debugging in attachable mode” section on page 2–18.

You can also invoke the Debugger from an ABL procedure, directly or indirectly, using the DEBUGGER and SESSION system handles. With these system handles, you can control some Debugger features from an ABL procedure and build your own OpenEdge development tools that include the Debugger as a tool option. For more information, see Chapter 4, “Using System Handles for Debugging.”

The following sections describe the Debugger features and functions:

- Application control
- Application data management
- Execution monitoring
- Session management and information

Application control

During a debugging session, the Debugger allows you to start and stop procedure execution as you want, and even execute procedures that are not part of your application. All procedures the Debugger executes are added to the procedure call stack. The procedure call stack is a last-in-first-out (LIFO) memory structure that keeps track of the execution status of each procedure as it calls a subprocedure or invokes a trigger block.

The following sections cover:

- Open and incremental execution
- Procedure interruption
- Procedure termination
Open and incremental execution

To execute a procedure other than the one the Debugger is currently running, open the procedure and start it from the Debugger, using Debug→Run. Whenever the Debugger has control, you can run any application, effectively adding it to the procedure call stack of your current application. This allows you to mix and match procedures dynamically or run diagnostic procedures while debugging your application.

**Note:** You cannot start a procedure that requires parameters or arguments from the Debugger. The Debugger has no way to define them.

When the Debugger is stopped in an executing procedure, you can continue execution, using Debug→Continue. This allows the procedure to execute until it encounters a breakpoint, an interrupt, or the end of the procedure. You can also continue executing the current procedure line by line using Debug→Step Into, Debug→Step Out, or Debug→Step Over. Use Debug→Start Animation to watch your program execute as the Debugger steps through your code. Use the Run to Line command to continue program execution up to a specified line of ABL code.

Procedure interruption

To selectively interrupt procedure execution, you can set or remove breakpoints, using Edit→Breakpoints. A breakpoint can be a specific line in a procedure where execution stops temporarily. When the procedure reaches a breakpoint, it halts before executing the specified line and gives control to the Debugger for your next command. The easiest way to set a breakpoint is to click in the left column of the source code pane where the procedure appears.

A breakpoint can be conditional, where evaluation of a logical expression determines whether the interruption occurs. A breakpoint can be based on encountering an error, in which case the Debugger gets control at the next executable line after the line that caused the error.

You can set and remove breakpoints in an ABL procedure, using the DEBUGGER system handle’s SET-BREAK( ) and CANCEL-BREAK( ) methods. This feature is helpful to control breakpoints at specific points in your code, regardless of how the surrounding code is modified, or to set breakpoints in include files that might appear in many different procedures.

To interrupt a running procedure and give control to the Debugger, the Debugger provides a Debug→Interrupt command. This interrupts a procedure wherever it is executing, as if it encountered a breakpoint. It is particularly useful when you want to interrupt a procedure in which you have not set a breakpoint.

**Note:** If you use Debug→Interrupt while an alert dialog box is displayed on the screen, or while the procedure is executing a READKEY or PAUSE statement, the Debugger does not take control until you dismiss the alert dialog box or satisfy the READKEY or PAUSE statement.

You can provide a means to interrupt a running ABL procedure by setting the SESSION system handle DEBUG-ALERT attribute to TRUE. This places a Help button on all alert boxes that provides access to a Stack Trace dialog box and the Debugger.
Procedure termination

You can force a procedure to terminate at a break or interrupt point, using Debug→Stop. This effectively inserts and executes an ABL STOP statement at the current break or interrupt point.

Application data management

Whenever the Debugger has control, you can monitor and make changes to data items in your application. For example, you can:

- Examine the values of variables, buffers, parameters, temp-tables, and datasets that are defined and accessible from an executing procedure in the variables pane. You can modify the values of variables and parameters.
- Examine and modify the values of attributes for objects, using Debug→Dataview.
- Examine and modify the values of database and temp-table buffer fields, using Debug→Dataview.
- Examine and modify the elements of an array selected in the variables pane, or of an array field selected in a buffer, using Debug→Dataview.
- Add watches to monitor the values of any variables, attributes, fields, or built-in ABL functions in the executing procedure, or any procedure on the call stack, using Debug→Add Watch.

Execution monitoring

The Debugger provides several ways to examine the state of an application, as described in the following sections:

- Code path analysis
- Transaction monitoring
- Breakpoint analysis
- Dynamic object monitoring

Code path analysis

During procedure execution, the Debugger window displays the listing of the procedure at each breakpoint or stopping point in its execution. A pointer always indicates the next line to execute. At any stopping point, you can display the listing for any procedure file using File→Open. This provides a convenient way to set breakpoints for any procedure in your environment, whether or not it is called from the procedure you are running.

You can examine and navigate the procedure call stack using the ABL stack trace pane. This allows you to examine the current code path back and forth through the active series of procedure calls and triggers starting from the current stopping point.
Transaction monitoring

You can determine the transaction state of your application using **Debug → Show Transaction**. This tells you whether a transaction is active at the current stopping point.

Breakpoint analysis

You can display the current breakpoint settings using **Edit → Breakpoints**. This lists the breakpoints currently set for all procedures during the session. The listing for each executing procedure also indicates each line where a breakpoint is set.

Dynamic object monitoring

You can monitor the creation and destruction of dynamic object instances in your application, using **Diagnostics → Monitor Dynamic Objects**. This lets you track dynamic object instances your application has created and not yet destroyed. This can help you locate unused object instances that can result in memory leaks.

Session management and information

The Debugger provides several features that allow you to monitor and customize a debugging session. These features include:

- **Window settings**
- **Listing management**
- **ABL Debugger control**

Window settings

The Debugger automatically saves some window settings, such as window size and location, across debugging sessions. You can set user preferences for other Debugger window settings, such as text font and size, using **Edit → Preferences**.

Listing management

The Debugger window provides a search menu that allows you to search forward and backward for text in the displayed procedure listing.

ABL Debugger control

The **DEBUGGER** and **SESSION** system handles provide attributes and methods that allow you to initialize, start, and control features of a debugging session directly or indirectly from within an ABL procedure. For example, you can use these handles to display and remove the Debugger window from the screen and selectively interrupt procedure execution.
Enabling debugging

Prior to running the Debugger on an OpenEdge installation that contains an ABL Virtual Machine (AVM), you must enable the system for debugging. Attempts to run the Debugger without first enabling debugging result in an error message.

Debugging is initially disabled because it opens a potential security hole. When running the Debugger, you can examine and modify internal variables and database fields. In a production environment, this means that someone could access sensitive business data while in the Debugger. For this reason, Progress Software Corporation strongly recommends that you avoid using the Debugger on a production system.

During application development, however, you can choose whether to selectively enable and disable debugging or enable it after installation and leave it enabled for the duration of the development cycle.

To enable debugging, use the `proDebugEnable` command.

This is the syntax for the command:

**Syntax**

```
proDebugEnable {-disable-all | -enable-all}
```

- **disable-all**
  
  Disables all AVM instances that are part of the installation from which you are executing the command. Specify this parameter to disable debugging on an installation where it was previously enabled.

- **enable-all**
  
  Enables all AVM instances that are part of the installation from which you are executing the command

To further secure the debugging facility, you must have the right privileges to execute this command: root privileges on UNIX and administrator privileges in Windows.

Note the following about enabling debugging:

- The `proDebugEnable` command controls debugging of AVM instances running on the machine where you execute it. It does not affect running of the Debugger user interface. So, for example, if you want to run the Debugger on one machine to debug an AVM instance that is on another machine (across a LAN), you must run `proDebugEnable` on the machine where the AVM instance is running.

- If you install OpenEdge on machine 1 and do a network install onto machine 2, you must run `proDebugEnable` on machine 2 to debug an AVM instance that is running on machine 2.
• If you install multiple instances of OpenEdge on the same machine, each instance will have its own copy of proDebugEnable, and each copy will affect only the debugging capability in its instance.

Thus, you can run an application system and a production system on the same machine, and control debugging separately for each system.

• If you anticipate that you might want to use the Debugger, execute proDebugEnable before starting the AVM. If you decide you want to debug after starting the AVM, you will have to shut down the AVM, enable debugging, and then restart the AVM.

• If you want to debug an AppServer™ or WebSpeed® agent, you also must set the appropriate debuggerEnabled property to 1 in the ubroker.properties file, in addition to enabling debugging with the proDebugEnable command.

Note: The default value for the debuggerEnabled property is 0.
Understanding debugging sessions

During a debugging session, the Debugger user interface and ABL client processes cooperate to execute, monitor, and interrupt application procedures. The ABL client process executes your application procedures, and the Debugger process manages the Debugger window. However, the two processes share the management of application execution. Figure 1–1 shows this interaction.

Figure 1–1: Debugger/client interaction

Interaction between Debugger and client

The Debugger process sends commands to the client based on menu options you select and other actions you take in the Debugger window (such as setting breakpoints). The client interprets the commands, performs relevant actions (such as honoring breakpoints), and sends run-time information to the Debugger process in response. For example, the client sends the procedure and line number of each breakpoint it encounters. The Debugger process uses the run-time information it receives from the client to manage and display procedure listings, variable values, and so on.

Debugger and application control

Either the Debugger or the executing application has control during a debugging session. The Debugger has control when no application is running or the running application is interrupted, for example, at a breakpoint. When the Debugger has control, it can send commands to the client process for execution. The application has control whenever it is executing ABL code, for example, in response to a Debugger control flow command such as Debug→Continue. When the application has control, it interacts with the user and database as if the Debugger were not running.

The following sections detail the Debugger and application interaction:

- Application interaction during Debugger control
- Debugger interaction during application control

Application interaction during Debugger control

When the Debugger has control, the application is blocked. At this point, the client application is waiting to execute a line of code. The application continues to wait until you invoke a Debugger control flow command such as Debug→Step Into, Debug→Step Over, Debug→Step Out, or Debug→Continue.
Debugger interaction during application control

When the application has control (is executing), you cannot invoke commands in the Debugger window until the Debugger receives control (for example, when the application reaches a breakpoint). You can force the Debugger to take control during procedure execution by using **Debug → Interrupt.**
Procedures and the Debugger context

This section introduces several terms that are used throughout this manual. These terms describe the relationship between the Debugger and application procedures it controls or references, and include:

- The Debugger context
- Debugger context and the procedure call stack

The Debugger context

The *Debugger context* consists of the data and execution status of all procedures running under Debugger control. The following sections describe:

- Procedures and triggers
- Persistent procedures
- Callback procedures
- Data
- Execution status

Procedures and triggers

Procedures and trigger blocks in the Debugger context include the executing procedure or trigger plus some or all of the procedures and triggers pushed onto the procedure call stack. The number of procedures and triggers on the call stack increases as each subprocedure or trigger calls another and decreases as each subprocedure or trigger returns to the one that called it. The Debugger provides information on a running application by referencing this call stack.

The executing procedure and all procedures on the call stack (whether inside or outside the Debugger context) are *active procedures*. Active procedures include all those that you run directly or indirectly from the client and any additional procedures you start from the Debugger with **Debug → Run**.

*Inactive procedures* are procedures for which the Debugger cannot examine data. They include:

- Procedures that have yet to be called
- Procedures that have completed execution and have returned to their caller
- Instances of persistent procedures that have been deleted from the session
- Instances of persistent procedures that are not currently executing
**Persistent procedures**

A persistent procedure is active in the Debugger context in the following instances:

- When the persistent procedure is first executing to instantiate it (**RUN . . . PERSISTENT**)
- When one of its triggers is executing in response to a user or program event
- When one of its internal procedures is executing from another procedure (**RUN . . . IN**)

Otherwise, the persistent procedure is not on the call stack and is invisible to the Debugger context.

**Callback procedures**

A *callback procedure* is an internal procedure that can be set by an ABL program; for example, when generating or receiving a Web Services Out SOAP message, or when parsing an XML document. You can use the Debugger to set breakpoints in callback procedures.

**Data**

Data in the Debugger context includes all variables, buffers, parameters, temp-tables, and attributes and fields of variables and objects defined or accessed by procedures inside the Debugger context.

**Execution status**

The execution status includes the location of the current *executable line* and the relative position in the call stack of each procedure in the Debugger context, plus the current transaction state. An executable line is any ABL line that contains a run-time statement (for example, **FOR**, **DISPLAY**, or **CREATE**). Although the listing monitored by the Debugger contains all the ABL code for a procedure, the execution status reflects only executable lines; execution stops only on executable lines. *Nonexecutable lines* include comments and static data definition statements (for example, **DEFINE** or **FORM**). Static data definition statements take effect only at compile time and generate data items and objects for a procedure.
Debugger context and the procedure call stack

Figure 1–2 shows the relationship between active procedures inside and outside the Debugger context in a typical procedure call stack (growing downward in the figure). The Debugger is controlling an application (your-app.p) that is running in the Procedure Editor (also an OpenEdge application). In this figure, the executing procedure is subexec.p. The procedure call stack includes all procedures down to the executing procedure. All procedures running from your application are in the Debugger context. Only procedures associated with the Procedure Editor (_edit.p and _proedit.p) are running outside of the Debugger context.

![Procedure call stack diagram]

**Figure 1–2:  Procedures inside and outside the Debugger context**

An active procedure can run outside the Debugger context in one of the following two ways:

- When the name of the procedure is preceded by an underscore (_), as with _edit.p and _proedit.p in Figure 1–2
- When the procedure invokes the Debugger with the DEBUG method of the DEBUGGER system handle

For more information on using underscores in procedure names, see Chapter 3, “Debugger Window and Files.” For more information on the DEBUGGER system handle, see Chapter 4, “Using System Handles for Debugging.”

The Debugger keeps track of run-time information only for active procedures inside the Debugger context. The Debugger allows you to examine the data items, object attributes, listing, and execution status of any procedure that is active in the Debugger context anytime the Debugger has control.

You can neither examine data from nor control execution of procedures outside the Debugger context.
Debugging in a distributed environment

The OpenEdge Debugger supports debugging application code in a distributed environment in two modes, distributed debugging and remote debugging. These modes provide two different models for debugging your distributed application. Both modes use the same Debugger window to debug remote procedures.

**Note:** Running the Debugger in attachable mode can be considered a form of debugging in a distributed environment, as you can run the Debugger on one machine and debug a client process on another machine within the same LAN. For more information, see the “Debugging in attachable mode” section on page 2–18.

The following sections describe debugging in a distributed environment:

- Distributed debugging
- Remote debugging
- Compatibility issues

**Distributed debugging**

*Distributed debugging* is the ability to debug associated ABL processes within a distributed application environment. That is, one debugger session can control both the client process and AppServer process, giving the client session the ability to step into code running on the AppServer. The procedure call stack reflects all procedures in all processes involved, enabling the root client application to be aware of the AppServer processes it is debugging. The *root client application* is the client application that initiates the Debugger using distributed debugging.

You can use distributed debugging on AppServers running in any session-managed operating mode (that is, state-reset, state-aware, stateless, but not state-free).

You can run the Debugger using distributed debugging to debug local procedures, remote procedures, and remote procedures executed by other remote procedures. An AppServer process that is once, twice, or further removed from the initial debugger session can be debugged in this manner.

For more information about distributed debugging on AppServers, see *OpenEdge Application Server: Developing AppServer Applications*. 
Remote debugging

Remote debugging is the ability to debug server-side and remote application procedures. This mode prevents debugging any procedure in a client application session. Remote debugging allows you to debug application code running on an AppServer process or a WebSpeed agent independently of the calling client application. Remote debugging is useful for debugging remote procedures that are:

- Running on an AppServer
- Running on a WebSpeed agent
- Executed by an Open Client (non-ABL client) application
- Executed by an OpenEdge Web Service
- Executed asynchronously on the AppServer from an ABL client application

In this debugging mode, the client application driving an AppServer process is unaware that the Debugger is running on the AppServer process. On the server side, the procedure call stack shown in the Debugger’s ABL stack trace pane reflects only entries up to the top level remote procedure call. It does not reflect entries for the ABL client application that is driving the AppServer process.

Compatibility issues

Changes in the Debugger over time have lead to certain incompatibilities when debugging in a distributed environment when a client and an AppServer are running on different software releases.

The client and AppServer use a protocol to communicate during debugging. There have been changes to this protocol such that an AppServer running on an earlier or later release cannot communicate effectively with the client in some configurations.

Added features in a later release introduce new commands to support these feature requests. An AppServer running on an earlier release cannot service the new feature requests because it does not recognize the commands introduced in the later release.
The Debugger reconciles release discrepancies sufficiently in some cases to continue executing, and in others, to provide feedback on why it cannot continue. Table 1–1 summarizes what happens when attempting client/AppServer debugging with different software releases.

**Table 1–1: The Debugger and mixed client/AppServer releases**

<table>
<thead>
<tr>
<th>Client</th>
<th>AppServer</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1D05/06/07</td>
<td>9.1D05/06/07</td>
<td>The client and AppServer must be running on identical releases, that is, 9.1D05 to 9.1D05, 9.1D06 to 9.1D06, and 9.1D07 to 9.1D07 to debug successfully; otherwise, results are unpredictable.</td>
</tr>
<tr>
<td>9.1D08</td>
<td>9.1D07 or earlier</td>
<td>Incompatible protocols prevent the client and AppServer from communicating. The Debugger displays an error message to this effect; the procedure executes without debugging.</td>
</tr>
<tr>
<td>9.1D08</td>
<td>10.0A and later</td>
<td>The client protocol adapts to the protocol of the AppServer for debugging purposes, but cannot take advantage of the features in the later release.</td>
</tr>
<tr>
<td>10.0A</td>
<td>9.1D07 or earlier</td>
<td>Incompatible protocols prevent the client and AppServer from communicating. The Debugger displays an error message to this effect; the procedure executes without debugging.</td>
</tr>
<tr>
<td>10.0A and later</td>
<td>9.1D08 and later</td>
<td>The client protocol adapts to the protocol of the AppServer. Debugging proceeds as expected. When debugging on a 9.1D08 AppServer, feature requests dependent on the later release will not execute. For example, conditional breakpoints fire, without first testing the condition; error breakpoints do not fire at all. Other cases might result in an error message from the AppServer because it does not recognize a command new to the later release.</td>
</tr>
</tbody>
</table>
Starting and Stopping the Debugger

Depending on where you are working in OpenEdge and how you want the Debugger to interact with your ABL (Advanced Business Language) application, you can start the Debugger in different ways. The following sections describe techniques for starting and stopping the Debugger:

- Debugging modes
- Debugging from the Procedure Editor
- Debugging from the AppBuilder
- Debugging from the ADE Desktop
- Debugging from the OpenEdge command line
- Debugging from alert dialog boxes
- Debugging from an ABL procedure
- Debugging in attachable mode

For more information on the Debugger window, see Chapter 3, “Debugger Window and Files.”
Starting and Stopping the Debugger

Debugging modes

When you start a debugging session, the Debugger initializes and runs in one of three modes: application mode, stand-alone mode, or attachable mode. When and how the Debugger gets control depends on the mode used to run it. The following sections describe the debugging modes:

- **Application mode**
- **Stand-alone mode**
- **Attachable mode**

**Application mode**

The Debugger runs in *application mode* when you start an initial application by means of the Debugger options of the Procedure Editor and the AppBuilder. This application runs in the Debugger context, and the Debugger takes control when the application stops at an automatic breakpoint set at the first executable line. This gives you a chance to examine your application listings and set breakpoints before continuing execution. You can run other procedures from the Debugger, using **Debug → Run**, effectively running them under your initial application.

**Note:** You can run the Debugger in application mode from your own application, using the **DEBUGGER** system handle. For more information, see the “Debugging from an ABL procedure” section on page 2–17.

Figure 2–1 shows the relationship between the Debugger in application mode, its initial application, other procedures it might run, and the OpenEdge environment in which it is running.

![Diagram showing the relationship between Debugger, Editor or AppBuilder, Initial application, Other procedures, and OpenEdge environment]

**Figure 2–1: Debugging in application mode**

In application mode, you can start and restart the Debugger and its initial application without leaving your OpenEdge environment.
Debugging modes

Exiting procedures started with Debug→Run

When you exit a procedure started with Debug→Run, it returns control to the Debugger. Any previous application on the stack (including the initial application) waits to resume execution at its current stopping point.

Exiting the Debugger before the initial application

When you exit the Debugger in application mode by closing the Debugger window, the Debugger purges itself from the OpenEdge environment and closes any procedures started with Debug→Run. It then returns control to the initial application, which continues execution from its current interruption point.

Exiting the initial application before the Debugger

When you exit the initial application, it returns control to the environment where you started it. If the Debugger is running when you exit, the Debugger closes its window but leaves Debugger session settings, such as window size and location, initialized in the OpenEdge environment. If you then run the same or another application using the Editor or AppBuilder Debugger option, the Debugger window opens with its previous window settings and takes control with a breakpoint at the first executable line.

Stand-alone mode

The Debugger runs in stand-alone mode when you start your OpenEdge session from the command line with the Debugger (-debug) startup parameter or from the Application Development Environment (ADE) Desktop. In stand-alone mode, the Debugger takes control immediately as your initial user interface and with no initial application running in the Debugger context.

Note: You can run the Debugger in stand-alone mode from your own application, using the DEBUGGER system handle. For more information, see the “Debugging from an ABL procedure” section on page 2–17.

To debug an application:

1. Load the procedure into the Debugger window, using File→Open.

   Note: If you start your OpenEdge session with the Startup Procedure (-p) startup parameter, the ABL Virtual Machine (AVM) loads the procedure into the Debugger window automatically.

2. Start the procedure, using Debug→Run.
Figure 2–2 shows the relationship between the Debugger in stand-alone mode, the application procedures it runs, and the OpenEdge environment in which it is running.

---

**Figure 2–2: Debugging in stand-alone mode**

When you exit any of these applications, it returns control to the Debugger. When you exit the Debugger, it completely removes itself and any application it is running in the OpenEdge environment, and returns control to the environment where you started it. If you restart the Debugger, for example, from the ADE Desktop, it completely re-initializes itself without any application in the Debugger context.

**Attachable mode**

When you first start the Debugger and then attach it to a running client process, the Debugger runs in attachable mode. The client can be any ABL client, WebSpeed agent, or AppServer running on the same machine or on the same LAN as the Debugger. The Debugger gets control immediately upon attaching to the process. Once attached, the Debugger works the same as in application mode; that is, you are debugging an already running application.

By running the Debugger in attachable mode you can debug:

- A previously started session
- A session on another machine
- The AppServer, WebSpeed, asynchronous AppServer procedures, OpenClient, and Web Services directly from the Debugger without adding statements to the source code to start the Debugger

To successfully attach the Debugger, the process you attach to must be in a debug-ready state. For more information, see the “Making the process ready for debugging” section on page 2–5.
Requirements for r-code

To support debugging in attachable mode, it is important to compile the r-code according to these rules:

- Use the DEBUG-LIST option with the COMPILE statement, and specify a location to which the Debugger has access as the location for the debug listing.
- Do not use MIN-SIZE option with the COMPILE statement. This option strips the Debugger Segment from the generated r-code.

For more information about these options, see the section on the COMPILE statement in OpenEdge Development: ABL Reference.

Performance and security considerations

Running an attachable mode debugging session has both security and performance considerations. The Debugger and the AVM instance communicate by opening a socket on a port and establishing a connection. In attachable mode, the AVM has to open a socket on a known port and wait for a connection from the Debugger. The open connection introduces a potential security gap and a performance degradation. To close the security gap, OpenEdge requires that you have physical or login access to the local machine to make a process debug-ready. To avoid the performance hit of unnecessary polling, you can make the process debug-ready by opening the connection only when you are ready to debug the process.

Making the process ready for debugging

Before you can start the Debugger in attachable mode, you have to ready the process for debugging. The process can be any ABL (GUI or character mode) client, WebSpeed agent, or AppServer process, but not a WebClient™ process. You can make the process ready for debugging by:

- Using the Debugger window
- Using the Ready Attachable Debugger (-debugReady) startup parameter
- Using the proDebugConfig command

While a process is debug-ready, it might run slower than normal. Therefore, you should turn on this capability only when you intend to use the Debugger in attachable mode.

Using the Debugger window

If you are running the Debugger on the same machine as the process to be debugged, you can make a process debug-ready through the Debugger window. In this case, the user interface mirrors what you do when you run the proDebugConfig command. You provide the same information and receive the same message feedback. For more information, see the “Attach to Process dialog box” section on page 3–23.
Using the Ready Attachable Debugger (-debugReady) startup parameter

The Ready Attachable Debugger (-debugReady) startup parameter makes a process ready for debugging at startup. For example:

```
-port-number
```

A port number or zero (0). If you specify a known port number, the AVM attempts to use that port to create a socket to await a connection from the Debugger. If the port is in use, the AVM reports the error and continues to run, without making the process ready for debugging.

If you specify 0, the AVM determines a usable port number and reports that number to you during startup processing, as follows:

- For a GUI client, in an Alert box (even if running in batch mode)
- For a WebSpeed agent, in the WebSpeed log file
- For an AppServer process, in the AppServer log file
- For a client process running on UNIX, in the shell window (even if running in batch mode)

If you attempt to ready debugging on startup and debugging is not enabled for the installation (see the “Enabling debugging” section on page 1–7), you receive a warning message, and then startup continues. If you specify -debugReady and -debug in the same startup parameter, the AVM reports this as invalid and shuts down.

Note: All WebSpeed agents and AppServer processes started by the same broker use the same startup parameter. If you use such a broker configuration, do not specify a port number with the -debugReady startup parameter.

Using the proDebugConfig command

The proDebugConfig command gives you a way to instruct a running ABL client, WebSpeed agent or single AppServer process to make itself ready for debugging. You must execute the command on the same machine as the process you are enabling. You can run the command from either a UNIX shell or a Windows Proenv shell (Programs → OpenEdge → Proenv from the Start menu). The command has the following syntax:

```
proDebugConfig [process Id] [-ready {yes | no}] [-port port-number]
```

Process Id

The ID of the process you want to enable for debugging. If you don’t specify an ID, the command searches the local machine and displays a list of running OpenEdge processes and prompts you to enter an ID shown in the list.
On UNIX, the list might resemble the following:

```
mscat 16273     1  0   Jul 08 pts/37  0:03 /pro/dlc/bin/_progres
   -p /usr1/InvApp/main.p -T /tmp -h 10
mrdog 9295  26391  0 10:57:38 pts/40  0:01 /pro/dlc/bin/prowin32
   -pf startup.pf
```

In Windows, the list might resemble:

```
C:\pro\dlc\bin\_progres.exe   16273
C:\pro\dlc\bin\prowin32.exe    9295
```

Enter the process ID, for example, **9295**, and press **ENTER**. Press **CTRL+C** to cancel the command.

- **ready** { **yes** | **no** }

  Turns the debug-ready state on or off. If you specify **yes**, and the process is currently ready for debugging (either from a previous command execution or the `-debugReady` startup parameter), the command displays a message to that effect that includes the port number used for the connection. If you specify **no**, and the ready state was already turned off by a previous command execution, or was never ready to begin with, the command displays a message to that effect. The default is **yes**.

- **port-number**

  A port number or zero (0). If you specify a known port number, the AVM attempts to use that port to create a socket to await a connection from the Debugger. If the port is in use, `proDebugConfig` reports the error and the AVM instance continues to run, without making the process ready for debugging. If you do not specify the parameter or you specify 0, the AVM determines a usable port number, which the command displays to you in the shell.

If the command succeeds in making the process debug-ready, it displays a message to that effect and terminates. If the command execution is unsuccessful, the command outputs a message to the shell, the contents of which might indicate one of the following:

- You entered an incorrect process ID.
- The process you are trying to ready for debugging might be from an earlier release or a non-OpenEdge process.
- The AVM instance is busy, perhaps performing an extremely slow query, waiting on a database lock or a response from an AppServer, and is thus unable to respond in a timely manner. The attempt, in this case, times out after 25 seconds.
The AVM instance is unable to respond, pending completion of one of the following statements:

- MESSAGE VIEW-AS ALERT BOX (GUI Windows)
- READKEY (character mode Windows)
- PAUSE (character mode Windows)

The command displays a message, instructing you to satisfy the condition and retry the operation.

You tried to change the debug-ready state of a process that is already in a debug session.

For a WebSpeed agent, when the command successfully alters the debug-ready state, it writes the status (on or off) to the WebSpeed log file.

For an AppServer process, when the command successfully alters the debug-ready state, it writes the status (on or off) to the server log file.

If the AppServer is currently waiting for a new request, the Debugger will get control on the next line of executable ABL code.

For more information on starting the debugger in attachable mode, see the “Debugging in attachable mode” section on page 2–18.
Stacked applications

In all three modes, you can stack applications. That is, you can run a new application at any interruption point of an executing application. When you do so, the previous application waits on the procedure call stack. The new application can access any shared or global data defined by previous applications stacked in the Debugger context. When the new application exits, it returns control to the Debugger, and the previous application is ready to continue at its current interruption point. When the Debugger exits, it closes all applications stacked in the Debugger context before returning to its startup environment.
Debugging from the Procedure Editor

Starting the Debugger from the Procedure Editor runs the Debugger in application mode, ready to debug the procedure that is running and any other procedures you choose.

To start a debugging session from the Procedure Editor, enter or open a procedure in the Editor buffer and choose Compile→Debug. Figure 2–3 shows the Procedure Editor in Windows.

Figure 2–3: Debugging from the Procedure Editor

After you choose Compile→Debug, the Procedure Editor:

1. Saves a temporary file containing your procedure to the current working directory, using a unique, alphanumeric filename with a .ped extension (as the Procedure Editor always does)
2. Initializes the Debugger
3. Sets a breakpoint on the first executable line of your procedure
4. Runs your procedure

The AVM instance immediately gives control to the Debugger at the initial breakpoint.
Debugging from the AppBuilder

Starting the Debugger from the AppBuilder runs the Debugger in application mode, ready to debug the procedure that is running and any other procedures you choose.

To start a debugging session from the AppBuilder, open an application procedure and choose **Compile ➔ Debug**, as shown in Figure 2–4.

![Debugging from the AppBuilder in Windows](image)

**Figure 2–4: Debugging from the AppBuilder in Windows**

After you choose **Compile ➔ Debug**, the AppBuilder:

1. Saves a temporary file containing your procedure to the current working directory, using a unique, alphanumeric filename with a .ab extension (as the AppBuilder always does)
2. Initializes the Debugger
3. Sets a breakpoint on the first executable line of your procedure
4. Runs your procedure

The AVM instance immediately gives control to the Debugger at the initial breakpoint.
Debugging from the ADE Desktop

Starting the Debugger from the ADE Desktop runs the Debugger in stand-alone mode, ready to execute and debug any procedures you open in the Debugger window.

**Note:** The Debugger does not automatically set a breakpoint on the first executable line of procedures you execute from the Debugger when you start it from the ADE Desktop. Be sure to set at least one breakpoint before running a procedure.

To start a debugging session from the ADE Desktop, choose **Tools → Application Debugger** or click on the **Application Debugger** button on the toolbar. Figure 2–5 shows the **Application Debugger** menu option and toolbar button in Windows.

![Figure 2–5: Debugging from the ADE Desktop](image)

The ADE Desktop immediately initializes and gives control to the Debugger, without an initial application running. Starting from the ADE Desktop runs the Debugger in stand-alone mode, ready to execute and debug any procedures you open in the Debugger window. Note the Debugger does not automatically set a breakpoint on the first executable line of procedures you execute from the Debugger when you start it from the ADE Desktop. Be sure to set at least one breakpoint before running a procedure.

**Note:** You can use the **Interrupt** option from the Debugger window to stop execution of most any procedure, whether or not it has a breakpoint set. For more information on the **Interrupt** and **Breakpoints** options, see Chapter 3, “Debugger Window and Files.”
Debugging from the OpenEdge command line

Starting the Debugger from the command line using the Debugger startup parameter (-debug) runs the Debugger in stand-alone mode.

To start a debugging session from the OpenEdge command line, run the client session with the Debugger (-debug) startup parameter, as in the following example:

```
pro sports -debug
```

The Debugger is the entry point for all application procedures you want to run. The Debugger starts and allows you to open a procedure and set breakpoints in the procedure before running it, using Debug→Run.

To start a single-user debugging session from the OpenEdge command line and start debugging the arrmenu.p procedure, run the client session with the Startup Procedure (-p) startup parameter, as in the following example:

```
pro sports -p arrmenu.p -debug
```

This command runs the Debugger in stand-alone mode, ready to execute and debug arrmenu.p (or any other procedures you choose). An automatic breakpoint is set on the first executable line of arrmenu.p.
Debugging from alert dialog boxes

When an unhandled ABL error or .NET Exception occurs—there is no CATCH or NO-ERROR logic present—in an interactive session for any ABL client, the AVM displays an Error message box. When Debug Alert is TRUE, the message box also includes a Help button. Clicking on the Help button produces a Stack Trace dialog box containing ABL stack trace and .NET stack trace information. The top of the stack (most recent call) is displayed at the top of the trace listing.

If you want alert dialog boxes displayed by a client application to include a Help button that provides access to a Stack Trace dialog box and the Debugger, start the client using the Debug Alert (-debugalert) client startup parameter or set SESSION:DEBUG-ALERT to TRUE. For more information on the Debug Alert startup parameter, see the reference entry in OpenEdge Deployment: Startup Command and Parameter Reference. Figure 2–6 shows an alert dialog box with a Help button.

![Image of an alert dialog box with a Help button]

**Figure 2–6: Alert dialog box with Stack Trace Help button**

**Note:** You can enable this feature using the SESSION system handle. For more information, see Chapter 4, “Using System Handles for Debugging.”

When you click the Help button, a Stack Trace dialog box opens, displaying the ABL stack trace for the currently executing client session. This information is helpful to determine where unhandled errors are occurring in your code. Stack trace information is included for error messages, ABL Alert-box messages, and .NET Exception messages. The top of the ABL stack and the top of the .NET stack is displayed at the top of their respective trace listings.
The following procedure describes the steps you can take to demonstrate how the stack trace feature works.

**To demonstrate the stack trace feature:**

1. Start an OpenEdge Procedure Editor client session. If you want to see a .NET stack trace, the session must be running on Windows.

2. Type or cut-and-paste the following source code into the Procedure Editor:

```plaintext
USING System.Windows.Forms.*.
DEFINE VARIABLE mainForm AS Form NO-UNDO.
DEFINE VARIABLE form2 AS Form NO-UNDO.
DEFINE VARIABLE dlgForm AS Form NO-UNDO.
DEFINE VARIABLE btn AS Button NO-UNDO.

ASSIGN
    mainForm = NEW Form()
    mainForm:Text = "Main and Only Form"
    btn = NEW Button().

mainForm:Controls:ADD(btn).
btn:Click:Subscribe("BtnClick").

WAIT-FOR Application:Run(mainForm).
MESSAGE "Done" VIEW-AS ALERT-BOX INFO BUTTONS OK.

PROCEDURE btnClick:
    DEFINE INPUT PARAMETER sender AS Button NO-UNDO.
    DEFINE INPUT PARAMETER args AS MouseEventArgs NO-UNDO.
    RUN newForm.
END.

PROCEDURE newForm:
    form2 = NEW Form().
    WAIT-FOR Application:Run(form2). /* This should fail w/.NET Exception */
END.
```

3. Press F2 or select **Compile→ Run** from the main menu to compile and run the code. A form window appears with the title “Main and Only Form”.

4. Click on the button. A .NET Exception Error message box appears.

5. Click on the **Help** button in the Error message box. The Stack Trace dialog box appears containing the ABL stack trace, followed by the .NET stack trace.
Figure 2–7 shows a sample **Stack Trace** dialog box, with the ABL stack trace shown first, followed by the .NET stack trace.

![Stack Trace dialog box](image)

**Figure 2–7:** Stack Trace dialog box

To start the Debugger from the Stack Trace dialog box:

1. In the alert dialog box, click the **Help** button to open the **Stack Trace** dialog box.
2. Click the **Debug** button in the **Stack Trace** dialog box. The **Stack Trace** dialog box closes, returning to the initial **Alert** dialog box.

**Note:** If you click **OK** in the **Stack Trace** dialog box instead of **Debug**, you return to the **Alert** dialog box without starting the Debugger. If you click **OK** in the **Alert** dialog box at this point, you return to the location from which you ran your code without starting the Debugger.

3. Click **OK** in the **Alert** dialog box to start the Debugger. (You must dismiss the **Alert** dialog box to start the Debugger.)

**Note:** It is possible that the original error caused the application to stop. In this case the Debugger cannot take control, since the application is no longer executing.
Debugging from an ABL procedure

Starting the Debugger from an ABL procedure using the DEBUGGER or SESSION system handle runs the Debugger in either application or stand-alone mode.

The DEBUGGER system handle provides attributes and methods that allow you to start and control a debugging session from an ABL procedure. It is intended for experienced ABL programmers who want to:

- Control breakpoints at specific points in their code, regardless of how the surrounding code is modified, or set breakpoints in include files that might appear in many different procedures.
- Develop their own ABL or OpenEdge development tools, and initialize and control Debugger interaction from those tools.
- Debug AppServer and WebSpeed applications.

The SESSION system handle allows you to specify whether you want alert dialog boxes to include a Help button that provides access to a Stack Trace dialog box and the Debugger. For more information on starting the Debugger from alert dialog boxes, see the “Debugging from alert dialog boxes” section on page 2–14.

For information on using the DEBUGGER and SESSION system handles, see Chapter 4, “Using System Handles for Debugging.”
Debugging in attachable mode

Starting the Debugger, then attaching to a debug-ready client process, runs the Debugger in attachable mode. Be sure to read the “Attachable mode” section on page 2–4.

To start the Debugger in attachable mode, follow the instructions below, based on your platform:

- **Windows** — From the Start menu, choose Programs→OpenEdge→ Debugger.
- **UNIX** — Change directory (cd) to $DLC/bin. At the prompt, type proDebugger.

When you start the Debugger in attachable mode, the user interface appears the same as for other modes; however, the only options available are:

- To make changes to preferences using the Preferences dialog box. For more information on the Preferences dialog box, see the “Preferences dialog box” section on page 3–45.
- To attach the Debugger to a process using the Attach to Process dialog box. For more information on the Attach to Process dialog box, see the “Attach to Process dialog box” section on page 3–23.

For more information on making a process ready for debugging, see the “Making the process ready for debugging” section on page 2–5.

Detaching from the process

After successfully attaching to a running client process, the Debug→Attach to Process menu item becomes Debug→Detach from Process. When you choose this menu option, the Debugger disconnects from the socket it uses to communicate with the AVM instance. If the debug-ready state was initiated by the Debugger, it then asks if you want to leave the process in a debug-ready state. Choose Yes or No, as appropriate. No is the default.

After you detach from the process, the Debugger returns to its startup state, with the menu item restored to Debug→Attach to Process. You can now attach to another process or close the Debugger.

If you attempt to close the Debugger window while it is attached to a process, the Debugger asks for confirmation. If you confirm, the Debugger disconnects from the process and might ask if you want to leave the process in a debug-ready state. Answer Yes or No. The Debugger then shuts down.

**Note:** In attachable mode, the Debugger remains open if you close the OpenEdge session, or when the current application completes, unlike other operating modes, where the Debugger itself shuts down as well.
Debugger Window and Files

The Debugger window is your primary means of interacting with the Debugger. It operates independently of any window used by your ABL (Advanced Business Language) application. From the Debugger window, you can control most Debugger features, from setting breakpoints and watches to listing and executing procedures under Debugger control.

The Debugger window provides panes, menus, toolbar buttons, and dialog boxes that you use to invoke Debugger commands and view results. You can configure various window settings and save them for future debugging sessions.

The following sections describe the Debugger window components and files:

- Debugger window layout
- Debugger window panes
- Debugger title bar
- Debugger menu bar options
- Debugger toolbar buttons
- Debugger status bar
- Debugger dialog boxes
- Debugger files
Debugger window layout

The layout of the Debugger window generally is the same on all supported systems; any significant differences are described in this chapter. The exact dimensions and layout of your Debugger window might differ, depending on the size and resolution of your monitor. However, the general layout of the window is fixed.

The Debugger window contains four panes, as well as a title bar, menu bar, toolbar, and status bar. You can resize the Debugger window like any other window on your system. You can also resize each pane vertically or horizontally in relation to the pane next to it. To resize the panes in Windows, point to the resize bar between the panes. When the pointer changes to a double-headed arrow, drag the resize bar up, down, right, or left. To resize the panes on UNIX, select the resize handles between the panes and drag them up, down, right, or left. Each pane provides scroll bars, as required, to allow you to access portions of the pane that might be vertically or horizontally out of view.

All panes except the source code pane can be hidden. To show or hide a Debugger window pane, select or clear the corresponding menu option on the View menu. For more information, see the “View menu” section on page 3–15.

The Debugger automatically saves these window settings and lets you set other Debugger window settings in the Preferences dialog box. For more information, see the “Preferences dialog box” section on page 3–45.

The Debugger updates all panes when it takes control of an executing procedure. For example, the stack trace pane does not reflect the current ABL stack trace while an application is executing; the Debugger updates the stack trace pane only when it encounters a breakpoint or when you step through code.
Debugger window panes

The following sections describe the Debugger window panes and how to use them:

- Source code pane
- ABL stack trace pane
- Variables pane
- Watches pane

Source code pane

The source code pane displays a read-only debug listing including breakpoints and the current line of execution. It can contain the executing procedure or any other procedure whose listing you want to see. The name of the procedure whose listing the Debugger displays appears in the Debugger title bar. For more information, see the “Debugger title bar” section on page 3–12.

The source code pane has a context (right-click) menu containing the following options: Copy, Find, Find Next, Find Previous, Add Breakpoint, Remove Breakpoint, Enable Breakpoint, Disable Breakpoint, Run to Line, and Add Watch (adds the selected item to the watches pane).

Debug listing

The debug listing is a specially prepared source code listing that lets you set breakpoints and follow the course of procedure execution in an application. It is an expanded listing file that the ABL compiler creates during procedure compilation.

The format of a debug listing is similar to the standard ABL compiler listing. Like compiler listings, debug listings expand all preprocessor, include file, and parameter references. The main difference is that the text in debug listings contains only numbered source code lines without headings, page formatting, or any of the other internal data information (such as buffer and frame use) usually provided by compiler listings.

Line numbers appear in the source code pane if you select the Include Source Line Numbers option in the Preferences dialog box. For more information, see the “Preferences dialog box” section on page 3–45. The Debugger displays line numbers by default.

The Debugger displays the listing for the executing procedure each time it receives control (for example, at a breakpoint). If the Debugger cannot find the debug listing for the procedure, it tries to generate it from the procedure source code. If the Debugger can find only the r-code for the procedure, it displays the procedure name and line number in the status bar as you step through the procedure.

For more information on procedure source files and debug listing files derived from procedure files, see the “Debugger files” section on page 3–48.
Listing indicators

When the source code pane displays the listing for the executing procedure or any procedure on the call stack, it also displays two listing indicators: a line pointer that shows the next line to execute and a breakpoint indicator that shows each line where a breakpoint is set. Table 3–1 lists the Debugger listing indicators.

Table 3–1: Listing indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Green Up Arrow]</td>
<td>The line pointer indicator for the executing procedure appears in green to the left of the next executable line. When you are viewing a procedure on the call stack other than the active procedure, the line pointer appears in yellow.</td>
</tr>
<tr>
<td>![Red Circle]</td>
<td>The breakpoint indicator appears in red to the left of each line where a breakpoint is set. Disabled breakpoints appear as red outlines. For information on maintaining breakpoints in a procedure, see the “Breakpoints dialog box” section on page 3–25.</td>
</tr>
</tbody>
</table>

Text selection

You can select one full or partial line of source code to set watches or copy to the clipboard.

Run to Line command

The Run to Line command continues program execution until it reaches a selected line of ABL code. Execution resumes with the selected line. If the Debugger encounters a breakpoint or interrupt before reaching the selected line, execution stops, and the Debugger cancels the command. The execution pointer is at the break or interrupt line.

If the selected line is not an executable line of code, the Debugger stops execution on the first executable line after the selected line. If there are no executable lines of code on or after the selected line, the Debugger stops execution on the last executable line of code in the procedure file.

If program execution ends before the Debugger reaches the selected line, the Debugger cancels Run to Line, and the debugging session ends.

To issue Run to Line, right-click on the chosen line in the source code pane and choose Run to Line from the context (right-click) menu.

You can select a line in any procedure file open in the Debugger. The selected line does not have to be in the current procedure.

ABL stack trace pane

The ABL stack trace pane displays the ABL stack trace for the executing procedure. This pane indicates what procedure you are in and what procedure you came from. The top of the pane shows the top of the stack. You can investigate the code associated with a line of the stack trace by clicking on the stack trace line. The Debugger automatically updates the source code pane, variables pane, and watches pane to reflect the code and data associated with the selected stack trace line.
Variables pane

The *variables pane* provides access to the variables associated with the current procedure. The Debugger organizes and displays variable data on tabs named for the following categories:

- Variables
- Buffers
- Parameters
- Temp Tables
- Dataset

Choose a tab to display all variables in that category. Each tab in the variables pane has a context (right-click) menu containing the following options: **Copy**, **Cut**, **Paste**, **Dataview** (displays attribute or field information for the selected variable in the Dataview dialog box), and **Add Watch** (adds the selected variable to the watches pane). For more information, see the “Dataview dialog box” section on page 3–26 and the “Add Watch dialog box” section on page 3–22.

Double-clicking on a cell containing the value of a variable makes the value editable. You can modify the value by entering a different value and pressing the **ENTER** key or clicking out of the cell. Pressing the **ESC** key when editing a value restores the current value and cancels the editing operation.

The Debugger displays raw (unformatted) variable data. For example, a decimal value of 1,234.56 appears as 1234.56; 1.00 appears as 1. Do not use formatting characters when entering variable values. Dynamic temp-table and dataset-related objects appear in the variables tab as handle variables.

**Accessing array variables and parameters**

Array variables and parameters appear on their respective tabs in the variables pane. The Debugger displays the name of the array, the number of elements in the array (in brackets), and the data type of the array (for example, `DaysInMonth[12] INTEGER`). You can examine the value of a single array element as a watch (`DaysInMonth[3]`), or examine the value of all elements in an array in the **Array** tab of the Dataview dialog box.

If an array has an indeterminate extent (that is, it was declared as **EXTENT** with no limiting expression), the Debugger displays the current value of the **EXTENT** function for the array. Before the array’s size is determined, the extent of the array is unknown, so the Debugger displays `[?]` in the **Value** column for the variable or parameter. When the array is populated or received as a parameter from an array with a known size, the extent is set. For example, if a calling procedure declares the array as **EXTENT 5** and passes it to a procedure where the array was declared to have an indeterminate extent, the receiving array is set to an extent of 5, once the procedure is called. At this point, the Debugger displays [5] as the value, and there is no indication the array originally was declared as having an indeterminate extent.
Accessing BLOB fields

You use BLOB (Binary Large OBject) fields to store large amounts of arbitrary binary data. A BLOB is similar to a MEMPTR, and the Debugger handles BLOBs in much the same way as MEMPTRs. Specifically, the Debugger displays the total length of a BLOB (in parentheses) followed by the first 256 bytes of data in the BLOB (as a hexadecimal string). If a BLOB contains more than 256 bytes of data, the Debugger displays an ellipsis indicating there is more data than shown. For example:

```
(133496) 64 42 74 65 0A 69 20 6D 20 64 75 65 21 0D ...
```

You cannot edit BLOB values; the Value cell is read-only.

Due to its small size, the Value cell shows only a small part of the BLOB data. To see the full 256 bytes of BLOB data, examine the BLOB in the Value tab of the Dataview dialog box.

Accessing CLOB fields and LONGCHAR variables

You use CLOB (Character Large OBject) fields and LONGCHAR variables to store large amounts of character data. The Debugger displays the total length of a CLOB or LONGCHAR (in parentheses) followed by the first 256 characters in the CLOB or LONGCHAR (as a quoted string). If a CLOB or LONGCHAR contains more than 256 characters, the Debugger displays an ellipsis indicating there is more data than shown.

You cannot edit CLOB and LONGCHAR values; the Value cell is read-only.

Due to its small size, the Value cell shows only a small part of CLOB and LONGCHAR data. To see the full 256 characters of data, examine the CLOB or LONGCHAR in the Value tab of the Dataview dialog box.

Accessing DATETIME and DATETIME-TZ variables

You use a DATETIME variable to store an ABL date and time, and a DATETIME-TZ variable to store an ABL date and time, as well as a time zone value. The Debugger displays DATETIME and DATETIME-TZ variables based on the current date format specified by the DATE-FORMAT attribute for the session (typically mdy or dmy). The Debugger also interprets DATETIME and DATETIME-TZ variable assignments in this way.

You can assign a new value to a DATETIME or DATETIME-TZ variable by editing its value.

Accessing class object instances

You can access instances of user-defined classes, as well as the following types of elements that make up a class:

- Data members, which define instance data of a class
- Properties, which are similar to data members, and also provide GET and/or SET accessors containing ABL code that executes implicitly when a property is read or written
- Methods, which define the behavior of a class
The data members, properties, and methods that a class comprises are statically defined in a class and scoped to an instance of that class, and they are available inside or outside of the class hierarchy depending on their access mode (PUBLIC, PRIVATE, or PROTECTED). When accessing data members and properties, or stepping through methods, the Debugger honors their access mode.

**Note:** PRIVATE members only appear when the class is the current execution frame on the ABL stack. PUBLIC and PROTECTED members appear from any execution frame that references them.

For more information about user-defined classes, and their data members, properties, and methods, see *OpenEdge Development: Object-oriented Programming*.

The Debugger displays the object reference for an instance of a user-defined class as an INTEGER value followed by the name of the instance (in parentheses). For example "1101 (Class MyClass)".

You can examine and edit the value of data members and properties for an instance of a user-defined class in the variables pane, the watches pane, or the Dataview dialog box.

**Accessing object properties**

A property typically defines and implements a GET and/or SET accessor, which provides a class object instance with read and write access to the property's data value, respectively. However, a property can define a GET and/or SET accessor without an implementation. In this case, the accessor reads the value from or writes the value to the property’s default memory (that is, a default storage area that holds the property’s current value). At the very least, a property must define either a GET accessor or a SET accessor in order to read or write the property’s value.

If the property defines and implements a GET or SET accessor, the accessor implementation executes implicitly. When you step into code that reads or writes a property’s value, the Debugger steps into the ABL code of that accessor implementation.

In certain cases, the code structure is such that errors occur when the GET accessor implementation executes. This happens, for example, if the implementation uses a buffer handle, and the Debugger executes the accessor before the handle is assigned. To prevent this problem, you can disable the evaluation by the Debugger of properties that have non-empty accessor methods. To do so, start the OpenEdge Client session with the -noevalprops startup parameter. For more information, see *OpenEdge Deployment: Startup Command and Parameter Reference*.

Consider the following Debugger behavior when examining and editing property values:

- If the property only defines a GET or SET accessor, and does not provide an implementation for the accessor, the Debugger reads the value from or writes the value to the property’s default memory.
- If the property does not define a GET accessor, the Debugger cannot read the property’s value and displays "** Unavailable **" in the property’s Value cell.
- If the property does not define a SET accessor, the Debugger cannot write the property’s value (the Value cell is read-only).
• If the property defines only a SET accessor, and no GET accessor, the Debugger can write the property’s value but will immediately display "** Unavailable **" in the property’s Value cell.

• If you started the OpenEdge session with the -noevalprops startup parameter, the Value cell displays "** Property evaluation disabled **" for those properties that have a GET method with an implementation. In this case, you can inspect the value of a property in the Dataview dialog box (see the “Dataview dialog box” section on page 3–26.) Note that ABL properties with empty GET methods are always evaluated.

**Note:** If a property defines and implements a GET or SET accessor, the value of the property can change each time the Debugger reads or writes the property because the accessor implementation will execute each time, and its logic might change the property’s value. For example, a property’s GET accessor might calculate the property’s value based on the current time.

Accessing ProDataSet objects

The ProDataSet object is a collection of temp-table buffer objects and relations among the temp-table objects. A ProDataSet consists of three object types—DATASET, DATA-RELATION, and DATA-SOURCE—each with several attributes and methods. The Dataset tab contains the names of all static ProDataSet-related objects declared in the current procedure context. You can right-click on any listed object and choose Dataview from the pop-up menu, to see the object’s attributes.

Watches pane

The watches pane keeps track of variables, buffer fields, attributes, data, and built-in ABL functions on which a watch is set. For more information on functions as watches, see the “Watches for built-in functions” section on page 3–10.

The watches pane has a context (right-click) menu containing the following options: Copy, Cut, Paste, Add Watch (adds a new variable to the watches pane), Remove Watch, and Dataview (displays attribute or field information for the selected variable in the Dataview dialog box).

You can add a watch by doing any of the following:

• Entering the watch into the last line of the watches pane directly.

• Entering the watch in the Add Watch dialog box. For more information, see the “Add Watch dialog box” section on page 3–22.

• Selecting text in the source code pane, or selecting a variable or parameter in the variables pane, and then choosing the Add Watch option on the context (right-click) menu.

• Selecting text in the source code pane and dragging it to the watches pane. For more information, see the “Drag-and-drop watches” section on page 3–11.

• Selecting an entity in the Dataview dialog box and choosing the Add Watch button.
Note the following with respect to validity checking of the selected text:

- Selected text that is improperly formatted displays "** Error **" in its Value cell.
- Selected text that is properly formatted but that refers to an out-of-scope or nonexistent variable displays "** Unavailable **" in its Value cell.

Valid watch formats are any of the following:

<table>
<thead>
<tr>
<th>VARIABLE</th>
<th>FIELD</th>
<th>PARAMETER</th>
<th>name</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle:attribute</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>object-reference[[array-index]]::data-member[[array-index]]</td>
<td>property</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[data-member[[array-index]]</td>
<td>property</td>
<td></td>
<td></td>
</tr>
<tr>
<td>widget-name[[array-index]]:attribute [IN FRAME frame-name]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>{ FRAME</td>
<td>MENU } widget-name:attribute</td>
<td></td>
<td></td>
</tr>
<tr>
<td>{ SUB-MENU</td>
<td>MENU-ITEM } widget-name:attribute</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[ IN { MENU</td>
<td>SUB-MENU } menu-name ]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can chain attribute and property references. For example, the following attribute reference displays the value of the TITLE attribute for a window containing a fill-in (assuming the fill-in is three levels from the window):

FILL-IN-1:PARENT:PARENT:PARENT:TITLE

If a variable is currently out of scope, or you add a watch for an unknown variable name, the following message appears in the Value cell:

** Unavailable **

If evaluation of properties is disabled (by means of the -noevalprops startup parameter), the following message appears in the Value cell for properties that have a non-empty accessor method (ABL properties that have an empty GET method are always evaluated):

** Property evaluation disabled**

Note: You can use the Value tab of the Dataview dialog box to inspect the value of a property, whether or not evaluation of properties is disabled. See the “Dataview dialog box” section on page 3–26 for more information.
Double-clicking on a cell containing the value of a variable makes the value editable. You can modify the value by entering a different value and pressing the ENTER key or clicking out of the cell. Pressing the ESC key when editing a value restores the current value and cancels the editing operation.

You can remove a watch for a variable by selecting the watch in the watches pane and then:

- Pressing the DELETE key
- Choosing the Remove Watch option on the context (right-click) menu or Debug menu

**Watches for built-in functions**

You can add a watch to a built-in ABL function to track the status of the function.

To add a new watch, type the complete function name directly in the watches pane or choose Debug → Add Watch. The Debugger displays the function and its value in the Watches pane.

Table 3–2 lists the ABL functions supported by the Debugger.

<table>
<thead>
<tr>
<th>Functions that can accept assignment of a new value</th>
<th>Functions that cannot accept assignment of a new value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURRENT-LANGUAGE</td>
<td>_PCONTROL</td>
</tr>
<tr>
<td>PROMSGS</td>
<td>_SERIAL-NUM</td>
</tr>
<tr>
<td>PROPATH</td>
<td>COM_SELF</td>
</tr>
<tr>
<td></td>
<td>DATASERVERS</td>
</tr>
<tr>
<td></td>
<td>DBNAME</td>
</tr>
<tr>
<td></td>
<td>ETIME</td>
</tr>
<tr>
<td></td>
<td>FRAME-DB</td>
</tr>
<tr>
<td></td>
<td>FRAME-FIELD</td>
</tr>
<tr>
<td></td>
<td>FRAME-INDEX</td>
</tr>
<tr>
<td></td>
<td>FRAME-NAME</td>
</tr>
<tr>
<td></td>
<td>FRAME-VALUE</td>
</tr>
<tr>
<td></td>
<td>GO-PENDING</td>
</tr>
<tr>
<td></td>
<td>LASTKEY</td>
</tr>
<tr>
<td></td>
<td>MACHINE-CLASS</td>
</tr>
<tr>
<td></td>
<td>MESSAGE-LINES</td>
</tr>
<tr>
<td></td>
<td>NUM-ALIASES</td>
</tr>
<tr>
<td></td>
<td>NUM-DBS</td>
</tr>
<tr>
<td></td>
<td>OPSYS</td>
</tr>
<tr>
<td></td>
<td>OS-DRIVES</td>
</tr>
<tr>
<td></td>
<td>OS-ERROR</td>
</tr>
<tr>
<td></td>
<td>PROGRESS</td>
</tr>
<tr>
<td></td>
<td>PROVERSION</td>
</tr>
<tr>
<td></td>
<td>RETRY</td>
</tr>
<tr>
<td></td>
<td>RETURN-VALUE</td>
</tr>
<tr>
<td></td>
<td>SCREEN-LINES</td>
</tr>
<tr>
<td></td>
<td>TERMINAL</td>
</tr>
<tr>
<td></td>
<td>TIME</td>
</tr>
<tr>
<td></td>
<td>TODAY</td>
</tr>
<tr>
<td></td>
<td>TRANSACTION</td>
</tr>
</tbody>
</table>

*Note: TERMINAL is settable only on UNIX character interfaces.*

The values of TIME and TODAY change independently of program execution, so the values displayed in the watches pane might not agree with the last values displayed in the ABL program.

You can modify a function’s value by editing the Value cell in the Watches pane. If the function does not accept an assignment, the function retains its value. In this case, the Debugger does not generate an error message.

*Note: You cannot watch a function that requires arguments.*
Drag-and-drop watches

You can add a watch by dragging an entity to the watches pane.

To add a watch by dragging and dropping:

1. Select the text that you want to add a watch for in the source code pane (by clicking and dragging with the mouse to select the text).
2. Drag the selected text to the watches pane.
3. Release the mouse button to add the object as a watch to the last (empty) row in the watches pane. If you release the mouse over any other pane or outside the Debugger window, the watch is not added.
Debugger title bar

The Debugger title bar displays the name of the procedure whose listing the Debugger is displaying. The title bar also displays the status of the procedure in brackets, and the location of the procedure in parentheses. When the procedure is executing, the status is [run]. When the Debugger has control, the status is [break]. When the procedure is local, the location is (LOCAL). When the procedure is remote, the location is (REMOTE). If the status and location do not appear in the title bar, the procedure has not yet started executing.

Any procedure you run in application mode from a Procedure Editor buffer is displayed using a filename with a .ped extension. This is the filename for a temporary procedure file where the Procedure Editor writes the ABL contents of the buffer. The names of temporary procedure files written by the AppBuilder have a .ab extension.
Debugger menu bar options

Like other Application Development Environment (ADE) tools, the primary way to access Debugger features and functions is through menu options on pull-down menus on the menu bar. You can access menu options in more than one way, using the mouse to choose menu options, using accelerator keys and mnemonics to invoke menu options directly from the keyboard, or using tool bar buttons for more frequently used menu options.

The following sections describe the Debugger menus and how to access their options:

- Accelerator keys and mnemonics
- File menu
- Edit menu
- Search menu
- View menu
- Debug menu
- Diagnostics menu
- Data menu
- Window menu
- Help menu

Accelerator keys and mnemonics

Some menu options have predefined *accelerator keys* labeled to the right of each menu option. Accelerator keys are function keys you can press to choose a menu option.

Most menu options have a *mnemonic*, a single letter you can press to choose a menu option after you choose the menu. The mnemonic for each menu option is underlined in its label.

File menu

The File menu provides the standard means to open a file or end your debugging session. Table 3–3 describes the File menu options.

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open... (F3)</strong></td>
<td>Displays the Open dialog box, which lets you open a procedure file in the source code pane. For more information, see the “Open dialog box” section on page 3–44.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Terminates the Debugger session and returns control to the environment or application in which the Debugger was invoked.</td>
</tr>
</tbody>
</table>
Edit menu

The **Edit** menu lets you cut, copy, and paste a specified text selection, as well as set breakpoints and preferences. Table 3-4 describes the **Edit** menu options.

**Table 3–4: Edit menu**

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut (CTRL+X)</td>
<td>Cuts the text currently selected in the variables or watches pane and places it on the clipboard.</td>
</tr>
<tr>
<td>Copy (CTRL+C)</td>
<td>Copies the currently selected text in the source code, variables, or watches pane to the clipboard.</td>
</tr>
<tr>
<td>Paste (CTRL+V)</td>
<td>Pastes the contents of the clipboard to the specified position in the variables or watches pane.</td>
</tr>
<tr>
<td>Breakpoints... (CTRL+B)</td>
<td>Displays the <strong>Breakpoints</strong> dialog box, which lets you maintain breakpoints in a procedure. For more information, see the “Breakpoints dialog box” section on page 3–25.</td>
</tr>
<tr>
<td>Preferences...</td>
<td>Displays the <strong>Preferences</strong> dialog box, which lets you set user preferences for the Debugger window. For more information, see the “Preferences dialog box” section on page 3–45.</td>
</tr>
</tbody>
</table>

Search menu

The **Search** menu lets you find a specified text string in your debug listing. Table 3–5 describes the **Search** menu options.

**Table 3–5: Search menu**

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find... (CTRL+F)</td>
<td>Displays the <strong>Find</strong> dialog box, which lets you specify text you want to find in the source code pane. For more information, see the “Find dialog box” section on page 3–37.</td>
</tr>
<tr>
<td>Find Next (F9)</td>
<td>Finds the next occurrence of the specified text.</td>
</tr>
<tr>
<td>Find Prev (SHIFT+F9)</td>
<td>Finds the previous occurrence of the specified text.</td>
</tr>
</tbody>
</table>
View menu

The View menu lets you show and hide various Debugger window panes. Select or clear an option to show or hide the corresponding pane, respectively. Table 3–6 describes the View menu options.

Table 3–6: View menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables</td>
<td>Shows or hides the variables pane</td>
</tr>
<tr>
<td>Stack Trace</td>
<td>Shows or hides the ABL stack trace pane</td>
</tr>
<tr>
<td>Watches</td>
<td>Shows or hides the watches pane</td>
</tr>
</tbody>
</table>

Debug menu

The Debug menu controls procedure execution and Debugger-application interaction. Table 3–7 describes the Debug menu options.

Table 3–7: Debug menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run (F2)</td>
<td>Starts or restarts execution of the procedure currently displayed in the source code pane (when invoked by choosing File → Open or using the Debugger (-debug) and Startup Procedure (-p) startup parameters).</td>
</tr>
<tr>
<td>Continue (F5)</td>
<td>Continues execution of the procedure until it encounters a breakpoint, an interrupt, or the end of the procedure.</td>
</tr>
</tbody>
</table>
| Step Into (F7) | Executes the next statement in a procedure. If the statement calls a subprocedure or causes a trigger to execute, the Debugger steps into the subprocedure or trigger and stops at the first executable line of code. The trigger or subprocedure is now the current procedure, and you can continue execution from the current stopping point.  

**Note:** The Debugger does not step into the destructor method of an object that has been automatically deleted by garbage collection, unless the destructor contains a breakpoint. In cases where the object is explicitly deleted by means of the DELETE OBJECT statement, the Debugger does step into the destructor. |
## Debug menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step Over (F6)</td>
<td>Executes the next statement in a procedure. If the statement calls a subprocedure, or causes a trigger to execute, the Debugger executes the trigger or subprocedure without stepping into it and stops at the next executable line of code. If the Debugger encounters a breakpoint in a subprocedure or trigger, execution stops at the breakpoint, the executing subprocedure or trigger becomes the current procedure, and you can continue execution from the current breakpoint. <strong>Note:</strong> After stepping over a statement, if the next statement is in a destructor method for an object that has been deleted, the Debugger does not stop in the destructor unless the destructor contains a breakpoint. This is true whether the object is deleted automatically by garbage collection or explicitly by means of the <code>DELETE OBJECT</code> statement.</td>
</tr>
<tr>
<td>Step Out (SHIFT+F7)</td>
<td>Continues execution until the current procedure ends, returning control to the calling procedure. The execution pointer is at the next line of the calling procedure. If the Debugger encounters a breakpoint or interrupt before returning to the calling procedure, the Debugger cancels the command. The execution pointer is at the break or interrupt line. If issued from the top-level procedure on the ABL call stack and the Debugger encounters no breakpoints or interrupts before the procedure ends, the debugging session ends. The exception is if you start the Debugger with <code>-debug</code>, in which case the Debugger has control, waiting for you to launch a new ABL program.</td>
</tr>
<tr>
<td>Stop</td>
<td>Immediately terminates the executing application as if it invoked the ABL <code>STOP</code> statement at the current break or interrupt point, and rolls back uncommitted changes in the current transaction.</td>
</tr>
<tr>
<td>Interrupt (CTRL+CANCEL)</td>
<td>Interrupts and halts an executing procedure and gives control to the Debugger without setting a breakpoint.</td>
</tr>
<tr>
<td>Attach To Process...</td>
<td>Opens the <strong>Attach to Process</strong> dialog box, where you can specify a running client process to optionally make debug-ready and attach to for the purpose of debugging. This option is only available when you open the Debugger in attachable mode. For more information, see the “<strong>Attach to Process dialog box</strong>” section on page 3–23. Changes to <strong>Detach From Process</strong>, after the Debugger attaches to a process.</td>
</tr>
<tr>
<td>Start Animation</td>
<td>Enables visual feedback as the Debugger automatically steps through code line by line, by updating the watches and variables panes with current values. When specified with <strong>Step Into</strong>, the Debugger steps into <code>RUN</code> statements; with <strong>Step Over</strong>, the Debugger steps over <code>RUN</code> statements. After each line executes, the Debugger pauses briefly. Use <strong>Edit → Preferences</strong> to increase or decrease the pause.</td>
</tr>
<tr>
<td>Stop Animation</td>
<td>Terminates animated stepping. Unavailable until animated stepping is in progress.</td>
</tr>
<tr>
<td>Dataview... (CTRL+D)</td>
<td>Displays the <strong>Dataview</strong> dialog box, which lets you examine attribute and field data for a variable. For more information, see the “<strong>Dataview dialog box</strong>” section on page 3–26.</td>
</tr>
</tbody>
</table>
### Debug menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Watch...</td>
<td>Displays the Add Watch dialog box, which lets you add a watch for a variable in a procedure. For more information, see the “Add Watch dialog box” section on page 3–22.</td>
</tr>
<tr>
<td>Remove Watch</td>
<td>Removes the selected watch.</td>
</tr>
<tr>
<td>Show Transaction</td>
<td>Displays a message indicating whether there is a transaction active at the current line of the executing procedure.</td>
</tr>
</tbody>
</table>

### Diagnostics menu

The **Diagnostics** menu lets you access Debugger diagnostics tools. Table 3–8 lists the diagnostics tool available on the **Diagnostics** menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor Dynamic Objects...</td>
<td>Displays the Dynamic Object Tracking dialog box, which lets you monitor the creation and destruction of dynamic object instances in an ABL application. For more information, see the “Dynamic Object Tracking dialog box” section on page 3–32.</td>
</tr>
</tbody>
</table>

### Data menu

The **Data** menu lets you select an ABL system handle and display the attributes associated with that handle in the **Dataview** dialog box. You can modify the values of writable attributes.

**Note:** Some handles might be unknown at various stages of execution. For example, the FOCUS and SELF handles typically are valid only when a trigger is executing.

For more information on the **Dataview** dialog box, see the “Dataview dialog box” section on page 3–26. For more information on ABL system handles and their associated attributes, see *OpenEdge Development: ABL Reference*.

### Window menu

The **Window** menu lists the open files, and lets you switch to another open file. Switching to another open file does not affect the state of the executing procedure.
Help menu

The Help menu provides access to help information about the Debugger window components and your Debugger installation. Table 3–9 describes the Help menu options.

Table 3–9: Help menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics (F1)</td>
<td>Displays information about Debugger window components</td>
</tr>
<tr>
<td>About</td>
<td>Displays version information about the Debugger</td>
</tr>
</tbody>
</table>
Debugger toolbar buttons

The Debugger toolbar contains shortcut buttons for frequently used menu options. Table 3–10 describes the toolbar buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="170x587" alt="Open" /> (Open)</td>
<td>Displays the Open dialog box, which lets you open a procedure file. For more information, see the “Open dialog box” section on page 3–44.</td>
</tr>
<tr>
<td><img src="170x565" alt="Step Into" /> (Step Into)</td>
<td>Executes the next statement in a procedure. If the statement calls a subprocedure or causes a trigger to execute, the Debugger steps into the subprocedure or trigger and stops at the first executable line of code. The trigger or subprocedure is now the current procedure, and you can continue execution from the current stopping point.</td>
</tr>
<tr>
<td><img src="170x359" alt="Note" /></td>
<td><strong>Note:</strong> The Debugger does not step into the destructor method of an object that has been automatically deleted by garbage collection, unless the destructor contains a breakpoint. In cases where the object is explicitly deleted by means of the DELETE OBJECT statement, the Debugger does step into the destructor.</td>
</tr>
<tr>
<td><img src="170x442" alt="Step Over" /> (Step Over)</td>
<td>Executes the next statement in a procedure. If the statement calls a subprocedure or causes a trigger to execute, the Debugger executes the trigger or subprocedure without stepping into it and stops at the next executable line of code. If the Debugger encounters a breakpoint in a subprocedure or trigger, execution stops at the breakpoint, the executing subprocedure or trigger becomes the current procedure, and you can continue execution from the current breakpoint.</td>
</tr>
<tr>
<td><img src="170x359" alt="Note" /></td>
<td><strong>Note:</strong> After stepping over a statement, if the next statement is in a destructor method for an object that has been deleted, the Debugger does not stop in the destructor unless the destructor contains a breakpoint. This is true whether the object is deleted automatically by garbage collection or explicitly by means of the DELETE OBJECT statement.</td>
</tr>
<tr>
<td><img src="170x297" alt="Step Out" /> (Step Out)</td>
<td>Continues execution until the current procedure ends, returning control to the calling procedure. The execution pointer is at the next line of the calling procedure. If the Debugger encounters a breakpoint or interrupt before returning to the calling procedure, the Debugger cancels the command. The execution pointer is at the break or interrupt line. If issued from the top-level procedure on the ABL call stack and the Debugger encounters no breakpoints or interrupts before the procedure ends, the debugging session ends. The exception is if you start the Debugger with -debug, in which case the Debugger has control, waiting for you to launch a new ABL program.</td>
</tr>
<tr>
<td><img src="170x176" alt="Continue" /> (Continue)</td>
<td>Continues execution of the specified procedure until it encounters a breakpoint, an interrupt, or the end of the procedure.</td>
</tr>
<tr>
<td><img src="170x134" alt="Stop" /> (Stop)</td>
<td>Immediately terminates the executing application as if it invoked the ABL STOP statement at the current break or interrupt point, and rolls back uncommitted changes in the current transaction.</td>
</tr>
<tr>
<td><img src="170x90" alt="Stop Animation" /> (Stop Animation)</td>
<td>Turns off animated stepping. Appears only when animated stepping is in progress.</td>
</tr>
</tbody>
</table>
### Table 3–10: Toolbar buttons (2 of 2)

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Interrupt]</td>
<td>Interrupts and halts an executing procedure and gives control to the Debugger without setting a breakpoint.</td>
</tr>
<tr>
<td>![Help Topics]</td>
<td>Displays information about Debugger window components.</td>
</tr>
</tbody>
</table>
The Debugger status bar appears at the bottom of the Debugger window and displays the following types of information:

- Debugger status messages
- Procedure name and line number
Debugger dialog boxes

The following sections provide usage information for each of the Debugger dialog boxes and are presented in alphabetical order:

- Add Watch dialog box
- Attach to Process dialog box
- Breakpoints dialog box
- Dataview dialog box
- Dynamic Object Tracking dialog box
- Edit Breakpoint dialog box
- Find dialog box
- New Breakpoint dialog box
- Open dialog box
- Preferences dialog box
- Select Process dialog box

Add Watch dialog box

The Add Watch dialog box lets you add a watch for any variable, including fields and handle or object attributes, in the executing procedure or any procedure on the call stack. A watch allows you to keep track of the value of a variable, parameter, buffer field, attribute, data, or built-in ABL function as you navigate through your ABL application. The name and value of the variable on which the watch is set appears in the watches pane. Figure 3–2 shows the Add Watch dialog box.

![Add Watch dialog box](image-url)

**Figure 3–2:** Add Watch dialog box

Access this dialog box by choosing the Add Watch option on the Debug menu or the context (right-click) menu in the watches pane.

To add a watch, enter an entity in the Watch field and click OK. See the “Watches pane” section on page 3–8 for a list of supported watch expressions.
You can also add a watch for an entity by:

- Entering the watch in the watches pane directly
- Selecting text in the source code pane or selecting a variable in the variables pane, and then choosing the Add Watch option on the context (right-click) menu
- Selecting an entity in the Dataview dialog box and choosing the Add Watch button
- Dragging selected text from the source code pane and dropping it onto the watches pane

### Attach to Process dialog box

The Attach to Process dialog box lets you attach the Debugger to a running client process. Optionally, you can make the process debug-ready and attach to it in a single step. For more information on making a process debug-ready, see the “Making the process ready for debugging” section on page 2–5. Figure 3–3 shows the Attach to Process dialog box.

![Attach to Process dialog box](image)

**Figure 3–3: Attach to Process dialog box**

Access this dialog box by choosing Debug → Attach to Process after starting the Debugger in attachable mode. Select either of the following options:

- **Make debug-ready and attach (local host only)** — Makes a process debug-ready and attaches the Debugger to the process. Select this option only if the process is running on the same machine as the Debugger. Choosing the Get List button lets you select an existing process in the Select Process dialog box. For more information, see the “Select Process dialog box” section on page 3–47.

- **Attach to debug-ready process** — Attaches the Debugger to a process you have already made debug-ready using either the -debugReady startup parameter or the proDebugConfig command. Select this option if the ABL Virtual Machine (AVM) instance is not running on the same machine as the Debugger.
To make a process debug-ready and attach to it:

1. Select the Make debug-ready and Attach (local host only) radio button.
2. Enter the Process ID of the process on the local machine you want to debug.

To list the currently running OpenEdge processes, click the Get List button. The Select Process dialog box appears. For more information, see the “Select Process dialog box” section on page 3–47.

3. Enter a port number that you want to use for communicating with the client process, or leave the default (0), for the AVM to determine a usable port number.
4. Click OK.

Upon a successful connection, the Debugger displays a message showing the port number that it is using for the connection, in case you need to reconnect, for any reason. After the dialog box closes, the AVM instance gives control to the Debugger, and the listing for the currently running procedure appears in the source code pane, at the point where the Debugger connection was acknowledged. For hidden procedures, the source code pane appears empty, but the Debugger announces the connection and indicates that the AVM instance will break at the first line of application code. Debugging can proceed as described for all other modes.

If the connection is unsuccessful, the Debugger displays an alert box reporting the reason for the failure. For information on possible reasons for the failure, see the “Using the proDebugConfig command” section on page 2–6.

For an AppServer process or WebSpeed agent, if the Debugger successfully alters the debug-ready state, it writes the status (on or off) to the log file.

To attach to a process that is already in a debug-ready state:

1. Select the Attach to debug-ready Process radio button.
2. Enter the name of the host on which the process is running, or accept the default localhost. You must enter a host name if the process is not running on the same machine as the Debugger.
3. Enter the port number used to make the process debug-ready. For more information, see the “Making the process ready for debugging” section on page 2–5.
4. Click OK.

After successfully connecting, the dialog box closes, and the AVM instance gives control to the Debugger. The listing for the currently running procedure appears in the source code pane, at the point where the Debugger connection was acknowledged. For hidden procedures, the source code pane appears empty, but the Debugger announces the connection and indicates that the AVM instance will break at the first line of application code. Debugging can proceed as described for all other modes.
If the attempt fails because the process was not in a debug-ready state, the Debugger reports only that the connection attempt timed out (it does not recognize that the process was not in a debug-ready state). The attempt can also fail because you specified an incorrect host name or port.

**Note:** In attachable mode, when the top-level procedure terminates, possibly returning control to the Procedure Editor or AppBuilder, the Debugger window does not automatically hide, but remains in view.

If control does return to the application development environment, you restart debugging on the application by choosing **Compile → Debug**. At that point the AVM instance gives control to the Debugger, stopping at the first executable line of the application, just as it would if you had not attached.

**Breakpoints dialog box**

The **Breakpoints** dialog box lets you add, edit, remove, enable, and disable breakpoints or watchpoints. This dialog box displays all breakpoints set in the current debugging session.

A breakpoint interrupts program execution. There are three types of breakpoints:

- **At Line** — A breakpoint set at a specific line in a named procedure
- **On Error** — A breakpoint set to interrupt execution if an error occurs
- **Watchpoint** — A breakpoint set to interrupt program execution when the value of a variable, buffer field, or attribute reference changes

**Note:** A watchpoint stops program execution when an the value of a variable, buffer field, or attribute reference changes. A watch tracks values of variables, buffer fields, attributes, data and built-in ABL functions.

Figure 3–4 shows the **Breakpoints** dialog box.

![Breakpoints dialog box](image)

Access this dialog box by choosing **Edit → Breakpoints** or entering **CTRL+B**.
To enable or disable a breakpoint or watchpoint, select or clear the check box to the left of the breakpoint and click the Close button. Disabled breakpoints appear in the source code pane as red outlines.

To add a new breakpoint or watchpoint, click the New button. The New Breakpoints dialog box appears.

You can also add a breakpoint directly in the source code pane by clicking in the shaded area to the left of a code line. For more information on adding new breakpoints, see the “New Breakpoint dialog box” section on page 3–38.

To edit a breakpoint or watchpoint, select the breakpoint or watchpoint you want to edit and click the Edit button. The Edit Breakpoint dialog box appears.

For more information on editing breakpoints, see the “Edit Breakpoint dialog box” section on page 3–36.

To remove a single breakpoint or watchpoint, select it and click the Remove button.

You can also remove a single breakpoint by clicking on its breakpoint indicator in the source code pane.

To remove all breakpoints and watchpoints, click the Remove All button.

**Dataview dialog box**

The Dataview dialog box lets you examine and modify data for variables and arrays, attributes of objects, and field data for buffer objects. You can add a watch for any entity that appears in the dialog box.

Access this dialog box by choosing one of the following:

- The Dataview option on the Debug menu, or press CTRL+D
- The Dataview option on the context (right-click) menu from the watches or variables pane
- An ABL system handle on the Data menu

If you select an object before choosing the Dataview option, the object appears automatically in the Dataview dialog box. Otherwise, you can enter an object name in the View field or select an object you viewed previously from the drop-down list, and click the View button.
The **Dataview** dialog box contains the following tabs:

- **Attributes tab** — Lets you examine the attributes of a selected object or handle.
- **Fields tab** — Lets you examine fields associated with a selected buffer
- **Array tab** — Lets you examine the elements of an array
- **Value tab** — Lets you view the value of a variable, attribute or field

**Attributes tab**

The **Attributes** tab lists the attributes associated with the selected object. **Figure 3–5** shows the **Attributes** tab.

![Dataview dialog box with Attributes tab](image)

**Figure 3–5:** **Dataview** dialog box with Attributes tab

For write-only attributes, the **Value** column displays **Unavailable**.
### Fields tab

The **Fields** tab lists the fields associated with the selected object. Figure 3–6 shows the **Fields** tab.

![Dataview dialog box with Fields tab]

**Figure 3–6: Dataview dialog box with Fields tab**

To view buffer details:

1. Select the buffer in the **Variable** pane.
2. Right-click and choose **Dataview**.
3. Choose the **Field** tab to view all field values in the buffer. You can view buffer details and add a watch.

Double-clicking on a cell in the value column makes the value editable. You can modify the value of variables, attributes (writable only) or fields by entering a different value and pressing the **ENTER** key. Pressing the **ESC** key when editing a value restores the current value and cancels the editing operation.

You can modify a field value in a buffer when the buffer contains a record; however, the modified value is not immediately stored in the database. To store the modified value in the database, you must execute the appropriate statement in your ABL code (such as **RELEASE record**).
Some attributes are handles to other objects (for example, the PARENT attribute of an object is the handle to the parent of that object). In this case, you can “walk the object tree” by selecting the attribute and choosing the View button. The new attribute appears in the View field (for example, if you are viewing FILL-IN-1 and select the PARENT attribute, the new attribute appears as FILL-IN-1:PARENT). If the new attribute is a valid object handle, choosing the View button refreshes the data view for that attribute. You can access the original object by selecting it from the drop-down list and choosing the View button.

You can chain object references. For example, the following object reference displays the information for a window containing a fill-in (assuming the fill-in is three levels from the window):

```
FILL-IN-1:PARENT:PARENT:PARENT
```

### Array tab

The Array tab displays the elements of an array (a variable, parameter, or field defined with the EXTENT option) and their values. To view the elements of an array, right-click on an array in the variables pane and choose Dataview from the pop-up menu. The Dataview dialog box appears with the Array tab populated with the elements of the selected array, as shown in Figure 3–7.

![Dataview Array tab](image)

**Figure 3–7:** Array elements in the Dataview Array tab

You can also view the elements of an array field in a buffer. When viewing the buffer's fields in the Dataview dialog box, select the array field, click the View button, and then choose the Array tab to view the field's elements.

The array viewer can show a limited amount of data, approximately 30KB. If the Array tab cannot show every element of an array at once, it displays “…” as the value of the last element. Select this element and click the View button to refresh the Array tab. The array viewer then shows the next 30KB of the array, beginning at the selected element.

You can modify the elements of an array. Double-click on a cell containing the value to make it editable. Enter a different value and press the ENTER key. Pressing the ESC key when editing a value restores the current value and cancels the editing operation.
Value tab

The Value tab enables you to view the value of a discrete entity without adding a watch. Figure 3–8 shows the Value tab.

![Dataview dialog box with Value tab](image)

**Figure 3–8:** Dataview dialog box with Value tab

**Note:** You access some system handle dataviews from the Data menu. These include the LOG-MANAGER, SESSION, and ERROR-STATUS system handles.

To view an entity:

1. Enter an entity name in the edit box. You can specify the following entities:
   - Variables
   - Attributes
   - Fields
   - Handles
   - Data members
   - Properties

   You can enter expressions in colon syntax for attributes and properties (for example, `myWindow:TITLE` or `myVariable:property1`).

2. Click the View button. The entity’s value appears in the Value tab.

You can modify the value of the entity. Double-click on the value to make it editable. Enter a different value and press the ENTER key. Pressing the ESC key when editing a value restores the current value and cancels the editing operation.
Distinguishing ProDataSet methods from attributes

The Debugger displays references to the objects contained in a ProDataSet, in addition to the attributes of the ProDataSet itself. These objects are accessible via ProDataSet methods. The Debugger, however, cannot execute methods; therefore, in the Dataview dialog box, these references appear as special entries in mixed case (upper and lower), to differentiate them from the attributes, which appear in uppercase, as shown in Figure 3–9.

![Dataview dialog box](image)

**Figure 3–9: ProDataSet methods and attributes in the Dataview dialog box**

You can select one of the MemberBuffer lines and refresh the Dataview dialog box to view the buffer's attributes. The Debugger takes a similar approach to the other methods that retrieve ProDataSet-related information (GET-CHILD-RELATION, GET-SOURCE-BUFFER, and so on), as shown in the following table:

<table>
<thead>
<tr>
<th>Object</th>
<th>Method</th>
<th>Dataview object name</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUFFER</td>
<td>GET-CHILD-RELATION()</td>
<td>ChildDataRelation</td>
</tr>
<tr>
<td>DATA-SOURCE</td>
<td>GET-SOURCE-BUFFER()</td>
<td>SourceBuffer</td>
</tr>
<tr>
<td>DATASET</td>
<td>GET-BUFFER-HANDLE()</td>
<td>MemberBuffer</td>
</tr>
<tr>
<td>DATASET</td>
<td>GET-RELATION()</td>
<td>DataRelation</td>
</tr>
<tr>
<td>DATASET</td>
<td>GET-TOP-BUFFER()</td>
<td>TopBuffer</td>
</tr>
</tbody>
</table>
The Dynamic Object Tracking dialog box lets you monitor the creation and destruction of dynamic object instances in an ABL application. Use this dialog box to locate dynamic object instances the application has created, no longer needs, and has not yet destroyed. These undeleted object instances might indicate a memory leak.

Access this dialog box by choosing Diagnostics→Monitor Dynamic Objects.

The Dynamic Object Tracking dialog box contains the following tabs:

- **Control Monitoring tab** — Lets you select the types of dynamic objects you want to monitor
- **View Objects tab** — Lists the active dynamic object instances, based on the selected object types

The Dynamic Object Tracking dialog box also contains the following buttons:

- **Start Monitoring button** — Starts the object monitoring process. When processing begins, the label on this button changes to Restart Monitoring.
- **Stop Monitoring button** — Stops the object monitoring process. When processing stops, the label on the Restart Monitoring button changes back to Start Monitoring.
- **Close button** — Closes the Dynamic Object Tracking dialog box.

**Control Monitoring tab**

The Control Monitoring tab lets you select the types of dynamic objects you want to monitor. Figure 3–10 shows the Control Monitoring tab.

![Dynamic Object Tracking dialog box with Control Monitoring tab](image)

**Figure 3–10:** Dynamic Object Tracking dialog box with Control Monitoring tab
The **Control Monitoring** tab contains a treeview control that displays the types of dynamic objects you can monitor, organized within object categories. The following list shows the dynamic object types you can monitor, as they appear on the **Control Monitoring** tab:

- **Database Objects**

| QUERY (excluding query handles for static queries) | BUFFER (excluding buffer handles for static buffers) |
| TEMP-TABLE (excluding table handles for static temp-tables) | DATASET |
| DATA-SOURCE | — |

**Note:** BUFFER-FIELD objects are not listed, since an application has no control over their creation or destruction.

- **User Interface widgets**

| BROWSE | BROWSE-COLUMN (excluding handles associated with static browse objects) |
| BUTTON | COMBO-BOX |
| EDITOR | FILL-IN |
| FRAME | IMAGE |
| MENU | MENU-ITEM |
| RADIO-SET | RECTANGLE |
| SELECTION-LIST | SLIDER |
| SUB-MENU | TEXT |
| TOGGLE-BOX | WINDOW |

- **XML Objects**

| SAX-ATTRIBUTES | SAX-READER |
| SAX-WRITER | SOAP-HEADER |
| SOAP-HEADER-ENTRYREF | X-DOCUMENT |
| X-NODEREFER | — |

**Note:** SOAP-FAULT and SOAP-FAULT-DETAIL objects are not listed, since an application has no control over their creation or destruction.
• **Other Objects**

<table>
<thead>
<tr>
<th>ASYNC-REQUEST</th>
<th>CALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTROL-FRAME</td>
<td>MEMPTR (any memory allocated for a MEMPTR)</td>
</tr>
<tr>
<td>PROCEDURE (excluding handles, such as THIS-PROCEDURE, for non-persistent procedures)</td>
<td>SERVER</td>
</tr>
<tr>
<td>SERVER-SOCKET</td>
<td>SOCKET</td>
</tr>
</tbody>
</table>

**Note:** For more information on these dynamic object types, see *OpenEdge Development: ABL Reference*.

To expand a category node, click the plus sign (+) next to the node. To collapse a category node, click the minus sign (−) next to the node.

You can select all object types within a category by selecting the check box at the category node level, whether or not the node is expanded. You can also select one or more individual object types within a category, after you expand the category node, by:

- Selecting the category node check box, which selects all object types within that category, and clearing the check box for each object type you want to exclude
- Clearing the category node check box, which clears all object types within that category, and selecting the check box for each object type you want to include

To begin tracking the creation and destruction of the object instances for the object types you selected, click the **Start Monitoring** button. Then, use the **View Objects** tab to monitor the active object instances. An **active object instance** is an instance of a dynamic object the application has created, but not yet destroyed, since you started or restarted monitoring.

**View Objects tab**

The **View Objects** tab lists the active dynamic object instances based on the object types you selected in the **Control Monitoring** tab. The **View objects** includes the line of code where the object comes into being. The list is in order of object creation. Use this list to quickly determine what object needs to be deleted.
Active object instances are instances of dynamic objects the application has created, but not yet destroyed, since you started or restarted monitoring. Figure 3–11 shows the View Objects tab.

![Figure 3–11: Dynamic Object Tracking dialog box with View Objects tab](image)

While the Debugger is monitoring active object instances, the following information is displayed in the active object instances list box:

- The object type.
- The name of the procedure file in which the dynamic object was created.
- The line number at which the object was created. This is based on the Debugger listing file.
- Any relevant attribute values (such as the value of the object’s Name attribute) or other object-specific information.

If an active object instance entry for any of the following object types is marked as “Delete Pending,” execution of the DELETE OBJECT statement for that object instance has been delayed for some reason:

- TEMP-TABLE (for example, an OUTPUT TABLE-HANDLE parameter)
- BUFFER (for example, a buffer associated with an OUTPUT TABLE-HANDLE parameter)
- PROCEDURE (for example, a procedure that deletes itself using the THIS-PROCEDURE system handle)

Each time the application creates a dynamic object instance, the Debugger refreshes the list of active object instances by:

- Adding the new object instance entry (to the top of the list)
- Removing entries for any deleted object instances
Only objects of the types you selected in the Control Monitoring tab appear in the object type selection list. You can filter the object instances that appear in the active object instances list box by selecting one or more object types in the object type selection list and choosing the Filter List button. Then, only instances of the types you select appear in the list. Use the Show Complete List button to cancel any filter settings and display the complete list of objects.

While monitoring, you can clear the current list of active object instances and restart monitoring in one of the following two ways:

- By choosing the Restart Monitoring button
- By first choosing the Stop Monitoring button, and then choosing the Start Monitoring button

**Note:** Clearing the current list of active object instances does not destroy the actual object instances; it simply clears the current list that appears in the active object instances list box.

To monitor a different set of object types, modify your selection of object types on the Control Monitoring tab and click the Start Monitoring or Restart Monitoring button.

### Edit Breakpoint dialog box

The Edit Breakpoint dialog box lets you edit breakpoints. Figure 3–12 shows the Edit Breakpoint dialog box.

![Edit Breakpoint dialog box](image)

**Figure 3–12: Edit Breakpoint dialog box**

Access this dialog by choosing the Edit button on the Breakpoints dialog box. For more information, see the “Breakpoints dialog box” section on page 3–25.

The Edit Breakpoint dialog box contains the following tabs:

- **At Line** — Sets a breakpoint at a specific line in a named procedure. You can make this type of breakpoint conditional; that is, it interrupts program execution only if a defined condition is satisfied. For more information, see the “New Breakpoint dialog box” section on page 3–38.

- **On Error** — Sets a breakpoint to interrupt program execution if an error occurs. The error condition can be general or specific. For more information, see the “New Breakpoint dialog box” section on page 3–38.

- **Watchpoint** — Sets a watchpoint to interrupt program execution when the value of a variable, buffer field, or attribute reference changes. For more information, see the “New Breakpoint dialog box” section on page 3–38.
To edit a breakpoint:

1. In the **Breakpoints** dialog box, select the breakpoint you want to edit. Click the **Edit** button.

   The breakpoint information appears in the tab of the **Edit Breakpoint** dialog box appropriate to the style of breakpoint selected. The other tabs are disabled. For example, if you select an error breakpoint, it populates the **On Error** tab. The **At Line** tab and the **Watchpoint** tab are unavailable.

2. Make your edits. For example, you might want to add a condition to a procedure line breakpoint.

3. Click **OK**.

To edit a watchpoint:

1. In the **Breakpoints** dialog box, select the watchpoint you want to edit. Click the **Edit** button.

   **Note:** The **Add Watch** toggle box is unchecked by default when modifying a watchpoint.

2. Modify the watchpoint expression and/or condition.

3. Click **OK** to save your changes.

   **Note:** A watchpoint remains until you explicitly delete it.

---

**Find dialog box**

The **Find** dialog box lets you specify a text string you want to find in the source code pane. **Figure 3–13** shows the **Find** dialog box.

![Find dialog box](image)

**Figure 3–13: Find dialog box**

Access this dialog box by choosing **Search**→**Find** or pressing **CTRL+F**.

The **Find** dialog box also lets you specify the direction in which to search (Up or Down), and whether to match the letter case in the text string during the search (Match Case).

Click the **Find Next** button to begin the initial search, as well as subsequent searches, for the specified text string. The Debugger highlights the text found and scrolls the text into view, if necessary. If the text is not found, the Debugger displays an alert dialog box message.
You can also perform subsequent searches for the next and previous occurrences of the text string specified with the **Find** option by choosing **Search** → **Find Next** and **Search** → **Find Prev**, respectively. The search wraps around to the beginning of the source buffer when it reaches the end of the buffer.

### New Breakpoint dialog box

The **New Breakpoint** dialog box lets you set new breakpoints and watchpoints.

Access this dialog box by choosing the **New** button on the **Breakpoints** dialog box. For more information, see the “**Breakpoints dialog box**” section on page 3–25.

The **New Breakpoint** dialog box contains the following tabs:

- **At Line** — Sets a breakpoint at a specific line in a named procedure. You can make this type of breakpoint conditional; that is, it interrupts program execution only if a defined condition is satisfied. A breakpoint indicator appears in red in the shaded area to the left of each line in the source code pane where an **At Line** breakpoint is set. Figure 3–14 shows the **New Breakpoint** dialog box with the **At Line** tab.

  ![Figure 3–14: New Breakpoint dialog box with At Line tab](image)

- **On Error** — Sets a breakpoint to interrupt program execution if an error occurs. The error condition can be general or specific. Figure 3–15 shows the **New Breakpoint** dialog box with the **On Error** tab.

  ![Figure 3–15: New Breakpoint dialog box with On Error tab](image)

For more information on setting breakpoints if an error occurs, see the “**Setting an error-based breakpoint**” section on page 3–42.
• **Watchpoint** — Sets a watchpoint to interrupt program execution when the value of a variable, buffer field, or attribute reference changes. Figure 3–16 shows the New Breakpoint dialog box with the Watchpoint tab.

![New Breakpoint dialog box with Watchpoint tab](image)

**Figure 3–16:** New Breakpoint dialog box with Watchpoint tab

**Setting a breakpoint in a procedure**

You can set a breakpoint at a specific line.

**To add a breakpoint at a specific line in a named procedure:**

1. In the New Breakpoint dialog box, choose the At Line tab.
2. Enter the name of an ABL procedure.
3. Enter an INTEGER value that specifies a line number in the current or specified procedure.
4. Specify a condition that must be satisfied for the breakpoint to be honored (optional).
5. Click OK.

A breakpoint indicator appears in red in the shaded area to the left of each line in the source code pane where a breakpoint is set. You can also add a breakpoint by clicking in the shaded area to the left of a line in the source code pane directly.
Procedure names and line numbers

Consider the following when setting a breakpoint:

- If you specify only a procedure name, the breakpoint is set on the first executable line of the procedure.

- If you do not specify a procedure name, the breakpoint is set on the specified line in the procedure currently displayed in the source code pane.

- If you specify a line number that is before any executable line in the code for the active procedure in the Debugger context, the breakpoint is set on the first executable line on or after the specified line. For example, if you specify line number 10 for an active procedure displayed with the following lines, the breakpoint is actually set on line 12:

  10  /* Set Startup Temperature */
  11  DEFINE VARIABLE InitialTemp AS INTEGER NO-UNDO.
  12  ASSIGN InitialTemp = 32.

If there is no executable line on or after the specified line, the breakpoint is set on the last executable line. For example, if you specify line number 20 for the lines displayed above, the breakpoint is also set on line 12.

- If you specify a line number for an inactive procedure, the breakpoint is set on the specified line. When the procedure becomes active in the Debugger context, the specified breakpoint adjusts to the corresponding effective breakpoint line.

- When setting a breakpoint, there is a distinction between specifying a line number value less than 1 and specifying a value of 1 or more. Any value less than 1 (for example, 0 or -1) specifies the first executable line of the main procedure in the procedure file. Any positive value specifies the first executable line on or after the specified line in the procedure file. For example, suppose the procedure file starts out like this:

  1  DEFINE VARIABLE lStart AS LOGICAL INITIAL TRUE.
  2  PROCEDURE ShowStart:
  3    IF lStart THEN MESSAGE "Procedure is starting ...".
  4    END.
  5
  6  MESSAGE "Hello World!".
  7  RUN ShowStart.
  8  lStart = FALSE.

  .
  .
  .
If you specify a breakpoint at line 0, –1, or any other negative value, the breakpoint actually occurs at line 6, the first line that executes in the main procedure. If you specify a breakpoint at line 1 or 2, the breakpoint occurs at line 3, the first executable line after 1 and 2, which happens to be the first executable line of an internal procedure.

This distinction also affects procedures containing the trigger phrase used to define triggers in object definitions. For example, suppose the procedure file starts out like this:

```
1      DEFINE BUTTON bOK LABEL "OK"
2      TRIGGERS:
3       ON CHOOSE
4       MESSAGE "OK Pressed!".
5       END TRIGGERS.
6      MESSAGE "Hello World!".
```

Again, if you specify a breakpoint at line –1, the breakpoint occurs on line 6, but if you specify the breakpoint at line 1, it occurs at line 4, which is the first executable line of a trigger block.

**Conditional breakpoints**

A condition is any expression that the AVM can evaluate to a logical value. The expression can include variables, buffer fields, object methods and attributes, logical operators (AND, OR, and so forth), comparison operators (=, <>, EQ, NE, and so forth), and other code entities.

The AVM validates the expression syntax when the breakpoint is added, but does not check variable references. If any variables in the condition are out-of-scope or nonexistent, the AVM interrupts execution (as if honoring the breakpoint) and displays an error message in the Debugger.

If the expression attempts to execute an I/O blocking statement (for example, a user-defined function that includes an `UPDATE` statement), the AVM displays an error message over the application window, not in the Debugger window. Note in this case that code in the user-defined function preceding the `UPDATE` statement is executed.

You can add a condition to any existing breakpoint (except those that are triggered by an error) by selecting the breakpoint and choosing the **Edit** button in the Breakpoints dialog box. For more information, see the “Edit Breakpoint dialog box” section on page 3–36.
Setting an error-based breakpoint

You can set a breakpoint that is triggered by the occurrence of an error condition.

To add a breakpoint triggered by an error:

1. In the New Breakpoint dialog box, choose the On Error tab. Select the appropriate radio button, as follows:
   - Any Unsuppressed Error — The Debugger gains control on the occurrence of any error not suppressed by a NO-ERROR. This type of breakpoint appears in the Breakpoints list as “Break on any unsuppressed error.”
   - Any Error — The Debugger gains control on the occurrence of any error regardless of whether the error is suppressed by a NO-ERROR. This type of breakpoint appears in the Breakpoints list as “Break on any error.”
   - On Error — The Debugger gains control on the occurrence of the specifically identified error, regardless of whether the error is suppressed by a NO-ERROR. This type of breakpoint appears in the Breakpoints list as “Break on Error #nnnn.”

2. Enter an INTEGER of 1–5 digits that identifies a specific error (available, and required, only when On Error is selected).

3. Click OK.

Breakpoints triggered by errors

Consider the following when setting breakpoints based on errors:

- For any breakpoint triggered by an error, an alert box appears stating “Stopped due to Break on error nnnnn.” (the error number appears for all three types). The Debugger gains control at the next executable line following the line of ABL code that caused the error.

Note: For On Error, the Debugger validates that you entered a number from 1–99999, but otherwise does not verify that an error corresponding to the number exists.

- Errors that occur in hidden procedures do not trigger error breakpoints. Hidden procedures are procedures whose filename begins with an underscore (_). For more information about hidden procedures, see the “Hidden procedure files” section on page 3–50.

- If your program does not trap a stop condition (with ON STOP, for example), the Debugger ignores the error that causes the interruption, since the program terminates. Similarly, the Debugger ignores an error condition that is not trapped (with ON ERROR, for example) and results in program termination.
Setting a watchpoint

You can set a watchpoint to interrupt program execution when the value of a variable, buffer field, or attribute reference changes.

To add a watchpoint:

1. In the New Breakpoint dialog box, choose the Watchpoint tab.

2. Type the name of a variable, buffer field, object attribute, or object reference in the Expression field. You can optionally add a condition in the Condition field.

   Note: A watchpoint requires a watchpoint expression. If you do not enter an expression and click OK, an error message appears in an alert box.

3. Click OK to create the watchpoint.

Watchpoints appear in the Breakpoints dialog box as “When expression changes [and condition]”. The third and fourth items in Figure 3–17 are watchpoints.

![Figure 3–17: Watchpoint example](image)

Entering a watchpoint automatically creates a watch for the watchpoint expression. If you leave the Add Watch toggle checked, the Debugger displays the watch in the Watches pane of the Debugger's main window. You can uncheck the Add Watch toggle box to override this behavior (Add Watch is checked by default). The Debugger shows the current value of all watches each time the Debugger gains control of the application.

Note: The watch and watchpoint are not connected to each other. Deleting the watchpoint does not delete the watch. Deleting the watch does not delete the watchpoint.

If the watchpoint expression or condition is invalid, the Debugger creates the watchpoint and displays an error message. In this case, edit the watchpoint and correct the mistake. If you do not fix the watchpoint before continuing program execution, the AVM generates an error when it gains control (via Step Into, Step Over, Continue, etc.) and disables the watchpoint.
Watchpoint expressions

A watchpoint expression can be a variable (including array elements), field (including array elements), attribute reference (including chained references), or built-in ABL function, such as PROPATH. (For a complete list of valid functions, see Table 3–2.) However, the expression may not be a CLOB, BLOB, LONGCHAR, RAW, or MEMPTR variable or field. The Debugger checks only that the watchpoint expression follows the conventions for a valid watch.

Note: Watchpoints are not valid on the name of an array. You must specify a particular array element to watch.

Watchpoint conditions

A condition can be any expression that the AVM can evaluate to a logical value. The condition can include references to one or more program variables (including array elements), buffer fields (including array elements), or object attributes; you are not limited to the variable, field, or attribute specified in the watchpoint expression.

When you create a watchpoint, the Debugger checks only that the syntax of the condition is valid. The Debugger cannot verify the existence of variables and fields in the condition, as the references to variables or fields might not be in scope.

Adding a watchpoint to a watch

To add a watchpoint to an existing watch, right-click on a watch in the Watches pane and choose Create Watchpoint from the pop-up menu.

The status bar displays the message “Watchpoint created for <expression>” to inform you that the operation was successful. If the operation fails, an alert box displays an error message.

Note: If you want to add a condition to the new watchpoint created on an existing watch, you must bring up the Breakpoints dialog box, select the watchpoint, click the Edit button, and enter the condition in the Edit Breakpoint dialog box.

Open dialog box

The Open dialog box lets you open a procedure and display it in the source code pane. Figure 3–18 shows the Open dialog box.

![Open dialog box](image)

Figure 3–18: Open dialog box
Access the Open dialog box by choosing File→Open or pressing F3.

To open a procedure, select the procedure file and click the Open button, or double-click the procedure file. If you cannot find the document in the folder list, you can browse for it using the folder-level buttons.

Preferences dialog box

The Preferences dialog box lets you set user preferences for the Debugger window. Access this dialog box by choosing Edit→Preferences.

The Preferences dialog box contains the following tabs:

- **Font tab** — Lets you set the Debugger font and size
- **Settings tab** — Lets you change Debugger settings
- **Attachable tab** — Lets you add and remove debug-listing directories

Font tab

The Font tab sets the Debugger font and size across all panes. Figure 3–19 shows the Font tab.

![Figure 3–19: Preferences dialog box with Font tab](image)

Settings tab

The Settings tab sets how long to pause between steps during animated stepping and whether to include line numbers in the source code pane.

**Note:** A change to the line number setting will take effect the next time the Debugger loads a new listing file.
Figure 3–20 shows the **Settings** tab.

![Preferences dialog box with Settings tab](image)

The Debugger automatically saves the following window settings:

- Debugger window size and location (set by resizing or moving the Debugger window)
- Size of the four window panes (set by resizing the panes)
- Hidden panes (set by choosing one or more options on the **View** menu)

**Attachable tab**

The **Attachable** tab lists the debug listing directories. From this tab you can add and remove debug listing directories. The Debugger uses this list in attachable mode to locate the debug listing files. When an AVM instance and the Debugger are on separate machines, the debug listing directories must be accessible to the Debugger machine via a mapped drive (Windows) or a mounted file system (UNIX). Figure 3–21 shows the **Attachable** tab.

![Preferences dialog box with Attachable tab](image)

**Note:** The Debugger working directory appears by default.

You can generate the debug listing files either manually or automatically. For more information on generating debug listing files, see the “Debug listing files” section on page 3–48.

The Debugger automatically opens the **Preferences** dialog box to this tab if it is unable to locate a listing file for the attached process. For more information, see the “Debug listing files” section on page 3–48.
Select Process dialog box

The **Select Process** dialog box lets you obtain the list of currently running OpenEdge processes on the same machines as the Debugger. Figure 3–22 shows the **Select Process** dialog box.

![Select Process dialog box](image)

**Figure 3–22: Select Process dialog box.**

Access this dialog box by choosing the **Get List** button on the **Attach to Process** dialog box. For more information, see the “**Attach to Process dialog box**” section on page 3–23.

To select a Process ID:

1. Locate and select the process in the list. The process ID appears in the **Process ID** text box.

   **Note:** You can also type the process ID in the **Process ID** text box.

2. Click **OK**.
Debugger Window and Files

Debugger files

During a debugging session, the Debugger references procedure source files and debug listing files derived from procedure files.

The following sections describe these files, how the Debugger uses them, and how you can interact with them:

- Debug listing files
- Locating debug listing files in attachable mode
- Procedure files and listing generation

Debug listing files

A debug listing file contains a line-numbered listing of a procedure with all preprocessor directives expanded and all include files inserted. The Debugger displays this listing in the source code pane to indicate breakpoints and the next line to execute in the current procedure.

You can generate a debug listing in one of two ways:

- **Automatic listing generation** — Running a procedure during a debugging session
- **Manual listing generation** — Compiling a procedure explicitly using either the ABL `COMPILE` statement or the Application Compiler from the ADE Desktop

Automatic listing generation

Automatic listing generation is appropriate for most debugging situations where you are working with new source procedures you have not yet compiled. Automatic generation creates temporary listing files that OpenEdge removes when you end your session and exit to the operating system. These temporary listing files have alphanumeric names based on the following naming convention (without an extension):

```
"dbg_" + procedure-filename + "_" + 8-character unique-id
```

OpenEdge stores temporary debug listing files in either your current working directory or the temporary directory specified by the Temporary Directory (-T) startup parameter. For more information on how and when OpenEdge automatically generates debug listings, see the “Procedure files and listing generation” section on page 3–49. For more information on the Temporary Directory startup parameter, see the reference entry in OpenEdge Deployment: Startup Command and Parameter Reference.

**Note:** There might be occasions when a session terminates leaving temporary debug listing files in your directory. This can occur during a system crash or during any other abnormal termination of your application. You can safely delete these temporary debug listings from your directory since the Debugger creates them automatically.
**Manual listing generation**

Manual listing generation can save significant time in a debugging session, especially when debugging very large procedures. To generate a debug listing file manually, use the `DEBUG-LIST` option with the `COMPILE` statement to compile your procedure. For more information on the `COMPILE` statement and the `DEBUG-LIST` option, see *OpenEdge Development: ABL Reference*. For information on the Application Compiler, see *OpenEdge Development: Basic Development Tools*.

**Locating debug listing files in attachable mode**

In attachable mode, the Debugger locates listing files based on the directories set in the Attachable tab in the Preferences dialog box. The Debugger’s working directory is the default listing directory. When the Debugger and AVM instance are on separate machines, the debug listing directories must be accessible to the Debugger machine via a mapped drive (Windows) or a mounted file system (UNIX). If the Debugger cannot find the listings files for any reason, it opens the Preferences dialog box to the Attachable tab so that you can provide a path. For information on this tab, see the “Attachable tab” section on page 3–46.

For more information on generating listing files, see the “Debug listing files” section on page 3–48.

**Procedure files and listing generation**

You can debug procedure files in both source (.p, .w) and r-code (.r) form. OpenEdge makes every attempt to provide the debug listing for the procedure you are debugging. If necessary, OpenEdge generates the debug listing automatically (“on the fly”). Any automatic listing generation creates a temporary file that is deleted at the end of your session. For more information on temporary debug listings, see the “Debug listing files” section on page 3–48.

The method OpenEdge uses to provide a debug listing depends on the form of the procedure OpenEdge has available to execute: r-code or source code.

**Debug listing generation from r-code**

When your application runs an r-code file, OpenEdge attempts to provide the debug listing for it by searching the `PROPATH` for the associated source file (.p, .w). The r-code contains references to all associated source, include, and debug listing files, as well as its cyclic redundancy check (CRC) value.

If OpenEdge finds the source file associated with an r-code file, it compares the CRC value of the source file with the corresponding CRC value stored in the r-code. If the CRC values do not match, OpenEdge displays a warning message and continues using the file with a bad CRC value.

You can step through r-code for which the source code is unavailable; however, the Debugger cannot display the source code in the source code pane. In this case, the Debugger displays the procedure name and line number in the status bar.

**Debug listing generation from source code**

If all you have is the source code for a procedure, OpenEdge automatically generates the debug listing during compilation and saves it as a temporary file. OpenEdge generates temporary debug listings from source both when you execute a procedure for a debugging session and when you just display the procedure in the source code pane.
Hidden procedure files

The Debugger ignores hidden procedures. A hidden procedure is a procedure whose filename begins with an underscore (_). Although you can execute a hidden procedure, it is hidden from the Debugger in the following ways:

- A hidden procedure never enters the Debugger context and does not honor any breakpoints that you set in it.
- The Debugger never displays the debug listing for a hidden procedure.

The OpenEdge ADE tools that invoke the Debugger use hidden procedures to keep the tools themselves invisible to the Debugger. You can use the same technique when writing your own development tools that invoke the Debugger.
Using System Handles for Debugging

The DEBUGGER system handle provides attributes and methods that allow you to initialize, start, and control a debugging session from an ABL (Advanced Business Language) procedure. It is intended for experienced ABL programmers who want to:

- Control breakpoints at specific points in their code, regardless of how the surrounding code is modified, or set breakpoints in include files that might appear in many different procedures.

- Develop their own OpenEdge development tools, and initialize and control Debugger interaction from those tools. For example, the OpenEdge Application Development Environment (ADE) uses the DEBUGGER system handle to invoke and manage the Debugger from ADE tools such as the Procedure Editor and ADE Desktop.

- Debug AppServer and WebSpeed applications.

The SESSION system handle allows you to specify whether you want alert boxes to include a Help button that provides access to a Stack Trace dialog box and the Debugger.

This chapter contains the following sections:

- DEBUGGER system handle attributes and methods

- Using the DEBUGGER system handle to start and control the Debugger

- Using the SESSION handle to start the Debugger
DEBUGGER system handle attributes and methods

The DEBUGGER system handle attributes and methods provide a limited set of capabilities primarily designed to start up and clean up after a debugging session from an ABL procedure. Table 4–1 lists the function of each DEBUGGER system handle attribute.

Table 4–1: DEBUGGER system handle attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>Returns the object type of the Debugger, the standard value for all system handles, “PSEUDO-WIDGET”</td>
</tr>
<tr>
<td>VISIBLE</td>
<td>Displays or removes the Debugger window on the screen</td>
</tr>
</tbody>
</table>

Table 4–2 lists the function of each DEBUGGER system handle method.

Table 4–2: DEBUGGER system handle methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANCEL-BREAK( )</td>
<td>Cancels a specified breakpoint.</td>
</tr>
<tr>
<td>CLEAR( )</td>
<td>Re-initializes the internal state of the Debugger. This function has no visible effect on the Debugger window.</td>
</tr>
<tr>
<td>DEBUG( )</td>
<td>Starts and initializes the Debugger, and immediately gives control to the Debugger in stand-alone mode while blocking the invoking procedure.</td>
</tr>
<tr>
<td>DISPLAY-MSG( )</td>
<td>Displays a message in an alert box. The Debugger stores these messages and displays them to the user in an alert box when the Debugger regains control of the application.</td>
</tr>
<tr>
<td>INITIATE( )</td>
<td>Initializes the Debugger, but does not immediately give control to the Debugger. When the ABL Virtual Machine (AVM) instance encounters a breakpoint, it gives control to the Debugger in application mode, and the procedure containing the breakpoint becomes the current procedure in the Debugger context.</td>
</tr>
<tr>
<td>SET-BREAK( )</td>
<td>Sets a specified breakpoint. You cannot use this method to set a condition on a breakpoint, or to set a breakpoint triggered by an error. You can, however, add a condition to a breakpoint created using this method, by editing the breakpoint from the Breakpoints dialog box. <strong>Note:</strong> You cannot use this method to set a watchpoint.</td>
</tr>
</tbody>
</table>
For more information on the DEBUGGER system handle or its attributes and methods, see the DEBUGGER system handle reference entry in *OpenEdge Development: ABL Reference*.

You must initialize the Debugger using either the DEBUG() or INITIATE() method before using any of the remaining methods in a procedure.

**Note:** The ABL code that initiates the Debugger and displays it on the screen is responsible for removing the Debugger from the screen when it is no longer needed by setting the DEBUGGER:VISIBLE attribute to FALSE.
Using the DEBUGGER system handle to start and control the Debugger

Any technique you use to run the Debugger from an ABL procedure runs the Debugger in either application or stand-alone mode. (For an introduction to application and stand-alone mode, see Chapter 1, “Introduction.”) Each technique allows your application to interact with the Debugger context in a different way, allowing more or less control of the Debugger from your invoking application. These techniques are:

- **Application mode** — An ABL program calls the INITIATE( ) and SET-BREAK( ) methods. At the first breakpoint specified by the SET-BREAK( ) method, the Debugger runs and takes control of the procedure in which the breakpoint is set as the initial procedure in the Debugger context. In effect, the invoking procedure debugs itself. You can use this technique to implement a Debugger tool that debugs a specified subprocedure under ABL control, and optionally make the invoking procedure invisible to the Debugger context.

- **Stand-alone mode (as a tool of your application)** — An ABL program calls the DEBUG( ) method. The invoking procedure blocks until the Debugger returns (exits). In effect, the Debugger runs as a subroutine or tool of the invoking procedure and can debug only procedures you run from the Debugger. In other words, the invoking procedure is not part of the Debugger context.

Using the DEBUGGER system handle in application mode

This technique is useful in large applications under development where the line numbers change constantly and you want to break at specific points in your code, regardless of how the surrounding code is modified, or you want to set breakpoints in include files that appear in many different procedures. This technique is also useful when implementing a Debugger tool in application mode, where you can set a breakpoint in a called subprocedure to indicate where debugging should start. Use this technique to start the Debugger on an AppServer to debug a remote procedure. For more information, see the “Remote debugging” section on page 1–15.

Debugging by controlling breakpoints from an ABL procedure

To start the Debugger and control breakpoints from an ABL procedure:

1. Optionally, add a DEFINE VARIABLE statement that defines a logical variable you can use to assign the return value for DEBUGGER system handle methods.

2. Add a DEBUGGER system handle statement that invokes the INITIATE( ) method before the point where you want to begin debugging. This initializes the Debugger but does not immediately make it visible.

3. Add one or more DEBUGGER system handle statements that invoke the SET-BREAK( ) method to set at least one breakpoint that occurs after the statement where you set it. The SET-BREAK( ) method that sets the breakpoint must also execute after the statement that invokes the INITIATE( ) method in Step 2.

4. Run the invoking procedure.
For example, in the following listing fragment, the Debugger is initialized on line 6, and the procedure stops at a breakpoint on line 15. The Debugger takes control at this point. From here, you can continue executing the invoking procedure under Debugger control, stopping at and continuing from all breakpoints, as shown:

```
1  DEFINE VARIABLE procname
2       AS CHARACTER NO-UNDO EXTENT 6.
3  DEFINE VARIABLE Selection
4       AS INTEGER NO-UNDO FORMAT "9".
5  DEFINE VARIABLE debug AS LOGICAL NO-UNDO.
6 debug=DEBUGGER:INITIATE().
7 /* Initialize the list of procedure names to be run */
8 procname[1] = "custedit.p".
12 procname[5] = "itemedit.p".
14 debug=DEBUGGER::SET-BREAK().
* => 15 DISPLAY "S A L E S   O R D E R   S Y S T E M" SKIP(1)
16       WITH COLUMN 18 NO-BOX.
17 . . .
```

When you exit the Debugger, the AVM instance continues execution from its current stopping (or breaking) point. If you exit the procedure before exiting the Debugger, the Debugger window closes and control returns to the startup environment (such as the Procedure Editor or AppBuilder).

**Debugging a called subprocedure**

To debug a subprocedure called from the invoking procedure:

1. Optionally, add a **DEFINE VARIABLE** statement that defines a logical variable you can use to assign the return value for **DEBUGGER** system handle methods.

2. Add a **DEBUGGER** system handle statement that invokes the **INITIATE( )** method before the point where you want to begin debugging the called subprocedure. This initializes the Debugger but does not immediately make it visible.

3. Add a **DEBUGGER** system handle statement that invokes the **SET-BREAK( )** method to set a breakpoint at the first executable line of the subprocedure you want to debug. This statement must execute after the statement that invokes the **INITIATE( )** method in **Step 2**, but before the statement that calls the subprocedure.

4. Run the invoking procedure.
The following listing fragment prompts the user to enter the name (procname) of a procedure to debug (line 30). It then initializes the Debugger (line 33) and sets a breakpoint on the first executable line of procname (line 34). When the invoking procedure calls procname (line 35), procname breaks immediately on its first executable line and gives control to the Debugger. The Debugger then displays the listing for procname in the Debugger window as the current procedure, as shown:

```abl
  1   DEFINE VARIABLE debug    AS LOGICAL NO-UNDO.
  2   DEFINE VARIABLE procname AS CHARACTER NO-UNDO.
    ...  
  30   SET procname LABEL "Enter name of procedure to debug" DEBLANK  
       WITH SIDE-LABELS.
  31   IF procname <> "" THEN DO:  
      32   debug = DEBUGGER:INITIATE().  
      33   debug = DEBUGGER:SET-BREAK(procname).  
      34   RUN VALUE(procname).  
      35   END.  
    ...
```

**Note:** Using this technique, the invoking procedure becomes part of the Debugger context; thus, the invoking procedure appears on the call stack. You can set breakpoints in the invoking procedure and break into it with the Debugger. In this type of application, you might not want the invoking procedure running in the Debugger context like this. You can prevent the invoking procedure from entering the Debugger context by prepending its procedure name with an underscore (_). In this case, the Debugger ignores the invoking procedure completely, and it never appears on the call stack.

Although this is a simple example, it illustrates the basic elements required to build an OpenEdge development tool that can start debugging sessions for specified application procedures.

**Using the DEBUGGER system handle in stand-alone mode**

This technique is useful for running the Debugger as a tool started from one application to debug other applications. The invoking procedure runs the Debugger much like a subroutine, but it does not specify any procedure for the Debugger to run as its initial current procedure. You must run all procedures you want to debug from the Debugger after it starts by using the Run option on the Debug menu.

To start the Debugger from an ABL procedure while blocking the invoking procedure:

1. Optionally, add a DEFINE VARIABLE statement that defines a logical variable you can use to assign the return value for the DEBUGGER system handle method.
2. Add a DEBUGGER system handle statement that invokes the DEBUG( ) method at the point where you want to start the Debugger.
In the following example, the procedure presents four execution options. The first three options invoke procedures. The fourth option invokes the `DEBUG()` method and blocks at the subsequent statement (line 33) while the Debugger runs, as shown:

```lisp
1 DEFINE VARIABLE procname AS CHARACTER NO-UNDO EXTENT 3.
2 DEFINE VARIABLE programNum AS INTEGER NO-UNDO INITIAL 1
3 VIEW-AS RADIO-SET
4 RADIO-BUTTONS "Customer Report", 1,
5   "Order Report", 2,
6   "Item Report", 3,
7   "Other", 4.
8 DEFINE BUTTON runReport LABEL "Run Report".
9 DEFINE BUTTON done LABEL "Done".
10 /* Initialize the list of procedure names to be run */
11 procname[1] = "custrpt.p".
12 procname[2] = "ordrpt.p".
14
16 DISPLAY "R E P O R T I N G   S Y S T E M" SKIP(1)
17   WITH COLUMN 18 NO-BOX.
18 FORM
19   SKIP(1) space(1) programNum
20   SKIP(1) SPACE(1) runReport SPACE(2) done SPACE(1)
21   SKIP(1)
22   WITH FRAME mainMenu
23   COLUMN 21 NO-LABELS
24   TITLE "M A I N   M E N U".
25
26 ON 'choose':U OF runReport IN FRAME mainMenu
27 DO:
28   ASSIGN programNum.
29   IF programNum < 4 THEN
30     RUN VALUE(procname[programNum]).
31   ELSE
32     DEBUGGER:DEBUG().
33 END.
34
35 ON 'choose':U OF done IN FRAME mainMenu
36 APPLY "close" TO THIS-PROCEDURE.
37
38 ENABLE ALL WITH FRAME mainMenu.
39 WAIT-FOR CLOSE OF THIS-PROCEDURE.
```

When the Debugger starts, you can open a procedure using **File → Open** and then run the procedure using **Debug → Run**.

As a result, while the invoking procedure waits on the blocked statement, the Debugger runs on its own, allowing you to control any other procedure that you start from it.

When you exit the Debugger, it returns control to the invoking procedure, which continues execution from the next statement (line 33 in the example). In stand-alone mode, you cannot otherwise access the invoking procedure until the Debugger returns control.
Using the SESSION handle to start the Debugger

If you want alert boxes to include a Help button that provides access to a Stack Trace dialog box and the Debugger, use the SESSION handle and set the DEBUG-ALERT attribute to TRUE. Use the following sample code if you want alert boxes to include a Help button:

```
SESSION:DEBUG-ALERT = TRUE.
```

For more information on starting the Debugger from alert boxes, see Chapter 2, “Starting and Stopping the Debugger.”

**Note:** You can enable this feature when you start an ABL client using the Debug Alert (-debugalert) startup parameter. For information on this startup parameter, see the reference entry in *OpenEdge Deployment: Startup Command and Parameter Reference.*
Troubleshooting Resources

Chapter 5, Logging in OpenEdge
Chapter 6, Log Entry Types Detail
Chapter 7, Other Diagnostics Resources
Logging in OpenEdge

The OpenEdge logging infrastructure provides a mechanism for logging diagnostic information based on a set of logging characteristics. The following sections describe the various aspects of the logging infrastructure:

- Logging infrastructure overview
- Log files
- Log size threshold
- Log entry types
- Logging levels
- Progress Explorer and logging settings
Logging infrastructure overview

The logging infrastructure provides a means for either standard reporting of run-time activity or logging diagnostic data for troubleshooting problems based on a set of logging characteristics. OpenEdge writes information to a log file. You control the type and amount of information logged using a combination of log entry types and logging levels. Log entry types are categories of information written to the log file. Logging levels control the amount of logging information for any given log entry type and environment. Log files are described in the “Log files” section on page 5–6. Log entry types are described in the “Log entry types” section on page 5–13. Logging levels are described in the “Logging levels” section on page 5–18.

The logging infrastructure is available for all ABL (Advanced Business Language) clients, as well as the AIA, NameServer, Unified Broker, and DataServer components. Each of these components use a particular set of characteristics to specify logging within the infrastructure. Table 5–1 shows how to specify logging characteristics for each of these components.

Table 5–1: Specifying component logging characteristics

<table>
<thead>
<tr>
<th>For . . .</th>
<th>Specify settings via . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>GUI or character client</td>
<td>Startup Parameters</td>
</tr>
<tr>
<td></td>
<td>LOG–MANAGER system handle</td>
</tr>
<tr>
<td>Run-time client</td>
<td>LOG–MANAGER system handle</td>
</tr>
<tr>
<td>AppServer or WebSpeed agent</td>
<td>Progress® Explorer</td>
</tr>
<tr>
<td></td>
<td>LOG–MANAGER system handle</td>
</tr>
<tr>
<td>WebSpeed Messenger</td>
<td>Progress Explorer</td>
</tr>
<tr>
<td>Unified Broker</td>
<td>Progress Explorer</td>
</tr>
<tr>
<td>NameServer</td>
<td>Progress Explorer</td>
</tr>
<tr>
<td>AIA</td>
<td>Progress Explorer</td>
</tr>
<tr>
<td>DataServer</td>
<td>Startup Parameters</td>
</tr>
<tr>
<td></td>
<td>Progress Explorer</td>
</tr>
<tr>
<td></td>
<td>LOG–MANAGER system handle</td>
</tr>
<tr>
<td></td>
<td>DSLOG–MANAGER system handle</td>
</tr>
</tbody>
</table>
LOG-MANAGER system handle attributes and methods

The LOG-MANAGER system handle attributes and methods provide a limited set of capabilities to access the logging settings for the current ABL run-time session.

Table 5–2 lists the function of each LOG-MANAGER system handle attribute.

Table 5–2: LOG-MANAGER system handle attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Access</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTRY-TYPES-LIST</td>
<td>Readable</td>
<td>Returns a character string containing a comma-separated list of all valid entry types for the current OpenEdge environment.</td>
</tr>
<tr>
<td>LOG-ENTRY-TYPES</td>
<td>Readable/Writable</td>
<td>Specifies a comma-separated list of one or more types of log entries to write to the log file.</td>
</tr>
<tr>
<td>LOGFILE-NAME</td>
<td>Readable/Writable</td>
<td>Specifies the name of log file OpenEdge uses to log messages and ABL stack trace information.</td>
</tr>
<tr>
<td>LOGGING-LEVEL</td>
<td>Readable/Writable</td>
<td>Specifies the level at which log entries are written to the log file.</td>
</tr>
<tr>
<td>LOG-THRESHOLD</td>
<td>Readable</td>
<td>Returns the file size threshold of log files. When the current log file becomes equal to or greater than the specified size, OpenEdge renames and saves the log file and creates a new log file.</td>
</tr>
<tr>
<td>NUM-LOG-FILES</td>
<td>Readable</td>
<td>Returns the number of rolled over log files to keep on disk at any one time, for OpenEdge session, including the current log file.</td>
</tr>
<tr>
<td>TYPE</td>
<td>Readable</td>
<td>Returns the type of handle (for all system handles, “PSEUDO-WIDGET”).</td>
</tr>
</tbody>
</table>

Table 5–3 lists the function of each LOG-MANAGER system handle method.

Table 5–3: LOG-MANAGER system handle methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLEAR-LOG( )</td>
<td>Clears all messages existing in the current client log file and leaves the file open for writing</td>
</tr>
<tr>
<td>CLOSE-LOG( )</td>
<td>Stops an interactive or batch client from writing messages to the current log file, and closes the log file</td>
</tr>
<tr>
<td>WRITE-MESSAGE( )</td>
<td>Writes user messages to the current log file</td>
</tr>
</tbody>
</table>

For more information on the LOG-MANAGER system handle or its attributes and method, see the LOG-MANAGER system handle reference entry in OpenEdge Development: ABL Reference.
DSLOG-MANAGER system handle attributes and methods

The DSLOG-MANAGER system handle attributes and methods provide a limited set of capabilities to access the logging settings for the DataServer’s server context.

**Note:** The DSLOG-MANAGER is only implemented for the DataServer for MS SQL Server at this time. For run-time access to logging setting for the MSS DataServer’s client context, use the LOG-MANAGER system handle from the current ABL run-time session as described in the previous section.

A user can have a valid LOG-MANAGER and DSLOG-MANAGER system handle at the same time in an OpenEdge application since they control different log contexts. The LOG-MANAGER manages the client (or server, in the case of AppServer/WebSpeed) log file and settings which are global to any given ABL process. For DataServers, each connection to a DataServer is its own entity. For instance, you may have 2 MS SQL Server databases connected (or of other types, such as ORACLE or ODBC) and each connection works independent of the other. Each DataServer connection is a different server context and may have different logging settings. In order to support the run-time management of log settings for each connected database independently, the DSLOG-MANAGER provides the DB-CONTEXT attribute. By default, it is the unknown value which disassociates the system handle with any particular connection. The user can set the system handle to the logical database name (or alias name) of an existing connection in order to apply log settings. At another time, the user can change the DB-CONTEXT attribute back to the unknown value or to the logical database name (or alias) of another existing connection in order to modify settings for that alternative connection.

**Note:** At the time of this publication, the only supported DB-TYPE is MSS. If the database does not have the correct type, or is not connected, or has an invalid value, an error is raised by the system handle.

Table 5–4 lists the function of each DSLOG-MANAGER system handle attribute.

**Table 5–4: DSLOG-MANAGER system handle attributes**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Access</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB-CONTEXT</td>
<td>Readable/Writable</td>
<td>Attribute should be set with the name of a valid and connected logical database name of a supported db-type before any of the other attributes and method of DSLOG-MANAGER can be accessed. You can also set it to the alias of a connected database. Default value is the unknown value. When you read the DB-CONTEXT attribute, it returns the same value as it was set to unless you specify a database alias, in which case it returns the logical name of the database assigned to the alias at the time the attribute was set.</td>
</tr>
<tr>
<td>ENTRY-TYPES-LIST</td>
<td>Readable</td>
<td>Returns a character string containing a comma-separated list of all valid entry types for the current OpenEdge environment.</td>
</tr>
</tbody>
</table>
Table 5–5 lists the function of each DSLOG-MANAGER system handle method.

Table 5–5: DSLOG-MANAGER system handle methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLEAR-LOG( )</td>
<td>Clears all messages existing in the current client log file and leaves the file open for writing</td>
</tr>
<tr>
<td>WRITE-MESSAGE( )</td>
<td>Writes user messages to the current log file</td>
</tr>
</tbody>
</table>

For more information on the DSLOG-MANAGER system handle or its attributes and methods, see the DSLOG-MANAGER system handle reference entry in the OpenEdge Data Management: DataServer for Microsoft SQL Server.
Log files

A log file contains log message header information and log message content. The message content is set by the log entry type and the logging level. Log entry types are described in the “Log entry types” section on page 5–13. Logging levels are described in the “Logging levels” section on page 5–18.

The message header information is consistent across all combinations of log entry types and logging levels. For example:

```
[06/10/31@14:07:15.892-0400] P-002702 T-002867 2 4GL DYNOBJECTS
```

Where:

- 06/10/31 is the date in yy/mm/dd format
- 14:07:15.892 is the time in hh:mm:ss.mls
- 0400 is the time zone, expressed as the number of hours relative to GMT
- 002702 is the process ID
- 002867 is the thread ID
- 2 is the logging level associated with this log entry
- 4GL is the execution environment
- DYNOBJECTS is the log entry type

For an ABL client, specify the log file with the Client Logging (-clientlog) startup parameter. For AppServer and WebSpeed, the log is the normal AppServer or WebSpeed log file (for example, asbroker1.server.log). For WebSpeed Messenger, Unified Broker, NameServer, AIA, the log file is specified through Progress Explorer. For DataServers, specify the log file for the client content with the Client Logging (-clientlog) startup parameter; specify the log file for the server content with the DataServer Logging (-dslog) startup parameters.

Specifying the log filename

You can specify the name of the log file to which OpenEdge writes all errors and warning messages by using the following:

- The Client Logging (-clientlog) startup parameter
- The LOGFILE-NAME attribute on the LOG-MANAGER system handle
- The logFile and related properties in the ubroker.properties file with Progress Explorer

**Note:** Use the above to log specifications to designate log file information for DataServer clients as well. The server context of DataServers, however, starts with a default log file name of dataserver.lg and uses separate mechanisms for designating a log file name. See the DataServer Guide for MS SQL Server for more information about specifying a log filename for the server context.
Table 5–6 shows how to specify the log filename.

Table 5–6: Specifying the log filename

<table>
<thead>
<tr>
<th>Method</th>
<th>General syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Startup parameter</td>
<td>-clientlog filename</td>
<td>-clientlog mylog.log</td>
</tr>
<tr>
<td>LOG-MANAGER system handle</td>
<td>LOG-MANAGER:LOGFILE-NAME = &quot;filename&quot;</td>
<td>LOG-MANAGER:LOGFILE-NAME = &quot;mylog.log&quot;</td>
</tr>
<tr>
<td>Progress Explorer or ubroker.properties files</td>
<td>logFile = filename srvrLogFile= filename brkrLogFile= filename</td>
<td>logFile = c:\workdir\mylog.log</td>
</tr>
</tbody>
</table>

**Note:** After starting an ABL session using the Client Logging (-clientlog) startup parameter, another log filename can be specified in code using the LOGFILE-NAME attribute on the LOG-MANAGER system handle. In this case, OpenEdge stops writing to the log file specified by the Client Logging (-clientlog) startup parameter and starts writing to the log file specified by the LOGFILE-NAME attribute.

For a detailed description of the Client Logging (-clientlog) startup parameter, see *OpenEdge Deployment: Startup Command and Parameter Reference*. For a detailed description of the LOG-MANAGER system handle, see *OpenEdge Development: ABL Reference*.

For more information on ubroker.properties, see the ubroker.properties.README file in $INSTALLDIR/properties/ubroker.properties.README.

To use the Progress Explorer to view and set properties, see the “Progress Explorer and logging settings” section on page 5–20.

**Clearing the log file**

You can clear messages from the current log file and leave the log file open for writing using the following methods:

- The Clear Log (-clearlog) startup parameter
- The CLEAR-LOG( ) method on the LOG-MANAGER system handle

**Note:** This method is valid only for interactive or batch clients.

- The srvrLogAppend and related properties in the ubroker.properties file with Progress Explorer
Table 5–7 shows how to clear the log file.

**Table 5–7: Clearing the log file**

<table>
<thead>
<tr>
<th>Method</th>
<th>General syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Startup parameter</td>
<td>-clearlog</td>
<td>-clientlog mylog.log -clearlog</td>
</tr>
<tr>
<td>LOG–MANAGER system handle</td>
<td>LOG–MANAGER:CLEAR-LOG( )</td>
<td>LOG–MANAGER:CLEAR-LOG( )</td>
</tr>
<tr>
<td>Progress Explorer or ubroker.properties files</td>
<td>logAppend = 0 or 1 srvrLogAppendFile= 0 or 1 brkrLogAppend= 0 or 1</td>
<td>srvrLogAppendFile=0</td>
</tr>
</tbody>
</table>

For a detailed description of the Clear Log (-clearlog) startup parameter, see *OpenEdge Deployment: Startup Command and Parameter Reference*.

For a detailed description of the LOG–MANAGER system handle, see *OpenEdge Development: ABL Reference*.

**Writing user messages to the log file**

You can write user messages to the current log file by using the `WRITE-MESSAGE( )` method on the LOG–MANAGER system handle.

**Note:** For interactive or batch clients, the `WRITE-MESSAGE( )` method writes the log entries to the log file specified by the `LOGFILE-NAME` attribute or the Client Logging (-clientlog) startup parameter. For WebSpeed agents and AppServer agents, the `WRITE-MESSAGE( )` method writes the log entries to the server log file.

Table 5–8 shows how to write messages to the log file.

**Table 5–8: Writing messages to the log file**

<table>
<thead>
<tr>
<th>Method</th>
<th>General syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG–MANAGER system handle</td>
<td>LOG–MANAGER:WRITE-MESSAGE ( msg-exp [, subsys-exp ] )</td>
<td>LOG–MANAGER:WRITE-MESSAGE(&quot;Got here: x=&quot; + string(x), &quot;DEBUG1&quot;).</td>
</tr>
</tbody>
</table>

The following line appears in the log file:

```
[06/10/31@13:19:19.742-0500] P-003616 T-001984 1 4GL DEBUG1 Got here: x=5
```

For a detailed description of the LOG–MANAGER system handle, see *OpenEdge Development: ABL Reference*. 
Closing the log file

You can stop writing messages to the current log file, and close the current log file by using the `CLOSE-LOG()` method on the `LOG-MANAGER` system handle.

**Note:** This method is only valid for interactive or batch clients. For WebSpeed or AppServer agents, the log file closes when the broker or server shuts down.

Table 5–9 shows how to close the log file.

**Table 5–9: Closing the log file**

<table>
<thead>
<tr>
<th>Method</th>
<th>General syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG-MANAGER system handle</td>
<td>LOG-MANAGER:CLOSE-LOG( )</td>
<td>LOG-MANAGER:CLOSE-LOG( )</td>
</tr>
</tbody>
</table>

For a detailed description of the `LOG-MANAGER` system handle, see *OpenEdge Development: ABL Reference*. This method is not available to the server context of DataServers via the `DSLOG-MANAGER` system handle due to the multi-user nature of the open log file for DataServers.
Log size threshold

The log file has a size threshold, allowing more control over the amount of disk space used for log files. When the file becomes equal to or greater than the specified size, the client process renames it and creates a new log file. The default value is 0, which implies there is no limit. Possible Values are 500000–2147483647 (in bytes).

Note: The log size threshold setting of 0 implies to ignore the number of log files setting.

To specify the number of rolled-over log files, see the “Specifying the number of log files retained” section on page 5–11.

Specifying the log size threshold

You can specify the log size threshold by using:

- The Log Threshold (-logthreshold) startup parameter
- The logThreshold and related properties in the ubroker.properties file with Progress Explorer

Table 5–10 shows how to specify the log size threshold.

<table>
<thead>
<tr>
<th>Method</th>
<th>General syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Startup parameter</td>
<td>-logthreshold n</td>
<td>-logthreshold 2000000</td>
</tr>
<tr>
<td>Progress Explorer or ubroker.properties files</td>
<td>logThreshold= n srvrLogThreshold = n brkrLogThreshold = n</td>
<td>logThreshold= 2000000</td>
</tr>
</tbody>
</table>

Note: You can read the log size threshold by using the LOG-THRESHOLD attribute on the LOG-MANAGER system handle.

For a detailed description of the Log Threshold (-logthreshold) startup parameter, see OpenEdge Deployment: Startup Command and Parameter Reference.

For a detailed description of the LOG-MANAGER system handle, see OpenEdge Development: ABL Reference.

For more information on ubroker.properties, see the ubroker.properties.README file in $INSTALLDIR/properties/ubroker.properties.README.

To use the Progress Explorer to view and set properties, see the “Progress Explorer and logging settings” section on page 5–20.

This attribute is read only for the DSLOG-MANAGER system handle due to the multi-user nature of the open log file for DataServers. This value can only be set at client or broker startup.
Specifying the number of log files retained

You can specify how many rolled-over log files to keep when a log threshold value is set for a given log file. The specified number represents the maximum total number of log files to keep on disk at any time, including the log currently being written to. The number takes into account any log files that already exist at the time the session starts up plus any new ones created during that session. For example, if there are five log files on the disk at startup and you specify you want a maximum of three, OpenEdge deletes the oldest two. Then, each time it creates a new one, OpenEdge deletes the next oldest one. The default value is 3. Possible values are 0, 2, 3 or greater.

Note: A value of 0 means that OpenEdge will create as many files as necessary. Values of 1 or greater than 999999 are not valid and cause a run-time error to occur and the OpenEdge process terminates.

You can specify the number of log files retained by using:

- The Number of Log Files to Keep (-numlogfiles) startup parameter
- The numLogFiles and related properties in the ubroker.properties file with Progress Explorer

Table 5–11 shows how to specify the number of log files retained.

Table 5–11: Specifying the number of retained log files

<table>
<thead>
<tr>
<th>Method</th>
<th>General syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Startup parameter</td>
<td>-numlogfiles n</td>
<td>-numlogfiles 2</td>
</tr>
<tr>
<td>Progress Explorer or</td>
<td>numLogFiles = n</td>
<td>numLogFiles = 2</td>
</tr>
<tr>
<td>ubroker.properties files</td>
<td>srvrNumLogFiles = n</td>
<td></td>
</tr>
<tr>
<td></td>
<td>brkrNumLogFiles = n</td>
<td></td>
</tr>
</tbody>
</table>

Note: You can read the number of log files retained by using the NUM-LOG-FILES attribute on the LOG-MANAGER system handle.

For a detailed description of the Number of Log Files to Keep (-numlogfiles) startup parameter, see OpenEdge Deployment: Startup Command and Parameter Reference.

For a detailed description of the LOG-MANAGER system handle, see OpenEdge Development: ABL Reference.

For more information on ubroker.properties, see the ubroker.propertiesREADME file in $INSTALLDIR/properties/ubroker.propertiesREADME.

To use the Progress Explorer to view and set properties, see the “Progress Explorer and logging settings” section on page 5–20.

This attribute is read only for the DSLOG-MANAGER system handle due to the multi-user nature of the open log file for DataServers. This value can only be set at client or broker startup.
Filename for rolled-over log files

To order log files and avoid name conflicts, OpenEdge uses the following format for naming rolled-over log files:

```
filename.#####.extension
```

**filename**

Log filename you specify.

```#####
```

OpenEdge adds the sequence number starting at 000001 and increases for each new log file until 999999, after which it rolls back to 000001.

**extension**

Log file extension you specify.

In the following example the log file name is `asbroker1.server` and the log file extension is `log`:

```
asbroker1.server.000001.log
```

**Caution:** Do not specify the filename with a sequence number in the Client Logging (-clientlog) startup parameter or for the related property (in the `ubroker.properties` file). OpenEdge determines the correct filename and sequence number, based on the filename you specify.

**srvrLogWatchDogInterval property**

For AppServer and WebSpeed environments, there also is a property for the Unified Broker, named `srvrLogWatchDogInterval`, which specifies the number of seconds to wait before checking to see if the log file is full. The watchdog thread checks the server log file size every `n` seconds to verify if it needs to roll over the file. The default value is 60 (1 minute). This property takes effect only if `srvrLogThreshold` is specified. If you decrease or increase this value, the log file rolls over when its size is closer to or further from the specified threshold value. In other words, the more frequently the log is checked, the closer its size will be to the threshold value. And consequently, the greater the time between checks, the larger the file is likely to be, relative to the threshold value.
Log entry types

Log entry types represent categories of information you can write to a log file. Table 5–12 lists the available log entry types. The amount of detail written to the log file is determined by the logging level. For more information on logging levels, see the “Logging levels” section on page 5–18.

Table 5–12: Log entry types

<table>
<thead>
<tr>
<th>Log entry type</th>
<th>Executable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4GLMessages</td>
<td>ABL (GUI and character mode); AppServer and WebSpeed do not require this log entry type for ABL messages to be written to the log file</td>
<td>Turns on logging of ABL messages. OpenEdge writes all ABL VIEW-AS ALERT-BOX messages to the log file, together with the ABL stack, when you turn on Debug Alert, using either the Debug Alert (--debugalertlert) startup parameter or the DEBUG-ALERT attribute on the SESSION system handle. For log entry details, see the “ABL message logging” section on page 6–3.</td>
</tr>
<tr>
<td>4GLTrace</td>
<td>ABL clients, AppServer, and WebSpeed agents</td>
<td>Turns on logging for the execution of internal procedures, user-defined functions, persistent user-interface triggers, named events, and class events (generated by the RUN, FUNCTION, PUBLISH, and SUBSCRIBE statements, and (for class events) by the Publish( ), Subscribe( ), and Unsubscribe( ) event methods, respectively). It also logs the instantiation and use of classes, including execution of constructors (invoked by the NEW phrase and also by the SUPER and THIS-OBJECT statements), the execution of methods defined within classes (including those invoked using the SUPER system reference), the execution of property accessor methods (invoked by accessing a property of a class), and the execution of destructors (invoked by executing the DELETE OBJECT statement). For log entry details, see the “ABL trace logging” section on page 6–4.</td>
</tr>
</tbody>
</table>
Table 5–12: Log entry types

<table>
<thead>
<tr>
<th>Log entry type</th>
<th>Executable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4GLTrans</td>
<td>ABL clients</td>
<td>Turns on logging for the processing of transactions and subtransactions in ABL procedures. For log entry details, see the “ABL transaction logging” section on page 6–7.</td>
</tr>
<tr>
<td>AiaDefault</td>
<td>AIA</td>
<td>Turns on logging for the AIA component. For log entry details, see the “AIA logging” section on page 6–9.</td>
</tr>
<tr>
<td>AiaMgmt</td>
<td>AIA</td>
<td></td>
</tr>
<tr>
<td>AiaProp</td>
<td>AIA</td>
<td></td>
</tr>
<tr>
<td>AiaRqst</td>
<td>AIA</td>
<td></td>
</tr>
<tr>
<td>AiaUbroker</td>
<td>AIA</td>
<td></td>
</tr>
<tr>
<td>ASDefault</td>
<td>AppServer agent</td>
<td>Combines the ASPlumbing and DB.Connects log entry types. It is the default value for AppServer agents. For log entry details, see the “AppServer logging” section on page 6–10.</td>
</tr>
<tr>
<td>ASPlumbing</td>
<td>AppServer agent</td>
<td>Turns on logging for different actions, depending on the logging level specified. For log entry details, see the “AppServer logging” section on page 6–10.</td>
</tr>
<tr>
<td>DB.Connects</td>
<td>ABL clients, AppServer, and WebSpeed agents</td>
<td>Turns on logging of database connections (connects and disconnects). The log messages include database name and user ID number. For log entry details, see the “Database connection logging” section on page 6–11.</td>
</tr>
<tr>
<td>DS.Cursor</td>
<td>DataServer clients</td>
<td>Turns on logging for cursor identification from the OpenEdge client and shows various attributes tagged to the cursor selection. For log entry details, see “DSLOG-MANAGER system handle attributes and methods” section on page 5–4.</td>
</tr>
</tbody>
</table>
### Table 5–12: Log entry types

<table>
<thead>
<tr>
<th>Log entry type</th>
<th>Executable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS.QryInfo</td>
<td>DataServer clients</td>
<td>Turns on logging for query preparation from the OpenEdge client and shows various attributes tagged to server query execution. For log entry details, see “DSLOG-MANAGER system handle attributes and methods” section on page 5–4.</td>
</tr>
<tr>
<td>DynObjects.Class DynObjects.DB DynObjects.Other DynObjects.XML DynObjects.UI</td>
<td>ABL clients, AppServer, and WebSpeed agents ABL clients and WebSpeed agents</td>
<td>Turns on logging of dynamic object creation and deletion. For log entry details, see the “Dynamic object logging” section on page 6–13.</td>
</tr>
<tr>
<td>FileID</td>
<td>ABL clients, AppServer, and WebSpeed agents</td>
<td>Turns on logging of file access operations (opening and closing files), and any file access error messages that might occur. For log entry details, see the “File access logging” section on page 6–32.</td>
</tr>
<tr>
<td>IgnoredOps</td>
<td>ABL clients</td>
<td>Turns on logging of operations that the AVM ignores because the ABL windows to which they apply are embedded in .NET forms. For information about operations that the AVM ignores when they occur in the context of an embedded window, see the EmbeddedWindow property reference entry in <em>OpenEdge Development: ABL Reference</em>. For log entry details, see the “Ignored operation logging” section on page 6–33.</td>
</tr>
<tr>
<td>MsgrTrace</td>
<td>WebSpeed Messengers</td>
<td>Turns on logging for WebSpeed Messengers. The information logged depends on which Messenger is running and the logging level specified. For log entry details, see the “WebSpeed Messenger logging” section on page 6–56.</td>
</tr>
</tbody>
</table>
For a detailed description of the information written to the log file for each of these log entry types, see Chapter 6, “Log Entry Types Detail.”

### Specifying log entry types

You can specify one or more log entry types to write to the log file by using:

<table>
<thead>
<tr>
<th>Log entry type</th>
<th>Executable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSPlumbing</td>
<td>NameServer</td>
<td>Turns on logging for the NameServer component. For log entry details, see the “NameServer logging” section on page 6–34.</td>
</tr>
<tr>
<td>ProEvents.UI.Char</td>
<td>ABL clients, AppServer, and WebSpeed agents</td>
<td>Turns on event logging for different categories of events. For log entry details, see the “Event logging” section on page 6–20.</td>
</tr>
<tr>
<td>ProEvents.UI.Command</td>
<td>ABL clients, AppServer, and WebSpeed agents</td>
<td>Turns on logging of queries (each open query and FOR EACH block) executed in an application. For log entry details, see the “Query information logging” section on page 6–35.</td>
</tr>
<tr>
<td>ProEvents.Other</td>
<td>ABL clients, AppServer, and WebSpeed agents</td>
<td>Turns on logging for the SAX parser. For log entry details, see the “SAX parser logging” section on page 6–50.</td>
</tr>
<tr>
<td>QryInfo</td>
<td>ABL clients, AppServer, and WebSpeed agents</td>
<td>Turns on logging for the Unified Broker component. For log entry details, see the “Unified Broker logging” section on page 6–51.</td>
</tr>
<tr>
<td>SAX</td>
<td>ABL clients, AppServer, and WebSpeed agents</td>
<td>Turns on logging for the Web Services Adapter component. For log entry details, see the “Web Services Adapter (WSA) and Web Service logging” section on page 6–53.</td>
</tr>
</tbody>
</table>
- The Log Entry Types (-logentrytypes) startup parameter
- The LOG-ENTRY-TYPES attribute on the LOG-MANAGER system handle
- The logEntryTypes and related properties in the ubroker.properties file

Table 5–13 shows how to specify log entry types.

<table>
<thead>
<tr>
<th>Method</th>
<th>General syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Startup parameter</td>
<td>-logentrytypes [log-entry-type[level]]</td>
<td>-logentrytypes 4GLTrace:2,DynObjects.*:3</td>
</tr>
<tr>
<td>LOG-MANAGER system handle</td>
<td>LOG-MANAGER:LOG-ENTRY-TYPES = &quot;log-entry-type[level]&quot;</td>
<td>LOG-MANAGER:LOG-ENTRY-TYPES = &quot;DB.Connects,4GLTrace:2,DynObjects.UI:3&quot;</td>
</tr>
<tr>
<td>Progress Explorer or</td>
<td>logEntryTypes = &quot;log-entry-type[level]&quot;</td>
<td></td>
</tr>
<tr>
<td>ubroker.properties files</td>
<td>srvrLogEntryTypes = &quot;log-entry-type[level]&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>brkrLogEntryTypes = &quot;log-entry-type[level]&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>logEntryTypes = &quot;DB.Connects,4GLTrace:2,DynObjects.UI:3&quot;</td>
<td></td>
</tr>
</tbody>
</table>

For a detailed description of the Log Entry Types (-logentrytypes) startup parameter, see OpenEdge Deployment: Startup Command and Parameter Reference.

For a detailed description of the LOG-MANAGER system handle, see OpenEdge Development: ABL Reference.

For more information on ubroker.properties, see the ubroker.properties.README file in $INSTALLDIR/properties/ubroker.properties.README.

To use the Progress Explorer to view and set properties, see the “Progress Explorer and logging settings” section on page 5–20.

For information about specifying log entry types for the server context of DataServers, see OpenEdge Data Management: DataServer for Microsoft SQL Server.
Logging levels

Logging levels represent the amount of logging information written to the log file. Table 5–14 lists the valid logging levels.

Table 5–14: Logging levels

<table>
<thead>
<tr>
<th>Logging level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (None)</td>
<td>Logs no entries. This is equivalent to turning logging off.</td>
</tr>
<tr>
<td>1 (Errors)</td>
<td>Logs OpenEdge error messages. This includes all error messages and is unrelated to the entry types specified. Errors continue to be logged at all higher levels.</td>
</tr>
<tr>
<td>2 (Basic)</td>
<td>Log entry type determines the logged information. Each log entry type generates at least some output. This is the default.</td>
</tr>
<tr>
<td>3 (Verbose)</td>
<td>Log entry type determines the logged information.</td>
</tr>
<tr>
<td>4 (Extended)</td>
<td>Log entry type determines the logged information.</td>
</tr>
</tbody>
</table>

By default, the logging level you specify applies to all log entry types. However, you can specify a different logging level for individual log entry types. For more information, see the “Specifying log entry types” section on page 5–16.

**Note:** To turn off logging without modifying other logging characteristics, set the logging level to 0 (None). If you do not specify a log file, but do specify other logging parameters, you receive a warning message that alerts you to this inconsistency.

**Specifying the logging level**

You can specify the level at which log entries are written to the log file by setting:

- The Logging Level (-logginglevel) startup parameter
- The LOGGING-LEVEL attribute on the LOG-MANAGER system handle
- The loggingLevel and related properties in the ubroker.properties file
Table 5–15 shows how to specify logging levels.

Table 5–15: Specifying logging levels

<table>
<thead>
<tr>
<th>Method</th>
<th>General syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Startup parameter</td>
<td>(-\text{logginglevel level})</td>
<td>(-\text{logginglevel 2})</td>
</tr>
<tr>
<td>LOG-MANAGER system handle</td>
<td>LOG-MANAGER:LOGGING-LEVEL = level</td>
<td>LOG-MANAGER:LOGGING-LEVEL = 2</td>
</tr>
<tr>
<td>Progress Explorer or ubroker.properties files</td>
<td>loggingLevel = level srvrLoggingLevel = level brkrLoggingLevel = level</td>
<td>loggingLevel = 2</td>
</tr>
</tbody>
</table>

For a detailed description of the Logging Level (-logginglevel) startup parameter, see *OpenEdge Deployment: Startup Command and Parameter Reference*.

For a detailed description of the LOG-MANAGER system handle, see *OpenEdge Development: ABL Reference*.

For more information on ubroker.properties, see the ubroker.properties.README file in $INSTALLDIR/properties/ubroker.properties.README.

To use the Progress Explorer to view and set properties, see the “Progress Explorer and logging settings” section on page 5–20.

For information about specifying logging level for the server context of DataServers, see *OpenEdge Data Management: DataServer for Microsoft SQL Server*. 
Progress Explorer and logging settings

Progress Explorer provides an interactive alternative for viewing and setting logging properties for AppServer agents, WebSpeed agents, WebSpeed Messengers, Web Services Adapter (WSA) applications, AIA, NameServer, and Unified Broker.

To access the AppServer properties (for example):

1. Open Progress Explorer.
2. Connect to localhost.
4. Right-click asbroker1 and choose Properties from the pop-up menu.
5. Expand Server and choose Logging Setting. The following dialog box appears:

![Logging Setting Dialog Box]

This view shows the defaults for the various logging settings.

**Note:** You can also use the mergeprop utility installed with OpenEdge to manually edit the ubroker.properties file. For information on using mergeprop, see OpenEdge Getting Started: Installation and Configuration.

Log settings in the OpenEdge Explorer and Progress Explorer also pertain to the client context for DataServers. However, a different set of properties in the ubroker.properties file apply to logging for DataServer broker instances. To acquire information about log settings in the ubroker.properties file for DataServer brokers, see OpenEdge Data Management: DataServer for Microsoft SQL Server.
This chapter provides a detailed description of the information written to the log file for each of the log entry types. The log entry types are organized within the following categories:

- ABL message logging
- ABL trace logging
- ABL transaction logging
- AIA logging
- AppServer logging
- Database connection logging
- DataServer logging
- Dynamic object logging
- Event logging
- File access logging
- Ignored operation logging
- NameServer logging
- Query information logging
- SAX parser logging
- Unified Broker logging
- Web Services Adapter (WSA) and Web Service logging
- WebSpeed Messenger logging
ABL message logging

Specifying the ABL message (4GLMessages) log entry type turns on logging of ABL (Advanced Business Language) messages. It causes OpenEdge to write all ABL VIEW-AS ALERT-BOX messages to the log file. If the Debug Alert (-debugalert) startup parameter is used, the ABL stack is also written to the log file at the time of the message. Information is logged at Level 2 (Basic) and higher. Log entries generated for this type contain the tag 4GLMESSAGE.

**Note:** You do not need to turn on ABL message logging to have messages logged for the AppServer or WebSpeed.
ABL trace logging

Specifying the ABL trace (4GLTrace) log entry type turns on logging for the execution of internal procedures, user-defined functions, persistent triggers, named events, and class events (generated by the RUN, FUNCTION, PUBLISH, and SUBSCRIBE statements, and (for class events) by the Publish( ), Subscribe( ), and Unsubscribe( ) event methods, respectively). Class events can also include subscribing and unsubscribing handlers for .NET events and publishing ABL implementations of inherited .NET abstract events. It also logs the instantiation and use of classes, including execution of constructors (invoked by the NEW phrase and also by the SUPER and THIS-OBJECT statements), the execution of methods defined within classes (including those invoked using the SUPER system reference), the execution of property accessor methods (invoked by accessing a property of a class), and the execution of destructors (invoked by executing the DELETE OBJECT statement).

ABL trace logging is available on all ABL clients including GUI clients, character clients, WebSpeed agents, and AppServer agents. Log entries generated for this type contain the tag 4GLTrace.

ABL trace logging logs an entry message when execution begins. Entry messages are logged at Level 2 (Basic) and higher. ABL trace logging also logs a return message to indicate when the application returned. Return messages are logged at Level 3 (Verbose) and higher.

The general format for ABL trace log messages is:

```
type routine-name [PERS TRIG] [in routine-name] [PERSIST] "input-param"
[caller - source @ line-number]
```

type

The log message entry type. Table 6–1 lists the log message entry types.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Deleting class instances</td>
</tr>
<tr>
<td>Function</td>
<td>Invoking user-defined functions</td>
</tr>
<tr>
<td>Invoke</td>
<td>Invoking methods</td>
</tr>
<tr>
<td>New</td>
<td>Instantiating classes</td>
</tr>
<tr>
<td>Publish</td>
<td>Publishing both named and class events</td>
</tr>
<tr>
<td>Run</td>
<td>Running procedures</td>
</tr>
<tr>
<td>Subscribe</td>
<td>Subscribing handlers for both named and class events</td>
</tr>
<tr>
<td>Super</td>
<td>Invoking super class methods</td>
</tr>
<tr>
<td>Unsubscribe</td>
<td>Unsubscribing handlers for class events only</td>
</tr>
</tbody>
</table>
routine-name

Procedure or function name being executed. For classes, this is the name of the class being instantiated or destroyed, or the name of the invoked method.

PERS TRIG

Indicates that the procedure runs as a result of a persistent trigger. In this case, this is the only piece of information in the log entry after the routine-name.

in routine-name

For procedures, logs the calling routine-name. For example, RUN xx in yy statement, logs yy as the routine-name. For functions and methods, logs the function or method when the function or method is not located in the caller procedure or class.

PERSIST

Indicates the RUN statement has the PERSISTENT clause.

input-param

List of input and input-output parameters, each separated by a single space.

caller

Indicates where the call to the statement or function is: Main block, SYSTEM-TRIGGER, or the name of an internal procedure, function, or method.

source

Indicates the name of the procedure or class containing the caller.

@ line-number

Indicates the line number at which the procedure routine-name is executed by the caller routine. When implicitly invoking the constructor of the super class, this is the string IMPLICIT.

For example:

```
4GLTrace Run myproc in myproc2.p "my parameters" [init - foo.p @ 10]
```
The following example shows ABL trace logging for classes:

```
4GLTrace New temp [Main Block - foo.p @ 10]
4GLTrace Super tempbase [temp - temp @ 5]
4GLTrace Invoke bar in temp "3" [Main Block - foo.p @ 11]
4GLTrace Delete temp [Main Block - foo.p @12]
```

The general format for ABL trace log return messages is:

```
Return from routine-name "output-param" [program-name] [STOP | ERROR]
```

**routine-name**

Name of internal procedure, function, method, user-interface trigger, PUBLISH statement, or Main Block.

**output-param**

List of OUTPUT, INPUT-OUTPUT, and RETURN parameters.

**program-name**

Name of the program containing the called procedure.

For example:

```
4GLTrace Return from myproc "my parameters" [myproc2.p]
```

The return message includes the STOP or ERROR tag in cases where one of those conditions is raised during execution.
ABL transaction logging

Specifying the ABL transaction (4GLTrans) log entry type turns on logging of transactions and subtransactions in ABL procedures. ABL transaction logging logs a message whenever a transaction or subtransaction begins or ends, or when a transaction is undone. Logging ABL transaction activity is useful in identifying transaction processing or scoping errors in your application.

The 4GLTrans log entry type provides information at the following logging levels:

- **Level 2 (Basic)** — Logs messages when a transaction begins or ends, or when a transaction is undone
- **Level 3 (Verbose)** — Logs messages when a transaction or subtransaction begins or ends, or when a transaction or subtransaction is undone

The format for ABL transaction log messages is:

```
{ BEGIN | END | UNDO } [ SUB-TRANS trans-id [ proc-name @ line-number ] ]
```

**BEGIN**

Indicates the beginning of a transaction or subtransaction block.

**END**

Indicates the end of a transaction or subtransaction block, where any changes made during the transaction or subtransaction were committed.

**UNDO**

Indicates the end of a transaction or subtransaction block, where any changes made during the transaction or subtransaction were undone (rolled back).

**SUB-TRANS**

Indicates the log entry is for a subtransaction (occurring within the scope of the currently active transaction).

**TRANS**

Indicates the log entry is for a transaction.

**trans-id**

A unique transaction identifier, which lets you locate the matching BEGIN and END messages for a single transaction or subtransaction block within a log file.
**proc-name**

The name of the procedure in which the transaction or subtransaction occurred.

@ **line-number**

The line number (in the debug listing for the procedure specified in *proc-name*) at which the transaction began or ended.

The following procedure and log file output excerpts demonstrate transaction logging:

```/* trantest.p */
DEFINE VARIABLE iVar AS INTEGER NO-UNDO.
DEFINE VARIABLE i1 AS INTEGER NO-UNDO.
DEFINE VARIABLE i2 AS INTEGER NO-UNDO.

DO TRANSACTION ON STOP UNDO, LEAVE:
   iVar = 1.
   DO TRANSACTION ON STOP UNDO, LEAVE:
      DO i1 = 1 TO 10:
         i2 = i2 + i1.
      END.
   END.
   iVar = 2.
   STOP.
END.
MESSAGE iVar VIEW-AS ALERT-BOX INFO BUTTONS OK.
QUIT.
```

The preceding procedure generates the following log file output for transaction logging at level 2 (Basic):

```
BEGIN TRANS 702 [trantest.p @ 6]
END TRANS 702 [trantest.p @ 15]
```

And the following log file output for transaction logging at level 3 (Verbose):

```
BEGIN TRANS 702 [trantest.p @ 6]
BEGIN SUB-TRANS 703 [trantest.p @ 8]
UNDO SUB-TRANS 703 [trantest.p @ 14]
END TRANS 702 [trantest.p @ 15]
```

For more information about the processing of transactions and subtransactions, see the chapter on transactions in *OpenEdge Getting Started: ABL Essentials*. 
AIA logging

Specifying an AIA log entry type turns on logging for the AIA component. Following are the AIA log entry types and the information they provide based on logging level:

- **AiaMgmt** — Logs messages about regular AIA operations, such as AIA version information, instantiation, some other informational messages, and information on the AIA connection pool. Level 2 (Basic) logs instantiation and informational messages. Level 3 (Verbose) logs the connection pool information. Level 4 (Extended) logs the same information as level 3.

- **AiaProp** — Logs the properties set for the specific AIA instance. These properties are set in the `ubroker.properties` file. Information is logged at logging level 2 (Basic) and higher.

- **AiaRqst** — Logs information on the GET and POST commands sent by the client and the response back to the client. Information is logged at logging level 2 (Basic) and higher.

- **AiaUBroker** — Logs information on the communication between the AIA and the Unified broker (and AppServer or OpenEdge Adapter for SonicMQ BrokerConnect). Logging level 2 (Basic) provides most information. Level 3 (Verbose) also logs a binary dump of messages exchanged between the client and the broker/server process.

- **AiaDefault** — Combines AiaMgmt and AiaProp. This is the default entry type for the AIA component.

The following example shows entries for the AIA entry type with the logging level set to VERBOSE (3):

```
2 AIA AiaMgmt     AIA v100A (25-Apr-03)
2 AIA AiaProp     installDir                : d:/dlc100a
2 AIA AiaProp     properties file           : d:/dlc100a/properties/ubroker.properties
2 AIA AiaProp     instanceName              : Aia1
2 AIA AiaProp     logfilename               : d:\progress\wrk100a\Aia1.aia.log
2 AIA AiaMgmt     instanceName: Aia1
2 AIA AiaMgmt     InstallDir: d:/dlc100a
2 AIA AiaMgmt     propertyFileName: d:/dlc100a/properties/ubroker.properties
2 AIA AiaMgmt     AIA_HTTPS is licensed in this configuration.
2 AIA AiaRqst     Start: doGet()
2 AIA AiaRqst     Requested URL: http://pcspot/aia/Aia
2 AIA AiaRqst     Request information:
2 AIA AiaRqst     Request method : HEAD
3 AIA AiaUBroker  readMsg()                 
3 AIA AiaUBroker  mark() : markpos=0
3 AIA AiaUBroker  readubhdr                
3 AIA AiaUBroker  appUserId=                
3 AIA AiaUBroker  arbString=               
3 AIA AiaUBroker  appService= asbroker1
2 AIA AiaUBroker  processConnect() url=http://localhost:5162/asbroker1
3 AIA AiaUBroker  [SC-000001] nameserverLookup() : brokerhost= 172.16.108.180
brokerport= 3090
3 AIA AiaUBroker  [SC-000001] wrote UBRQ_CONNECT to (172.16.108.180:3090)
```
AppServer logging

Specifying an AppServer log entry type turns on logging for the AppServer.

The **ASPlumbing** log entry type provides information at the following logging levels:

- **Level 2 (Basic)** — Logs messages when an AppServer agent starts and stops, and when client processes connect and disconnect from the AppServer agent.

- **Level 3 (Verbose)** — Same as logging level 2, plus logging of the execution of the top level procedure (that is, the procedure that the client process asks the AppServer agent to execute on its behalf, but not any procedure the top level procedure executes).

- **Level 4 (Extended)** — Same as logging level 3, plus messages about server state, and status messages about read and write socket operations. Do not turn this on unless directed to do so by Progress Software Corporation technical support.

Log entries generated for this type contain the tag **AS**. An example of AppServer logging messages (with headers suppressed) is shown:

```
AS Starting application server for asbroker1. (5560)
AS Application Server Startup. (5473)
AS Shutdown request received. (5465)
AS Application Server Shutdown. (5476)
```

The **ASDefault** log entry type combines the **ASPlumbing** and **DB.Connects** log entry types. It is the default value for AppServer agents.

For more information on AppServer logging, see *OpenEdge Application Server: Administration*. 
Database connection logging

Specifying the database connection (DB.Connects) log entry type turns on logging of database connections (connects and disconnects). The messages include database name and user ID number. Information is logged at logging level 2 (Basic) and higher.

Log entries generated for this type contain the tag CONN. An example of database connection logging messages (with headers suppressed) is shown:

| CONN Connected to database sports, single user. (9542) |
| CONN Disconnecting from database sports, single user. (9544) |

The default for AppServer is ASPlumbing and DB.Connects. Generally, these log entry types are together in an AppServer log. For example:

| AS Starting application server for asbroker1. (5560) |
| AS Application Server Startup. (5473) |
| CONN Connected to database sports, single user. (9542) |
| AS Shutdown request received. (5465) |
| AS Application Server Shutdown. (5476) |
| CONN Disconnecting from database sports, single user. (9544) |
DataServer logging

Specifying a DataServer log entry type turns on logging for the DataServer client context.

The DS.QryInfo log entry type provides information at the following logging level:

- **Level 2 (Basic)** — Logs basic information about client generation of SQL query generation. Information about find mode, field list declarations, selected index, BY clauses, file type, join level and lock mode are logged.

**Note:** NOTE: This client entry type is closely associated with a server context entry type known as “SQL”. See *OpenEdge Data Management: DataServer for Microsoft SQL Server* for more details on log entry types for the server context.

The DS.Cursor log entry type logs client side cursor details at the following logging level.

- **Level 2 (Basic)** — Logs messages pertaining to cursor details such as table-number and cursor id. Cursor id is also tracked to the server so it can be tracked in the server context.

**Note:** NOTE: This client entry type is closely associated with a server context entry type known as “Cursor”. See the DataServer for MS SQL Server Guide for more details on log entry types for the server context.

The 4GLTrans log entry type is not specific to DataServers but its output may be mildly useful as a supplement in combination with the output of a server context entry type known as TRANS.

The 4GLTrans log entry type provides information specific to DataServers at the following logging level:

- **Level 4 (Extended)** — Logs client lock mode, transaction isolation level and other transaction-related information as pertains to DataServers. It lists when records are re-tested for server modification, when foreign connect environments are cleared, when locks are released and when transactions are aborted.

For more information on DataServer logging, *OpenEdge Data Management: DataServer for Microsoft SQL Server*. 
Dynamic object logging

Specifying a dynamic object log entry type turns on logging of dynamic object creation and deletion. Table 6–2 lists the dynamic object log entry types and their associated objects.

### Table 6–2: Dynamic objects that are logged

<table>
<thead>
<tr>
<th>Log entry type</th>
<th>Type of objects logged</th>
<th>Objects logged</th>
</tr>
</thead>
<tbody>
<tr>
<td>DynObjects.Class</td>
<td>Classes</td>
<td>Logs the creation and deletion of classes for:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Progress.Lang.Object</td>
</tr>
<tr>
<td>DynObjects.DB</td>
<td>Database-related objects</td>
<td>• BUFFER</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DATASET</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DATA-SOURCE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• QUERY</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• TEMP-TABLE</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
<td>For BUFFERs, QUERYs, and TEMP-TABLEs, does not include handles for static objects. For BUFFER objects, the log file includes the table name associated with the buffer.</td>
</tr>
<tr>
<td>DynObjects.Other</td>
<td>Objects that do not fall into the other groups</td>
<td>• ASYNC-REQUEST</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• CALL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• CONTROL-FRAME</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• MEMPTR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PROCEDURE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SERVER</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SERVER-SOCKET</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SOCKET</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
<td>For ASYNC-REQUEST, the log entry includes the procedure name in the RUN statement. For MEMPTR variables, logs an entry each time memory is allocated or freed. The log entry includes the allocation size (in bytes), and the handle ID always is 0. For PROCEDURES, does not includes handles for non-persistent procedures (for example, THIS–PROCEDURE). The log entry includes the name of the persistent procedure.</td>
</tr>
</tbody>
</table>
Table 6–2: Dynamic objects that are logged

<table>
<thead>
<tr>
<th>Log entry type</th>
<th>Type of objects logged</th>
<th>Objects logged</th>
</tr>
</thead>
<tbody>
<tr>
<td>DynObjects.UI</td>
<td>User-interface-related objects</td>
<td>• COMBO-BOX  &lt;br&gt; • BROWSE  &lt;br&gt; • BROWSE-COLUMN  &lt;br&gt; • BUTTON  &lt;br&gt; • EDITOR  &lt;br&gt; • FILL-IN  &lt;br&gt; • FRAME  &lt;br&gt; • IMAGE  &lt;br&gt; • MENU  &lt;br&gt; • MENU-ITEM  &lt;br&gt; • RADIO-SET  &lt;br&gt; • RECTANGLE  &lt;br&gt; • SELECTION-LIST  &lt;br&gt; • SLIDER  &lt;br&gt; • SUB-MENU  &lt;br&gt; • TEXT  &lt;br&gt; • TOGGLE-BOX  &lt;br&gt; • WINDOW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: For all objects, the log entry includes the object name, when available. For BROWSE-COLUMNs, the log entry does not include handles associated with static browse objects. If there is no value for the Name attribute (for calculated fields, for example), the log entry contains the Label attribute. Also, includes the BROWSE name, or the BROWSE handle, if there is no name.</td>
</tr>
<tr>
<td>DynObjects.XML</td>
<td>XML-related objects</td>
<td>• SAX-ATTRIBUTES  &lt;br&gt; • SAX-READER  &lt;br&gt; • SAX-WRITER  &lt;br&gt; • SOAP-HEADER  &lt;br&gt; • SOAP-HEADER-ENTRYREF  &lt;br&gt; • X-DOCUMENT  &lt;br&gt; • X-NODEREF</td>
</tr>
</tbody>
</table>
Logging dynamic object creation and deletion

To create log entries for dynamic object creation and deletion, use the Log Entry Types (-logentrytypes) startup parameter or, for AppServer and WebSpeed, the srvrLogEntryTypes property in the ubroker.properties file. Specify one or more of the four dynamic object log entry types in a comma-separated list, or specify DynObjects.* to get all four types. For example:

- -logentrytypes DynObjects.*
- -logentrytypes DynObjects.DB,DynObjects.Other

You can also turn on this logging at run time, by using the LOG-MANAGER system handle. For example, you can include the following line in the ABL code:

LOG-MANAGER:LOG-ENTRY-TYPES = "DynObjects.UI"

You can turn off this logging in the ABL application by resetting the attribute. For example:

LOG-MANAGER:LOG-ENTRY-TYPES = ?

Log entries generated for any of these types contain the tag DYNOBJECTS.

OpenEdge writes a log entry every time it creates or destroys a dynamic object tracked by this feature. This also includes allocation and deletion of space for MEMPTRs, if you specify DynObjects.Other or DynObjects.*.

Logging class creation and deletion

Log entries generated for this type contain the tag DYNOBJECTS. An example of Dynamic object logging messages for classes (with headers suppressed) is shown:

<table>
<thead>
<tr>
<th>DYNOBJECTS Created</th>
<th>Progress.Lang.Object</th>
<th>Handle:1093 (foo.p Line 18)</th>
</tr>
</thead>
<tbody>
<tr>
<td>tempclass</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DYNOBJECTS Delete Pending</td>
<td>Progress.Lang.Object</td>
<td>Handle:1094 (method1</td>
</tr>
<tr>
<td>tempclass Line 13</td>
<td>tempclass</td>
<td></td>
</tr>
<tr>
<td>DYNOBJECTS Deleted</td>
<td>Progress.Lang.Object</td>
<td>Handle:1093 (foo.p Line 20)</td>
</tr>
<tr>
<td>tempclass</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Deleted objects

There are cases where the application deletes an object with a DELETE OBJECT statement, but the AVM delays the deletion of the object. One example is an output TABLE-HANDLE parameter. If the ABL application deletes this object before returning, the AVM delays the deletion so it can transfer the output temp-table records back to the calling program when the program returns. If the AVM delays the object deletion, a log entry indicates that the deletion is pending. A log entry also indicates when the AVM deletes the object. This can happen with the following object types:

- BUFFER (associated with an output TABLE-HANDLE parameter)
- DATASET (for example, an OUTPUT DATASET-HANDLE parameter)
- PROCEDURE (for example, if a procedure contains DELETE THIS-PROCEDURE)
- TEMP-TABLE (for example, an OUTPUT TABLE-HANDLE parameter)

Objects created and deleted implicitly

The AVM creates and deletes some objects implicitly. This means the ABL application does not explicitly have a CREATE or DELETE OBJECT statement for the object. An example of implicit object creation is a SOCKET object, which the AVM creates when it receives a Connect event on a SERVER-SOCKET. In this case, the log entry contains the word IMPLICIT. The AVM creates the following object types implicitly:

- ASYNC-REQUEST
- BUFFER (that is, the default buffer of a dynamic query)
- SOAP-HEADER (which can also be created explicitly)
- SOAP-HEADER-ENTRYREF
- SOCKET
- TEMP-TABLE (an INPUT or OUTPUT TABLE-HANDLE parameter)
- X-DOCUMENT

An example of implicit object deletion is when the AVM destroys an object during the course of destroying its object pool. In this case, the log entry contains the word POOLDEL.
Logging levels for dynamic objects

There are two logging levels supported for Dyn объекты entry types: 2 (Basic) and 3 (Verbose). Setting logging to 4 (Extended), logs information as for 3 (Verbose).

Basic logging level (2)

The log entries for logging level 2 (Basic) include the following information, and any level above 1 (Errors) logs this information:

- **Action** — For objects, this is Created, Deleted, or Delete Pending. For MEMPTRs, this is Allocated or Deallocated.
- **Object type** — For example, BUFFER, SERVER, or BUTTON.
- **Handle value** — Handle: followed by the INTEGER value of the handle (0 for MEMPTRs).
- **Routine name** — The name of the .p or .w file or method where this application created or destroyed the object.
- **Line number** — The line number in the .p or .w file or method where the application created or destroyed the object. This line number comes from the debugger listing file. When the AVM creates a SOCKET object implicitly, the line number always is 0.

For other implicitly created objects, the line number is meaningful. For example, for an ASYNC-REQUEST handle, it is the line number of the RUN statement.

- **IMPLICIT** — Appears when the AVM created the object implicitly.
- **POOLDEL** — Appears when the AVM deleted the object because it was deleting the object’s object pool.
- **Other** — For specific object types, the log output line includes other attributes, including:
  - **Name** — Followed by the object name. For BUFFER objects, the Name attribute is the name of the table associated with the buffer, so the entry contains Table: followed by the table name.
    
    TEMP-TABLE objects do not show the Name attribute. This information is not available when the application creates the TEMP-TABLE object, but only after it invokes the TEMP-TABLE-PREPARE method.
  - The allocation’s size, for MEMPTRs.
  - The procedure name for PROCEDURE objects.
  - The name of the procedure associated with an ASYNC-REQUEST-HANDLE object (that is, the procedure that ran asynchronously).
  - The Label attribute for BROWSE-COLUMN objects, if there is no Name attribute (for example, for calculated fields). Also, to identify the browse parenting the column, the log entry includes the BROWSE name or BROWSE handle ID.
Here are sample BASIC log entries (with headers suppressed):

```
[05/10/31@14:07:15.892-0400] P-002702 T-002867 2 4GL DYNOBJECTS
Created  MENU  Handle:1098 (x.p Line 4)
[05/10/31@14:07:15.892-0400] P-002702 T-002867 2 4GL DYNOBJECTS
Deleted  MENU  Handle:1098 (x.p Line 5)
```

<table>
<thead>
<tr>
<th>Created</th>
<th>BROWSE</th>
<th>Handle:1139 (y.p Line 29)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>BROWSE</td>
<td>Handle:1139 (y.p Line 29)</td>
</tr>
<tr>
<td>Created</td>
<td>BROWSE-COLUMN</td>
<td>Handle:1143 (y.p Line 63) Name: Cust-Num</td>
</tr>
<tr>
<td></td>
<td>[Browse Handle:1139]</td>
<td></td>
</tr>
<tr>
<td>Created</td>
<td>BUFFER</td>
<td>Handle:1144 (y.p Line 70) IMPLICIT Table:item</td>
</tr>
<tr>
<td>Deleted</td>
<td>MENU</td>
<td>Handle:1098 (x.p Line 5) POOLDEL</td>
</tr>
</tbody>
</table>

**Verbose logging level (3)**

Setting the logging level to 3 (Verbose), also logs object-pool related information.

First, level 3 adds pool information to the log entry every time a dynamic object is created that is being tracked, except PROCEDURE, MEMPTR, and BROWSE-COLUMN objects. PROCEDUREs are always in the Session pool. MEMPTR and LONGCHAR memory is not stored in a pool. The log entry for BROWSE-COLUMN objects contains the browse name or handle ID information in the creation log entry (as described above), so you can refer back to the browse creation entry to find out which pool contains the object.

Second, level 3 logs an extra entry every time an object-pool is created or deleted. This helps identify when the AVM deletes an object in the course of deleting an object pool, as opposed to when the application deletes the object explicitly.

There are two formats for the messages generated at level VERBOSE, depending on the action:

- **Format 1** — OpenEdge logs the following when creating or deleting an object pool:
  - **Action** — This is Creating Pool or Deleting Pool.
  - **Pool name** — This is <unnamed>, <Session Pool>, or the name of a named pool.
  - **PERS** — This indicates the pool is persistent. OpenEdge does not log this for Deleting Pool actions.
  - **Routine name and line number** — The routine name is the name of the .p or .w file or method where the AVM created or destroyed the pool. The line number comes from the debugger listing file.

  **Note:** The line number can be the string IMPLICIT for an unnamed widget pool if the pool is created implicitly during the instantiation of a user-defined object.

  - **FROM routine-name** — routine-name is the name of the .p or .w file or method where the AVM created the object pool. OpenEdge logs this only for the Delete pool.
Here are sample log entries (with the headers suppressed):

- **Format 2** — OpenEdge adds pool information to the Basic log entries when creating and deleting dynamic objects. OpenEdge logs this additional information:

  - **Pool name** — This is `<unnamed>`, `<Session Pool>`, or the name of a named pool.
  
  - **FROM routinename** — `routinename` is the name of the `.p` or `.w` file or method that created the object pool. OpenEdge logs this only when the pool is not persistent and not the Session Pool.

Here are some sample log entries (with headers suppressed):

<table>
<thead>
<tr>
<th>Time</th>
<th>Code</th>
<th>Message Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[05/10/31@14:15:20.892-0400]</td>
<td>P-002702</td>
<td>T-002867 3 4GL DYNOBJECTS Created MENU Handle:1098 (x.p Line 4) Pool:&lt;unnamed&gt; FROM x.p</td>
</tr>
<tr>
<td>[05/10/31@14:15:20.892-0400]</td>
<td>P-002702</td>
<td>T-002867 3 4GL DYNOBJECTS Created MENU Handle:1098 (x.p Line 4) Pool:&lt;unnamed&gt; FROM z.p</td>
</tr>
<tr>
<td>[05/10/31@14:15:20.892-0400]</td>
<td>P-002702</td>
<td>T-002867 3 4GL DYNOBJECTS Deleted MENU Handle:1098 (x.p Line 5) Pool:mypool FROM x.p</td>
</tr>
<tr>
<td>[05/10/31@14:15:20.892-0400]</td>
<td>P-002702</td>
<td>T-002867 3 4GL DYNOBJECTS Deleted MENU Handle:1098 (x.p Line 5) Pool:myperswp FROM y.p</td>
</tr>
</tbody>
</table>

The following excerpt is from a log file (with headers suppressed) showing an example of how the pool information relates to the other messages:

<table>
<thead>
<tr>
<th>Time</th>
<th>Code</th>
<th>Message Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating pool mypool (x.p Line 2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Created MENU Handle:1098 (x.p Line 4) Pool:mypool FROM x.p</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deleted MENU Handle:1098 (x.p Line 5)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Created TOGGLE-BOX Handle:1099 (x.p Line 7) Pool:mypool FROM x.p</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deleting pool mypool (x.p Line 9) FROM x.p</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deleted TOGGLE-BOX Handle:1099 (x.p Line 9) POOLDEL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Event logging

Problems involving event processing present real challenges to ABL developers trying to troubleshoot their code. Event logging takes advantage of the OpenEdge logging infrastructure to track which events occur and the order in which they occur as an ABL program executes. Support personnel can benefit from event logging as they troubleshoot customer code to resolve problems.

Event generation

An event occurs when the AVM receives notification of an action. An action can be user-driven, such as a mouse click, or some other external event, such as the completion of an AppServer procedure. The AVM also creates events as a result of an APPLY statement, and in response to an external event; for example, pressing the TAB key causes LEAVE and ENTRY events to be created.

Event stack

An external event can result in more than one internal event. For example, clicking the mouse in a fill-in might shift the focus from another field, causing ENTRY and LEAVE events, respectively. Since the ordering of events is significant, the AVM builds a stack based on events as they occur, starting with the first event at the bottom of the stack. Each succeeding event is added to the stack.

The stack is a LIFO (Last In First Out) stack, which means the AVM pushes events onto the stack in the reverse order of their firing. In the focus example above, clicking in the fill-in causes the focus to shift, so the ENTRY event is first in the stack.

In some cases, a trigger on one event takes precedence over a trigger on another event. For example, when you press the mouse button to choose a button, the AVM generates both a $MOUSE-SELECT-CLICK event and a $CHOOSE event for the button (among other possible events). Since the $MOUSE-SELECT-CLICK trigger takes precedence over the $CHOOSE trigger for a button, the AVM recognizes that the $CHOOSE trigger should not fire and does not push it onto the stack.

Sometimes the AVM has to insert an event elsewhere in the stack than at the top. For example, when you click the mouse to choose a button, the AVM pushes the $MOUSE-SELECT-DOWN and ENTRY events that are the first to occur, onto the stack. When you release the mouse button, a $CHOOSE event occurs, but if the AVM pushes the $CHOOSE event onto the top of the stack, a $CHOOSE trigger on the button will fire before an ENTRY trigger. Since an ENTRY trigger always must fire before a $CHOOSE trigger, the AVM inserts the $CHOOSE event below the ENTRY event so the $CHOOSE trigger will fire after the ENTRY trigger.

Once it adds the events for an external action to the stack, the AVM starts to remove events. Since the stack is built in reverse order, the last event pushed onto the stack is the first to be removed. As it removes each event, the AVM checks for triggers and runs the ABL code for each event trigger it finds.
Logged events

ABL event logging logs the following categories of events:

- **User interface events** — Limited to ABL-owned windows; these events include keyboard activity of both printable and nonprintable keystrokes.

- **ABL-generated events** — For example, ENTRY, LEAVE, and ROW-LEAVE. This also includes Developer Events (U1 through U10). For a complete list of ABL events, see the Events Reference chapter in *OpenEdge Development: ABL Reference*.

- **ASYNC events**

- **Sockets events**

- **COM events**

Table 6–3 lists the Windows GUI events that OpenEdge logs. Note, however, that not all GUI events are logged. For example, OpenEdge ignores mouse movements on the basis that they are too numerous and not significant.

**Table 6–3: Windows GUI events that are logged**

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Event Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>WM_WINDOWPOSCHANGING</td>
<td>WM_ACTIVATE</td>
</tr>
<tr>
<td>WM_DESTROY</td>
<td>WM_CLOSE</td>
</tr>
<tr>
<td>WM_SETFOCUS</td>
<td>WM_ENABLE</td>
</tr>
<tr>
<td>WM_KILLFOCUS</td>
<td>WM_LBUTTONDOWN</td>
</tr>
<tr>
<td>WM_DROPFILES</td>
<td>WM_LBUTTONDOWN</td>
</tr>
<tr>
<td>WM_CHAR</td>
<td>WM_LBUTTONDOWN</td>
</tr>
<tr>
<td>WM_KEYDOWN</td>
<td>WM_RBUTTONDOWN</td>
</tr>
<tr>
<td>WM_SYSKEYDOWN</td>
<td>WM_RBUTTONDOWN</td>
</tr>
<tr>
<td>WM_SYSCHAR</td>
<td>WM_SYSCOMMAND</td>
</tr>
<tr>
<td>WM_MENUCHAR</td>
<td>WM_INITMENUPOPUP</td>
</tr>
</tbody>
</table>
Logged information

Event logging records information about the following types of actions as they apply to an event:

- **Event occurs** — Either the client receives notification of an external event or the AVM executes an APPLY statement.

- **Indirect action taken** — The client takes additional action in response to the event. For example, on a Windows minimize event, the client might minimize several other related windows.

- **ABL event pushed onto stack** — The internal events that result from external events, such as LEAVE and ENTRY, are pushed onto the stack, from where they will be executed in sequence.

- **Event popped from stack without executing** — In certain cases, the AVM does not execute events on the stack. For example:
  - An event occurs to an object that is disabled. the AVM pushes the event onto the stack, and then pops it off the stack without executing the corresponding trigger, if one exists.
  - Other examples: a trigger executes a RETURN NO-APPLY statement; a COM event occurs during a database or socket operation; a field’s validation fails.

- **Trigger started** — Begins execution of the user interface trigger associated with the event.

- **Event applied by APPLY statement** — OpenEdge logs each execution of an APPLY statement by an ABL program. Frequently, an application calls an APPLY statement from within a user-defined trigger.

- **Trigger finished** — Ends execution of the user interface trigger associated with the event.

- **Event popped off stack** — Concludes a specific event execution.

The order of actions presented here is typical of what might appear in a log. Note, however, that not all actions occur for every event. An external event starts all of the actions that occur in an event-driven program, except for initialization. Thus, you would always expect to find the following in the log:

- A GUI, socket, Async, or COM event first

- One or more ABL events and their associated triggers or event procedures

- The conclusion of the external event
Table 6–4 lists the information that is logged for each of the described actions. Note that the term *object* refers to the object to which the event applies.

<table>
<thead>
<tr>
<th>Action</th>
<th>Information logged</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event occurs</td>
<td><strong>Event Type</strong> — GUI (GUI Windows), UI (character mode), PRGS, COM, ASYNC, or SOCKET.</td>
</tr>
<tr>
<td></td>
<td><strong>Event Name</strong> — (For example) WM_xxx, OCX event name, LEAVE, TAB.</td>
</tr>
<tr>
<td></td>
<td><strong>Widget information</strong> — Type (BUTTON, for example), name, and handle ID of the object, when available.</td>
</tr>
<tr>
<td></td>
<td><strong>Flag</strong> — Can be set to TRUE or FALSE for COM events (for use by Progress Software Corporation Technical Support).</td>
</tr>
<tr>
<td></td>
<td><strong>OpenEdge Handled</strong> — The string Progress Handled appears only for COM object WM_ events. Logging this string means that the AVM captured the event and will process it, as opposed to passing it to the ActiveX control.</td>
</tr>
<tr>
<td>Indirect action</td>
<td><strong>Description</strong> — A descriptive string. When processing an event, the AVM might perform additional tasks that will also be recorded. These extra tasks include: minimize, restore, and close related windows.</td>
</tr>
<tr>
<td>ABL event pushed onto stack</td>
<td><strong>Event Name</strong> — (For example) LEAVE, ENTRY.</td>
</tr>
<tr>
<td></td>
<td><strong>Widget information</strong> — Type (BUTTON, for example), name, and handle ID of the object, when available.</td>
</tr>
<tr>
<td></td>
<td><strong>Procedure Name</strong> — Name of the procedure that created the object.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: OpenEdge makes no entry for COM events sent by an ActiveX control.</td>
</tr>
<tr>
<td>Event popped off stack without executing</td>
<td><strong>Event Name</strong> — (For example) LEAVE.</td>
</tr>
<tr>
<td></td>
<td><strong>Event Discarded</strong> — Noted as “discarded.” Additional information provided, if the reason for the action is known (for example, “disabled”).</td>
</tr>
<tr>
<td></td>
<td><strong>Widget information</strong> — Type (BUTTON, for example), name, and handle ID of the object, when available.</td>
</tr>
<tr>
<td>Trigger started</td>
<td><strong>Handler</strong> — Event name and object name (similar to the ON statement), or name of the internal procedure.</td>
</tr>
<tr>
<td>Event applied by APPLY statement</td>
<td><strong>Event Name</strong> — (For example) ENTRY.</td>
</tr>
<tr>
<td></td>
<td><strong>Widget information</strong> — Type (BUTTON, for example), name, and handle ID of the object, when available.</td>
</tr>
<tr>
<td></td>
<td><strong>Routine and line number</strong> — Name and line number of the routine (.p or .w file or method) and internal procedure, if appropriate, where the APPLY statement is. The line number is based on the Debugger listing file.</td>
</tr>
</tbody>
</table>
### Table 6–4: Information logged for each type of action

<table>
<thead>
<tr>
<th>Action</th>
<th>Information logged</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger finished</td>
<td><strong>Handler</strong> — Event name and object name (similar to the <code>ON</code> statement), or name of the internal procedure.</td>
</tr>
<tr>
<td>Event popped off stack</td>
<td><strong>Event Name</strong> — (For example) <code>LEAVE</code>, <code>ENTRY</code>.  &lt;br&gt; <strong>Widget information</strong> — Type (<code>BUTTON</code>, for example), name, and handle ID of the object, when available.  &lt;br&gt; <strong>Routine Name</strong> — Name of the routine (<code>.p</code> or <code>.w</code> file or method) that created the object. <strong>Note:</strong> OpenEdge makes no entry for COM events sent by the control.</td>
</tr>
</tbody>
</table>
Event log entry types and logging levels

You enable event logging with any of three log entry types. Using three different entry types gives you greater control over what and when information is logged. Table 6–5 lists the events that are logged and the logging levels supported for each entry type.

Table 6–5: Events logged by log entry type

<table>
<thead>
<tr>
<th>Log entry type</th>
<th>Information logged</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProEvents.UI.Char</td>
<td>Turns on logging of keystroke events for printable characters. Logged at level 2 (Basic) and higher.</td>
</tr>
<tr>
<td>ProEvents.UI.Command</td>
<td>Turns on logging of keystroke events for nonprintable characters:</td>
</tr>
<tr>
<td></td>
<td>• TAB</td>
</tr>
<tr>
<td></td>
<td>• FN keys</td>
</tr>
<tr>
<td></td>
<td>• CTRL, SHIFT, ALT and their combinations</td>
</tr>
<tr>
<td></td>
<td>• PAGE DOWN, PAGE UP, HOME, END</td>
</tr>
<tr>
<td></td>
<td>And Windows GUI events (WM events). Level 2 (Basic) logs nonprintable keystrokes and this subset of WM GUI events:</td>
</tr>
<tr>
<td></td>
<td>• WM_SETFOCUS</td>
</tr>
<tr>
<td></td>
<td>• WM_KILLFOCUS</td>
</tr>
<tr>
<td></td>
<td>• WM_CLOSE</td>
</tr>
<tr>
<td></td>
<td>• WM_ENABLE</td>
</tr>
<tr>
<td></td>
<td>• WM_LBUTTONDOWN</td>
</tr>
<tr>
<td></td>
<td>• WM_RBUTTONDOWN</td>
</tr>
<tr>
<td></td>
<td>• Developer Events U1–U10</td>
</tr>
<tr>
<td></td>
<td>Level 3 (Verbose) logs nonprintable keystrokes and all WM GUI events.</td>
</tr>
<tr>
<td>ProEvents.Other</td>
<td>Turns on logging of COM, Async, and Socket events. Logged at level 2 (Basic) and higher.</td>
</tr>
<tr>
<td></td>
<td>OpenEdge logs no PUSH and POP entries for COM events. At levels 2 and 3, OpenEdge logs COM events only when the application defines a trigger for the event, on the assumption that you are interested only in events for which you have written a trigger. At level 4 (Extended), OpenEdge logs all COM events.</td>
</tr>
</tbody>
</table>
Starting event logging

To create log entries for events, use the Log Entry Types (-logentrytypes) startup parameter or, for the AppServer and WebSpeed, the srvrLogEntryTypes property in the ubroker.properties file. Specify one or more of the three event log entry types in a comma-separated list, or use the * wild-card character to get combinations. For example:

<table>
<thead>
<tr>
<th>-logentrytypes</th>
<th>ProEvents.UI.*</th>
</tr>
</thead>
<tbody>
<tr>
<td>-logentrytypes</td>
<td>ProEvents.UI.Command,ProEvents.Other</td>
</tr>
</tbody>
</table>

You can also turn on this logging at run time, by using the LOG-MANAGER system handle. For example, you can include the following line in the ABL code:

```
LOG-MANAGER:LOG-ENTRY-TYPES = "ProEvents.UI.Command"
```

You can turn off this logging in the ABL application by resetting the attribute. For example:

```
LOG-MANAGER:LOG-ENTRY-TYPES = ?
```

Log entries generated for any of these types contain the tag ProEvents.

Event message formats

Event logging message formats correlate closely with event actions. There are six distinct formats.

**Format 1: event occurs**

When an event occurs, logged messages contain the following information:

- **Start** — START
- **Identifier** — Event type GUI (GUI Windows), UI (character mode), PRGS, COM, ASYNC, or SOCKET
- **Event name** — For example, LEAVE or GUI \_WM\_command. For WM\_CHAR, also contains the key pressed
- **Widget information** — Type (BUTTON, for example), name, and handle ID of the object, when available
- **Flag** — T or F (COM events only). For use by Progress Software Corporation Technical Support
- **OpenEdge Handled** — The string Progress Handled appears only for COM object WM\_events
Here are some sample Format 1 log entries:

```
[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS START PRGS
  LEAVE BUTTON Handle:1989
```

```
[05/10/31@12:02:43.570-0400] P-005783 T-005735 2 4GL PROEVENTS START COM
  WM_KEYDOWN Handle:1114
```

```
[05/10/31@12:02:43.585-0400] P-005783 T-005735 2 4GL PROEVENTS START COM
  CtrlFrame.CSSpin.KeyDown CONTROL-FRAME Handle:1114 myocx.w T
```

```
[05/10/31@12:02:43.570-0400] P-005783 T-005735 2 4GL PROEVENTS START COM
  WM_DESTROY FILL-IN customer-name Handle:1126
```

```
[05/10/31@12:02:43.570-0400] P-005783 T-005735 2 4GL PROEVENTS START COM
  WM_CHAR d Handle:1114
```

```
[05/10/31@12:02:43.570-0400] P-005783 T-005735 2 4GL PROEVENTS START COM
  WM_CHAR TAB Handle:1114
```

```
[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS Action
  minimize related windows
```

```
[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS Action close
  related windows
```

```
[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS Action restore
  related windows
```

**Format 2: indirect action**

When there is an indirect action, logged messages contain the following information:

- **Identifier** — Action
- **Description** — A textual description of the indirect action taken

Here are some sample Format 2 log entries:

```
[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS Action
  minimize related windows
```

```
[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS Action close
  related windows
```

```
[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS Action restore
  related windows
```

**Format 3: pushed on to the stack/popped off the stack**

When an event is either pushed onto or popped off of the stack, logged messages contain the following information:

- **Identifier** — Push or Pop.
- **Event name** — For example, LEAVE. For a keystroke, the entry includes the key name and associated event, if appropriate.
- **Widget information** — Type (BUTTON, for example), name, and handle ID of the object, when available.
- **Procedure name** — Name of the procedure that created the object (not available in all cases).
Here are some sample Format 3 log entries:

<table>
<thead>
<tr>
<th>Timestamp</th>
<th>PID</th>
<th>TaskID</th>
<th>Priority</th>
<th>Event Type</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>[05/10/31@13:00:00.098-0400]</td>
<td>P-000001</td>
<td>T-000002</td>
<td>2</td>
<td>4GL PROEVENTS</td>
<td>PUSH ENTRY BUTTON button-1 Handle:1564 myproc.p</td>
</tr>
<tr>
<td>[05/10/31@13:00:00.098-0400]</td>
<td>P-000001</td>
<td>T-000002</td>
<td>2</td>
<td>4GL PROEVENTS</td>
<td>PUSH ENTRY BUTTON Handle:1987</td>
</tr>
<tr>
<td>[05/10/31@12:19:54.023-0400]</td>
<td>P-005805</td>
<td>T-005881</td>
<td>2</td>
<td>4GL PROEVENTS</td>
<td>PUSH CTRL-F FILL-IN X Handle:1000 test.p</td>
</tr>
<tr>
<td>[05/10/31@12:20:45.054-0400]</td>
<td>P-005805</td>
<td>T-005881</td>
<td>2</td>
<td>4GL PROEVENTS</td>
<td>PUSH F6 (NEXT-FRAME) FILL-IN X test.p</td>
</tr>
<tr>
<td>[05/10/31@13:00:00.098-0400]</td>
<td>P-000001</td>
<td>T-000002</td>
<td>2</td>
<td>4GL PROEVENTS</td>
<td>POP ENTRY BUTTON Handle:1987</td>
</tr>
</tbody>
</table>

**Format 4: generated by the ABL APPLY statement**

When an APPLY statement executes, logged messages contain the following information:

- **Identifier** — APPLY.
- **Event name** — For example, LEAVE. For a keystroke, the entry includes the key name and associated event, if appropriate.
- **Widget information** — Type (BUTTON, for example), name, and handle ID of the object, when available.
- **Routine name and line number** — Name and line number of the routine (.p or .w file or method) and internal procedure, if appropriate, where the APPLY statement is. The line number is based on the Debugger listing file.

Here are some sample Format 4 log entries:

<table>
<thead>
<tr>
<th>Timestamp</th>
<th>PID</th>
<th>TaskID</th>
<th>Priority</th>
<th>Event Type</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>[05/10/31@13:00:00.098-0400]</td>
<td>P-000001</td>
<td>T-000002</td>
<td>2</td>
<td>4GL PROEVENTS</td>
<td>APPLY ENTRY BUTTON button-1 myproc myp.p Line 10</td>
</tr>
<tr>
<td>[05/10/31@13:00:00.098-0400]</td>
<td>P-000001</td>
<td>T-000002</td>
<td>2</td>
<td>4GL PROEVENTS</td>
<td>APPLY ENTRY BUTTON Handle:1987 myproc myp.p Line 10</td>
</tr>
</tbody>
</table>
Format 5: trigger execution

When a trigger executes, logged messages contain the following information:

- **Identifier** — Begin-Trigger or End-Trigger.
- **Additional information** — Can include: the event name, for example, LEAVE; object type and name, and handle ID (when available), or internal procedure name for persistent triggers; the word ANYWHERE, if it is an ANYWHERE trigger. For objects that are no longer valid, the entry also includes the words object not valid, as in the case when the window following it has been destroyed.
- **Procedure name** — Name of the routine (.p or .w file or method) and internal procedure, if appropriate, where the trigger is.

Here are some sample Format 5 log entries:

```
[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS Begin-Trigger
"LEAVE OF button button-1" Handle:1234 myprog.p

[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS End-Trigger
"LEAVE OF button button-1" Handle:1245

[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS Begin-Trigger
"LEAVE OF button" RUN myinternalproc Handle:1256 myproc.p

[05/10/31@13:00:00.098-0400] P-000001 T-000002 2 4GL PROEVENTS Begin-Trigger
"F2 OF FILL-IN" ANYWHERE Handle:1278 myproc.p
```

Format 6: event discarded

When an event is discarded, logged messages contain the following information:

- **Identifier** — PRGS
- **Event name** — For example, ENTRY
- **Additional information** — In most cases, the word discarded, followed by the reason for not processing the event, if known; for example, widget disabled
- **Widget information** — Type (BUTTON, for example), name, and handle ID of the object, when available
Here are some sample Format 6 log entries:

<table>
<thead>
<tr>
<th>Log Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[05/10/31@00:00:00-0400] P-000001 T-000002 2 4GL PROEVENTS PRGS ENTRY BUTTON b1 Handle:1234 discarded widget disabled</td>
<td></td>
</tr>
<tr>
<td>[05/10/31@00:00:00-0400] P-000001 T-000002 2 4GL PROEVENTS PRGS ENTRY BUTTON Handle:1987 discarded widget disabled</td>
<td></td>
</tr>
<tr>
<td>[05/10/31@00:00:32-0400] P-005747 T-005914 2 4GL PROEVENTS PRGS ESC (END-ERROR) FILL-IN FILL-IN-1 Handle:1568 discarded</td>
<td></td>
</tr>
<tr>
<td>[05/10/31@00:00:32-0400] P-005747 T-005914 2 4GL PROEVENTS PRGS LEAVE FILL-IN FILL-IN-1 Handle:1598 discarded return no-apply</td>
<td></td>
</tr>
<tr>
<td>[05/10/31@00:00:32-0400] P-005747 T-005914 2 4GL PROEVENTS PRGS ESC FILL-IN FILL-IN-1 (END-ERROR) Handle:1599 field validation failed</td>
<td></td>
</tr>
</tbody>
</table>

**Sample Event logs**

The sample event logs that follow assume a logging level of 2 and a log entry type of ProEvents.*.

The next sample event log involves a RETURN NO-APPLY statement. It is based on the following scenario:

- There is a window with a fill-in and a button.
- The fill-in has the focus when the user clicks the button.
- The fill-in’s LEAVE trigger executes a RETURN NO-APPLY.
- The AVM discards both the LEAVE and ENTRY events.

Here is the sample log file (with header suppressed):

```
START GUI WM_LBUTTONDOWN BUTTON BUTTON-1 myprog.p
START GUI WM_KILLFOCUS FILL-IN FILL-IN-1 myprog.p
START GUI WM_SETFOCUS BUTTON BUTTON-1 myprog.p
START GUI WM_LBUTTONUP BUTTON BUTTON-1 myprog.p
PUSH FOCUS-IN BUTTON BUTTON-1 myprog.p
PUSH ENTRY BUTTON BUTTON-1 myprog.p
PUSH LEAVE FILL-IN FILL-IN-1 myprog.p
Begin-Trigger "LEAVE OF FILL-IN FILL-IN-1" myprog.p
End-Trigger "LEAVE OF FILL-IN FILL-IN-1"
PRGS LEAVE FILL-IN FILL-IN-1 return no-apply
POP LEAVE FILL-IN FILL-IN-1 myprog.p
START GUI WM_KILLFOCUS BUTTON BUTTON-1 myprog.p
START GUI WM_SETFOCUS FILL-IN FILL-IN-1 myprog.p
PRGS ENTRY BUTTON BUTTON-1 discarded
POP ENTRY BUTTON BUTTON-1 myprog.p
PRGS FOCUS-IN BUTTON BUTTON-1 discarded
POP FOCUS-IN BUTTON BUTTON-1 myprog.p
```
The next sample Event log shows a common event cycle. It is based on the following scenario:

- There is a window with a toggle box, a fill-in, and a button.
- The toggle box has the focus when the user clicks the button.
- The button’s CHOOSE trigger runs the APPLY statement that applies an event to the fill-in.

Here is the sample log file (with header suppressed):

```
START GUI WM_LBUTTONDOWN BUTTON BUTTON-1 win1.p
START GUI WM_KILLFOCUS FILL-IN FILL-IN-1 win1.p
START GUI WM_SETFOCUS BUTTON BUTTON-1 win1.p
START GUI WM_LBUTTONUP BUTTON BUTTON-1 win1.p
PUSH FOCUS-IN BUTTON BUTTON-1 win1.p
PUSH FOCUS-IN BUTTON BUTTON-1 win1.p
PUSH ENTRY BUTTON BUTTON-1 win1.p
PUSH LEAVE FILL-IN FILL-IN-1 win1.p
Begin-Trigger "LEAVE OF FILL-IN FILL-IN-1" win1.p
End-Trigger "LEAVE OF FILL-IN FILL-IN-1"
POP LEAVE FILL-IN FILL-IN-1 win1.p
Begin-Trigger "ENTRY OF BUTTON BUTTON-1" win1.p
START GUI WM_ENABLE WINDOW Handle:1129 win1.p
START GUI WM_ENABLE WINDOW Handle:1029
START GUI WM_KILLFOCUS BUTTON BUTTON-1 win1.p
START GUI WM_SETFOCUS WINDOW Handle:1129 win1.p
START GUI WM_ENABLE WINDOW Handle:1129 win1.p
START GUI WM_ENABLE WINDOW Handle:1029
START GUI WM_KILLFOCUS WINDOW Handle:1129 win1.p
START GUI WM_SETFOCUS BUTTON BUTTON-1 win1.p
End-Trigger "ENTRY OF BUTTON BUTTON-1"
POP ENTRY BUTTON BUTTON-1 win1.p
POP FOCUS-IN BUTTON BUTTON-1 win1.p
POP FOCUS-IN BUTTON BUTTON-1 win1.p
PUSH CHOOSE BUTTON BUTTON-1 win1.p
Begin-Trigger "CHOOSE OF BUTTON BUTTON-1" win1.p
APPLY ENTRY FILL-IN FILL-IN-1 USER-INTERFACE-TRIGGER win1.p Line 194
PUSH APPLY_ENTRY FILL-IN FILL-IN-1 win1.p
PUSH APPLY_ENTRY FILL-IN FILL-IN-1 win1.p
PUSH ENTRY FILL-IN FILL-IN-1 win1.p
PUSH LEAVE BUTTON BUTTON-1 win1.p
POP LEAVE BUTTON BUTTON-1 win1.p
START GUI WM_KILLFOCUS BUTTON BUTTON-1 win1.p
START GUI WM_SETFOCUS BUTTON BUTTON-1 win1.p
PUSH APPLY_ENTRY FILL-IN FILL-IN-1 win1.p
PUSH APPLY_ENTRY FILL-IN FILL-IN-1 win1.p
End-Trigger "CHOOSE OF BUTTON BUTTON-1"
POP CHOOSE BUTTON BUTTON-1 win1.p
```

As you can see by examining these samples, there are bursts of logging activity during short spans of user interaction. Thus, it is most efficient to turn on logging at run time, using the LOG-MANAGER system handle attributes, perform the interaction you want to trace, and then turn off logging. For more information, see *OpenEdge Development: ABL Reference*. 
File access logging

Specifying the file access (FileID) log entry type turns on logging of file access operations (opening and closing files) and file access error messages that do not include the filename. Information is logged at logging level 2 (Basic) and higher.

Some file access error messages do not include the filename in the message; they show only the file ID, which can make it difficult to diagnose the problem. When you turn on file access logging and such an error occurs, OpenEdge includes both the file’s name and ID in the log entry. File access logging is also useful in identifying file access errors or inefficiencies in your code (for example, you might be opening or closing a file unnecessarily, setting PROPATH or PATH incorrectly, or exceeding some file limit).

Log entries generated for this type contain the tag FILEID. An example of FileID logging messages (with headers suppressed) is shown:

```
FILEID Open d:\temp\program.r ID=30
FILEID Close d:\temp\program.r ID=30
FILEID Open d:\temp\srt01934 ID=31
FILEID Error 219 for file d:\temp\srt01934 ID=31
```

You can also turn on this logging at run time, by using the LOG-MANAGER system handle. For example, you can include the following line in the ABL code:

```
LOG-MANAGER:LOG-ENTRY-TYPES = "FileID"
```

You can turn off this logging in the ABL application by resetting the attribute. For example:

```
LOG-MANAGER:LOG-ENTRY-TYPES = ?
```
Ignored operation logging

Specifying the ignored operation (IgnoredOps) log entry type turns on logging of the names and code locations of all window attributes or methods that the AVM ignores on embedded ABL windows. This log entry type has only one logging level, 2 (Basic).

When you embed an ABL window in a .NET control container, many of the window attributes and methods have no function in the .NET environment. ABL ignores any access that you make to these attributes and methods, and this log entry type allows you to identify where you might be using these ignored window elements in your code.

Examples of ignored operations include setting the MAXIMUM-WIDTH attribute and executing the MOVE TO TOP method. For more information about operations that the AVM ignores when they occur in the context of an embedded window, see the EmbeddedWindow property reference entry in OpenEdge Development: ABL Reference.

For each ignored operation, OpenEdge logs the source file name, the line number, and the name of the attribute or method, as shown in the following example:

```
[08/03/2001 12:03.737-0400] P-006124 T-005700 2 4GL IGNOREDOPS (Procedure: 'KeepOnTop testwin.w' Line:646) Attribute/Method ALWAYS ON TOP ignored for embedded window
```

**Note:** It is not always possible for the AVM to distinguish between an attribute and a method. Therefore, the log entry specifies “Attribute/Method” as shown in the preceding example.

To create log entries for ignored operations, use the Log Entry Types (-logentrytypes) startup parameter:

```
-logentrytypes IgnoredOps
```

You can also turn on this logging at run time, by using the LOG-MANAGER system handle. For example, you can include the following line in the ABL code:

```
LOG-MANAGER:LOG-ENTRY-TYPES = "IgnoredOps"
```

You can turn off this logging in the ABL application by resetting the attribute. For example:

```
LOG-MANAGER:LOG-ENTRY-TYPES = ?
```
NameServer logging

Specifying the NameServer (NSPlumbing) log entry type turns on logging for the NameServer component. Information is logged at the following logging levels:

- **Level 2 (Basic)** — Logs messages when a NameServer starts and stops, load balancing status and messages on registering and unregistering brokers. This is the default logging level.

- **Level 3 (Verbose)** — Same as logging Level 2, plus logs requests from clients, and status information on the communication between client and NameServer and between NameServer and brokers.

- **Level 4 (Extended)** — Same as logging Level 3, plus logs debugging messages on broker unregistering.

Log entries generated for this type contain the tag NSPlumbing.

The following example shows log entries for the NameServer component with logging level set to VERBOSE(3) (with headers suppressed):

```
2 NS NSPlumbing Starting NameServer NS1 rmi://test:20931/NS1 Port = 5162 TimeOut = 30. (8196)
2 NS NSPlumbing Load Balancing Disabled For NameServer NS1. (8200)
2 NS NSPlumbing Registering Broker 11d1def534e1be0:283b8a:e8c5ff9235:-7da4 AS.icfrepos test/127.0.0.1 3095. (8205)
2 NS NSPlumbing Broker 11d1def534e1be0:283b8a:e8c5ff9235:-7da4 Registered For Application Service AS.icfrepos. (8207)
3 NS NSPlumbing Response sent to 127.0.0.1 2837. (8202)
3 NS NSPlumbing Request received from 127.0.0.1 2843 for AS.icfrepos. (8201)
3 NS NSPlumbing AppService = AS.icfrepos Found = true Number Of Brokers = 1. (8206)
3 NS NSPlumbing Response sent to 127.0.0.1 2843. (8202)
3 NS NSPlumbing Known Broker 11d1def534e1be0:283b8a:e8c5ff9235:-7da4 AS.icfrepos test/127.0.0.1 3095. (8209)
```
Query information logging

Query information logging fills a void for ABL developers trying to evaluate what happens when a query executes and how efficient query execution might be. In large deployed applications, it is impractical for developers to add diagnostics to their code to track and analyze the efficiency and performance of queries.

Query information logging takes advantage of the OpenEdge logging infrastructure to provide you with extended logging information that helps you to locate and correct issues with queries that cause performance degradation (such as poorly indexed queries, or client/server queries that result in excess network traffic).

The following sections provide information about using query information logging:

- Query information log entry type and logging levels
- Starting query information logging
- Generating query information
- Query information logged
- Query plan
- Query statistics
- Sample query information logs

Query information log entry type and logging levels

Specifying the query information (QryInfo) log entry type enables logging of queries (each open query and FOR EACH block) executed in an application. Information is logged at the following logging levels:

- **Level 2 (Basic)** — Logs information about individual queries—this is the default logging level
- **Level 3 (Verbose)** — Logs information about all queries

The following information is logged at each level:

- Index listing
- Query resolution details
- Query statistics

If you set the level to 4 (Extended), information is logged at level 3 (Verbose).
Starting query information logging

To create query information log entries, use the Log Entry Types (-logentrytypes) startup parameter or, for the AppServer and WebSpeed, the srvrLogEntryTypes property in the ubroker.properties file. Specify the QryInfo log entry type alone or in a comma-separated list that includes other log entry types. For example:

- logentrytypes QryInfo

- logentrytypes QryInfo,ProEvents.UI.Command

You can also turn on this logging at run time, using the LOG-MANAGER system handle. For example, you can include the following line in the ABL code:

LOG-MANAGER:LOG-ENTRY-TYPES = “QryInfo:3”

You can turn off this logging in the ABL application by resetting the attribute. For example:

LOG-MANAGER:LOG-ENTRY-TYPES = ?

Whichever way you start query information logging, you must do so before the query starts, or else no logging will occur for this query. If you turn off query information logging before the query completes, no logging will occur for this query.

Starting query information logging on individual queries

You can turn on query information logging programmatically for an individual query by doing the following:

- Ensure that the logging level of the QryInfo log entry type is Basic (level 2).
- Set the BASIC-LOGGING attribute of the query object handle to TRUE before the query starts, as follows:
  - For a dynamically opened query, this is before the QUERY-PREPARE() method
  - For a statically opened query, this is before the OPEN QUERY statement

**Note:** Since FOR EACH and static PRESELECT queries do not have an associated handle, you cannot log them at level 2.

If the query has already started, no query information logging occurs.
Upon successful startup, OpenEdge writes a message to the log file noting that it has turned on query information logging for the query; the message includes a Query ID, handle, and query name.

To turn off query information logging for the query, set the BASIC-LOGGING attribute of the query object handle to FALSE. If you do this before the query completes, no query statistics are written. OpenEdge writes a message to the log file noting that it has turned off query information logging for the query; the message includes a Query ID, handle, and query name.

**Writing query statistics on-demand**

You can write the currently accumulated query information logging statistics on a query to the log before the query completes, by calling the DUMP-LOGGING-NOW( ) method of the query object handle.

When you call DUMP-LOGGING-NOW( ) for a pre-pass query, OpenEdge writes the second set of statistics to the log. OpenEdge writes the first set after it builds the result-list. For more information, see the “Query statistics for pre-pass queries” section on page 6–43.

The DUMP-LOGGING-NOW( ) method returns TRUE if OpenEdge successfully writes the statistics to the log file; FALSE otherwise. Logging will fail, for example, if query information logging is turned off (for the individual query or in general), or if the query started before query information logging was turned on.

The syntax for the DUMP-LOGGING-NOW( ) method is:

```
query-handle:DUMP-LOGGING-NOW(reset)
```

The DUMP-LOGGING-NOW() method takes an optional logical argument that, if set to TRUE, resets the query’s statistics to zero after writing to the log. FALSE is the default. In either case, statistics continue to accumulate as the query completes.

The following example writes to the log file after each result and resets the accumulated values:

```
DEFINE VARIABLE qh AS HANDLE NO-UNDO.
CREATE QUERY qh.
qh:QUERY-PREPARE("FOR EACH customer WHERE customer.custnum < 5").
qh:QUERY-OPEN().
REPEAT:
    qh:GET-NEXT().
    IF qh:QUERY-OFF-END THEN LEAVE.
    qh:DUMP-LOGGING-NOW(TRUE).
END.
```
Generating query information

The following ABL constructs generate query information logging:

- **FOR [EACH | FIRST | LAST] statements:**

  ```abl
  FOR EACH customer
  ```

- **Static PRESELECT statement on REPEAT or DO blocks:**

  ```abl
  REPEAT PRESELECT FOR EACH customer, EACH order OF CUSTOMER
  ```

- **Statically Opened Queries:**

  ```abl
  OPEN QUERY q FOR EACH customer
  ```

- **Dynamically Opened Queries**

  It is possible to dynamically open both dynamic and static queries:
  
  - **For a dynamic query object:**

    ```abl
    DEFINE VARIABLE qh AS HANDLE NO-UNDO.
    CREATE QUERY qh.
    ... qh:QUERY-PREPARE("FOR EACH customer").
    qh:QUERY-OPEN().
    ```

  - **For a static query object:**

    ```abl
    DEFINE VARIABLE qh AS HANDLE NO-UNDO.
    DEFINE QUERY q FOR CUSTOMER.
    qh = q:HANDLE.
    qh:QUERY-PREPARE("FOR EACH customer").
    qh:QUERY-OPEN().
    ```

Query information logging logs information separately for each instance of the same query. For example, if a program containing a query calls itself recursively, information is logged for each instance of the query.
Distinguishing between query objects

You typically generate ABL query objects as follows:

- You define static queries. For example:

```
DEFINE QUERY q1 FOR customer.
```

- You create dynamic queries. For example:

```
DEFINE VARIABLE my-query-handle AS HANDLE NO-UNDO.
CREATE QUERY my-query-handle.
```

It also is possible for you to dynamically open a static query; that is, you can define the query statically, but then get a handle to the query, and prepare and open the query as you would a dynamic query. Since query information logging reacts to how a query is prepared and opened, not to how it is defined or created, it is necessary to distinguish between static and dynamic queries, and queries that are statically or dynamically opened.

For example, query information logging logs query preparation statistics for dynamically opened queries, as it happens at run time and can affect the performance of an application. For statically opened queries, the preparation happens at compile time, so there is no impact at run time.

There are some places in query information logging that do relate specifically to dynamic and static queries. For example, dynamic queries typically do not have a name, while static queries always have a name. This means that a dynamically opened query might or might not have a name. Thus, query information logging will log the name only when it is available.

Both database and temp-table queries are logged.

Unsupported queries

OpenEdge provides no query information logging for SQL statements within an ABL procedure, or for free-standing FIND statements. For example:

```
REPEAT:
    FIND NEXT customer.
END.
```

Similarly, query information logging does not log query information for WebSpeed support programs, such as any programs in the web/objects, webutil, webedit, and weboots directories.
Query information logged

Query information logging logs two categories of information:

- Query plan
- Query statistics

Since the information in these two categories is not necessarily written contiguously to the log file, a unique identifier links the two. This Query ID, which is a hexadecimal string, has no significance beyond matching a query’s plan to its statistics.

Query plan

The query plan contains the following information about how OpenEdge extracts information for the query:

- Procedure name and line number where the query started:
  - For dynamically opened queries, this is the QUERY-PREPARE() method
  - For statically opened queries, this is the OPEN QUERY statement
  - For static PRESELECT and FOR statements, this is the top of the FOR or REPEAT/DO PRESELECT block.
- Query ID, the query's unique identifier.
- For statically and dynamically opened queries, a string representation of the query handle, and the name of the query (if available).
- Whether the query is a FOR statement, a static PRESELECT statement, a statically opened query, or dynamically opened query.
- For dynamically opened queries, the PREPARE-STRING.
- When the query was prepared:
  - For FOR and static PRESELECT statements, and statically opened queries, this is at compile time. Query information logging will report “Prepared at Compile Time”.
  - For dynamically opened queries, this is at run time. Query information logging will report “Prepared at Runtime”.
- Whether the client is performing sorting.
- Whether this is a SCROLLING query, and whether it uses INDEXED-REPOSITION.
- Table and index information for each table used in the query. The index information that query information logging provides, such as the INDEX-INFORMATION attribute of the query object handle, is already available within ABL. To get more complete index information, use COMPILE XREF. For more information on indices, see the “Identifying indices” section on page 6–41.
• Whether the query uses PRESELECT. Using the PRESELECT keyword in a dynamically opened query has the same effect as the static PRESELECT, that is, it builds a preselected list of records.

• The time it takes to prepare dynamically opened queries.

OpenEdge logs and collates query plan information at specific times, based on query type, as follows:

• On a FOR statement, after the top of the FOR statement block executes

• On a statically opened query, after the OPEN QUERY statement executes

• On a dynamically opened query, after the QUERY-PREPARE() method of the query handle executes

• On the static PRESELECT statement, after the top of the REPEAT | DO PRESELECT block executes

Identifying indices

Query information logging identifies single and multiple index brackets used by the query engine for FOR and PRESELECT statements. It also identifies indices for dynamic and static queries that use multiple index brackets. Selected indices will display in a comma-separated list in the Query Plan.

Note: When using dataservers, the logged index behavior may not accurately reflect the indices used to resolve the query against the non-OpenEdge database. For more information, see OpenEdge Getting Started: Database Essentials.

For the following FOR EACH statement:

```
FOR EACH invoice
    WHERE (((invoice.ordernum >= 102) AND
              (invoice.custnum >= 28 AND invoice.custnum <= 30) AND
              (invoice.invoicenum > 100 AND invoice.invoicenum <= 105)) OR
           ( invoice.ordernum > 118 AND invoice.ordernum <= 119) AND
           ( invoice.custnum = 46 AND invoice.custnum <= 119) AND
           ( invoice.invoicenum = 136))
```

Query information logging produces the following Query Plan:

```
Query Plan: C:\work\100a\qitest.p line 1
QueryId: 0xec091c
Type: FOR Statement
Client Sort: N
Scrolling: N
Table: sports2000.Invoice
Indexes: InvoiceNum,CustNum
```
Query statistics

Query statistics provide information on the query as it extracts data from the database. That is, on the retrieval of records during the query. This information is intended to help you evaluate query performance.

For the purposes of gathering statistics, queries fall into either of two categories:

- **Pre-pass queries** — Queries that build a result-list completely, in one ABL statement, before going on to the next ABL statement. The AVM builds the result-list at different times for different types of queries. These queries include:
  - Static and dynamic queries that perform sorting or pre-fetching. (The AVM builds a complete result-list only on the first GET NEXT statement or GET-NEXT() method executed.)
  - Static PRESELECT statements. The AVM builds a complete result-list on the PRESELECT statement.
  - FOR statements that sort on the client and build a list of results in a sort file. The AVM builds a complete result-list on the FOR EACH statement.

- **Non-pre-pass queries** — Queries that do not build a result-list completely before executing the next ABL statement. These queries include FOR EACH statements and queries that sort by an index, enabling the server to identify the next record from the index, without any sorting by the client.

Between record retrievals, the client steps through ABL statements in an iterating block, for example, between a FOR EACH and its corresponding END statement. In cases where the client is selecting the records, only fetches involving records that satisfy selection criteria iterate through the loop.

Query information logging logs different information depending on whether the query is a pre-pass query or a non-pre-pass query. Both pre-pass and non-pre-pass queries write statistics when the query is complete. A query is considered complete at the following points in the code:

- For FOR and static PRESELECT statements, at the end of the block (the END statement). Any statements that cause a premature exit from the block still result in end-of-block processing, and the logging of query statistics.

- For static and dynamic queries, when the AVM closes the query. The following are examples of when the AVM closes the query:
  - On a CLOSE QUERY statement or QUERY-CLOSE() method
  - On a OPEN QUERY statement or QUERY-OPEN() method if the query is already open
  - When the query goes out of scope, that is, the program containing the query exits
  - When a program deletes a buffer used by a dynamically opened query
Query statistics for pre-pass queries

OpenEdge provides two sets of query statistics for pre-pass queries: first, when the AVM builds the result-list; second, when the query is complete (that is, at the end of the block or when the AVM closes the query).

OpenEdge logs the following query statistics when it completely builds the result-list for a pre-pass query:

- Procedure name and line number where the AVM built the result-list.
- Query ID, the query's unique identifier.
- For static and dynamic queries, a string representation of the query handle, and the name of the query object (if available).
- Number of entries in the result-list.
- Time taken to build the result-list. See the “Time taken to build a result-list” section on page 6–45.
- Database block access required to build the result-list. See the “Database block access” section on page 6–46.
- Table and index read access statistics. See the “Read Access Statistics” section on page 6–46.
- Number of records for each table in the query that were sent to the client to resolve the query. See the “Number of records sent by the server” section on page 6–45.
- Field list used to optimize the query. See the “Field list information” section on page 6–46.
- Whether the client rather than the server performs selection of records for each table in the query.
- Number of times the AVM has opened this query. A program can reuse static and dynamic query objects. Opening a query multiple times, as within a loop, might indicate poor programming practice.
- For dynamically opened queries, query preparation statistics. See the “Query preparation statistics” section on page 6–44.

OpenEdge logs the following query statistics when the pre-pass query is complete:

- Procedure name and line number where the block ends or the AVM closes the query.
- Query ID, the query's unique identifier.
- For statically and dynamically opened queries, a string representation of the query handle, and the name of the query object (if available).
- Database block access required to retrieve the ABL records. This is not logged for queries on temp-tables. See the “Database block access” section on page 6–46.
- Table and index read access statistics. See the “Read Access Statistics” section on page 6–46.
- Number of available records for each table in the query. See the “Number of available records in the query” section on page 6–45.

- Whether the program used INDEX-REPOSITION on the query.

**Query statistics for non-pre-pass queries**

OpenEdge provides a single set of statistics for non-pre-pass queries at query completion. Query information logging logs the following query statistics when the query is complete:

- Procedure name and line number where the block ends or where the AVM closes the query.

- Query ID, the query's unique identifier.

- For dynamic or static queries, a string representation of the query handle, and the name of the query object (if available).

- Database block access required to resolve the query. This is not logged for queries on temp-tables. See the “Database block access” section on page 6–46.

- Table and index read access statistics. See the “Read Access Statistics” section on page 6–46.

- Field list used to optimize the query. See the “Field list information” section on page 6–46.

- Number of available records for each table in the query. See the “Number of available records in the query” section on page 6–45.

- Number of records for each table in the query that were sent to the client to resolve the query. See the “Number of records sent by the server” section on page 6–45.

- Whether the client rather than the server performs selection of records for each table in the query.

- For dynamic or static queries, number of times the AVM has opened this query.

- For dynamically opened queries, query preparation statistics. See the “Query preparation statistics” section on page 6–44.

- For scrolling queries, whether the program used INDEX-REPOSITION on the query.

**Query preparation statistics**

Query preparation determines how the AVM will access the requested data, for example, which indices to use. The compiler prepares statically opened queries at compile time. The AVM prepares dynamically opened queries at run time, using the **QUERY-PREPARE()** method.

Because preparation of a dynamically opened query can have an impact on performance, query information logging tracks the following statistics on dynamically opened queries:

- Number of times the AVM has prepared this query

- Time taken to prepare the query (in milliseconds)

- Database block access required to prepare the query
Number of records sent by the server

The server, in resolving a query, sends a number of records to the client. In certain cases, the client determines whether a record satisfies selection criteria. If a query returns a large number of records, only a few of which the client determines satisfy the selection criteria, the query might be inefficient.

For each table in a query, query information logging tracks:

- The number of records sent to the client. For self-service and single-user database connections, this refers to the number of records selected by the database engine.
- The number of records that satisfied the criteria.
- The number of records that failed the criteria.

Optimizations within the client and database server might skew the figures somewhat, as in the cases when the server returns to the client field lists rather than a full record, or a prefetched list of records.

Use these figures with other statistical data to determine if a query is inefficient.

Number of available records in the query

It is useful to know the number of available records in the query:

- In the context of a FOR block or a REPEAT loop on a query, this is the number of records the ABL program accessed through a buffer.
- For a browse object on a static or dynamic query, this is the number of records fetched to populate the browse.

Consider this figure in light of other statistical data, such as blocks accessed, or records sent by the server, to determine the efficiency of the query. For example:

- If used in a FOR or static PRESELECT block with no repositioning, the figure accurately reflects the number of records that satisfy the following search criteria:

  FOR EACH customer WHERE customer.custnum < 5

  There are four customers.

- If a program repositions the query, or leaves a block before it fetches all records that satisfy the criteria, the figure is not a true measure of the number of matching records.

Time taken to build a result-list

It is useful to know how long it takes to build a result-list for a pre-pass query, in evaluating query efficiency. Using this value in combination with other statistical data, such as the number of entries in a result-list, the number of records read, and database block access, you can calculate your own query averages, for example, average time a record is available, or average time for a record to be sent to the client.
Field list information

Defining field lists in a query improves performance to remote databases and dataservers. The ABL compiler may further optimize the query by adding implicit fields to the field lists or use an implicit field list if the user did not specify one. Query information logging logs all field lists a query uses as part of the Query Statistics. Each field list is logged with the table to which it applies.

For more information on field lists, see OpenEdge Development: Programming Interfaces.

Database block access

When evaluating query efficiency, it is useful to consider the number of times the server performs database block accesses on behalf of the client. A disparity in the number of accesses to records returned could indicate poor index selection. OpenEdge tracks database block access on OpenEdge RDBMSs (but not on dataservers) in the _userio-dbaccess field of the _userio Virtual System Table as follows:

- For pre-pass queries, the number of blocks accessed is the difference between the number of block accesses immediately before the query starts building the result-list, and the number immediately after the query finishes building the list.
- For non-pre-pass queries, and for the reading of ABL records in pre-pass queries, the number of blocks accessed is the accumulation of accesses before and after each record fetch executed by the query.

A large number of database block accesses do not necessarily indicate a poorly conceived query. The number stored in the _userio-dbaccess field is a combined figure that includes both RM (data) and index block accesses. Although a high count on index accesses might predictably indicate inefficiencies in index use, a high count on RM accesses might simply mean that records are scattered throughout the database rather than in contiguous blocks. Thus, you have to weigh this value with other statistical data to determine query efficiency.

Note: Although not recommended, it is possible for a query to access tables in more than one database. For any such queries, OpenEdge records block access statistics for each database accessed. OpenEdge does not, however, track block access statistics for databases in single-user mode.

Read Access Statistics

Query information logging captures table and index read access statistics for each table and index identified in a query against an OpenEdge database. Read access statistics includes reads by all users connected to the database.

Note: Query information logging omits read access statistics for DataServers and temp-tables. Additionally, read access statistics are not logged for preparing a dynamic query.

Table read access statistics provide the number of times read access has occurred on a table. Use Base Table (-basetable) with Table Range Size (-tablerangesize) to specify the range of tables for which you want to collect statistics. Table statistics are stored in the _TableStat-Read field of the _TableStat Virtual System Tables (VST).
Index read access statistics provide the number of times read access has occurred on an index. Use Base Index (-baseindex) with Index Range Size (-indexrangesize) to specify the range of indexes for which you want to collect statistics. Index statistics are stored in the _IndexStat-Read field of the _IndexStat VST.

Read access statistics information is located in the Query Statistics after the DB Block access statistics. For each table in the query, or a non-pre-pass query, the client writes the read access statistics in the Query Statistics once the query completes. For a pre-pass query, the client writes the read access statistics in the Query Statistics for building the results list, and again once the query completes. This differentiates the read accesses required to build the result list from those required to iterate through the list.

In order to get the table and index read statistics, the user must ensure the queried tables and indices are within the ranges specified by the startup parameters Base Table (-basetable)/Table Range Size (-tablerrangesize) and Base Index (-baseindex)/Index Range Size (-indexrangesize) ranges. If your query accesses tables or indices outside these ranges, query information logging cannot determine the access statistics for the tables or indices, and displays “UNAVAILABLE” for the read access statistics.

For more information on the referenced startup parameters, see OpenEdge Deployment: Startup Command and Parameter Reference. For more information on VSTs, see OpenEdge Data Management: Database Administration.

Sample query information logs

Sample output formats (with headers suppressed) of query information logs are shown.

The following is a code example for a non-pre-pass query:

```
FOR EACH invoice
  WHERE ((invoice.ordernum >= 102) AND
    (invoice.custnum >= 28 AND invoice.custnum <= 30) AND
    (invoice.invoicenum > 100 AND invoice.invoicenum <= 105)) OR
    ((invoice.ordernum > 118 AND invoice.ordernum <= 119) AND
    (invoice.custnum = 46) AND
    (invoice.invoicenum > 115 AND invoice.invoicenum < 120)) OR
  (invoicenum = 136),
  EACH order WHERE order.ordernum = invoice.ordernum:
    DISPLAY invoice.invoicenum order.ordernum.
END.
```

The following is an example of the query plan for a non-pre-pass query:

```
Query Plan: qisample1.p line 1
QueryId: 0x159e004
Type: FOR Statement
Client Sort: N
Scrolling: N
Table: sports2000.Invoice
  Indexes: InvoiceNum,CustNum
Table: sports2000.Order
  Indexes: OrderNum
```
The following is an example of the query statistics for a non-pre-pass query:

```
Query Statistics:  qisample1.p line 11
QueryId: 0x159e004
DB Blocks accessed:
  sports2000 : 43
DB Reads:
  Table: sports2000.Invoice : 11
  Index: Invoice.InvoiceNum : 8
  Index: Invoice.CustNum : 6
  Table: sports2000.Order : 3
  Index: Order.OrderNum : 6
sports2000.Invoice Table:
  4GL Records: 3
  Records from server: 3
  Useful: 3
  Failed: 0
  Select By Client: N
sports2000.Order Table:
  4GL Records: 3
  Records from server: 3
  Useful: 3
  Failed: 0
  Select By Client: N
```

The following is a code example for a pre-pass query:

```
FOR EACH invoice
  WHERE ((invoice.ordernum >= 102) AND
          (invoice.custnum >= 28 AND invoice.custnum <= 30) AND
          (invoice.invoicenum > 100 AND invoice.invoicenum <= 105)) OR
    ((invoice.ordernum > 118 AND invoice.ordernum <= 119) AND
     (invoice.custnum = 46) AND
     (invoice.invoicenum > 115 AND invoice.invoicenum < 120)) OR
    (invoice.invoicenum = 136),
  EACH order WHERE order.ordernum = invoice.ordernum BY invoice.custnum:
    DISPLAY invoice.invoicenum order.ordernum.
END.
```

The following is an example of the query plan for a pre-pass query:

```
Query Plan:  qisample2.p line 1
QueryId: 0x159e006
Type: FOR Statement
Client Sort: Y
Scrolling: N
Table: sports2000.Invoice
  Indexes: CustNum,InvoiceNum
Table: sports2000.Order
  Indexes: OrderNum
```
The following is an example of the query statistics for building the result-list on a pre-pass query:

```
QueryId: 0x159e006
Entries in result list: 3
Time to build result list (ms): 16
DB Blocks accessed to build result list:
sports2000 : 38
DB Reads to build result list:
Table: sports2000.Invoice : 15
Index: Invoice.CustNum : 16
Index: Invoice.InvoiceNum : 2
Table: sports2000.Order : 0
Index: Order.OrderNum : 0
sports2000.Invoice Table:
Records from server: 3
Useful: 3
Failed: 0
Select By Client: N
sports2000.Order Table:
Records from server: 0
Useful: 0
Failed: 0
Select By Client: N
```

The following is an example of the second query statistics (record retrieval) on a pre-pass query:

```
Query Statistics: qisample2.p line 12
QueryId: 0x159e006
DB Blocks accessed:
sports2000 : 15
DB Reads:
Table: sports2000.Invoice : 3
Index: Invoice.CustNum : 0
Index: Invoice.InvoiceNum : 0
Table: sports2000.Order : 3
Index: Order.OrderNum : 6
sports2000.Invoice Table:
4GL Records: 3
```

The following is an example of the query statistics when the read access statistics for the table and index are outside of range:

```
Query Statistics: idxnum.p line 6
QueryId: 0x159f3ec
DB Blocks accessed:
sports2004 : 272
DB Reads:
Table: sports2004.item : UNAVAILABLE
Index: item.Item_Obj : UNAVAILABLE
sports2004.item Table:
4GL Records: 134
Records from server: 134
Useful: 134
Failed: 0
Select By Client: N
```
SAX parser logging

Specifying the SAX parser (SAX) log entry type turns on logging for the SAX parser. Table 6–6 lists the message logged as the SAX parser executes.

Table 6–6: SAX parser logging messages

<table>
<thead>
<tr>
<th>When logging occurs</th>
<th>What is logged</th>
</tr>
</thead>
<tbody>
<tr>
<td>The AVM initializes the parser.</td>
<td>Initialize parser</td>
</tr>
<tr>
<td>The AVM finishes using the parser.</td>
<td>Exiting parser</td>
</tr>
<tr>
<td>The AVM finds a callback to run.</td>
<td>Callback \textit{internal-routine-name} found in super procedure</td>
</tr>
<tr>
<td></td>
<td>— or —</td>
</tr>
<tr>
<td></td>
<td>Callback \textit{internal-routine-name} found</td>
</tr>
<tr>
<td>The AVM does not find a callback to run.</td>
<td>Callback \textit{internal-routine-name} not found</td>
</tr>
<tr>
<td>For each parameter in a callback, the log message includes the following, depending on the parameter type:</td>
<td>parameter \textit{parameter-number}: value</td>
</tr>
<tr>
<td>• CHARACTER, MEMPTR (which contains a string), or INTEGER</td>
<td>parameter \textit{parameter-number}: \textless null\textgreater</td>
</tr>
<tr>
<td>• If CHARACTER parameter is empty</td>
<td>parameter \textit{parameter-number}: \textless valid-handle\textgreater</td>
</tr>
</tbody>
</table>

The following example shows log entries for the SAX parser at logging level 2 (Basic) with headers suppressed:

```
1 4GL -- Log entry types activated:SAX
2 4GL SAX Initialize parser
2 4GL SAX Callback StartDocument not found
2 4GL SAX Callback StartElement found
2 4GL SAX parameter 1: <null>
2 4GL SAX parameter 2: custorders
2 4GL SAX parameter 3: custorders
2 4GL SAX parameter 4: <valid handle>
2 4GL SAX Callback Characters found
2 4GL SAX parameter 1:
2 4GL SAX parameter 2: 1
2 4GL SAX Callback EndElement found
2 4GL SAX parameter 1: <null>
2 4GL SAX parameter 2: city
2 4GL SAX parameter 3: city
2 4GL SAX Callback EndDocument not found
2 4GL SAX Exiting parser
```
Unified Broker logging

Specifying a Unified Broker log entry type turns on logging for the Unified Broker component. These are the Unified Broker log entry types and the information they provide based on logging level:

- **UBroker.Basic** — Logs messages about broker and server startup and shutdown, NameServer registration, and connections from clients at Level 2 (Basic). At Level 3 (Verbose), logs information about all the property values read from the `ubroker.properties` file for that broker instance, and more information on the connection from clients.

The following example shows log messages for the `UBroker.Basic` entry type (with headers suppressed):

<table>
<thead>
<tr>
<th>Level</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>UB Basic ubroker version: v100B (28-Apr-04) (8038)</td>
</tr>
<tr>
<td>2</td>
<td>UB Basic Started listener thread: L-3090 (8043)</td>
</tr>
<tr>
<td>3</td>
<td>UB Basic installDir: d:\dlc100b</td>
</tr>
<tr>
<td>3</td>
<td>UB Basic properties file: d:\dlc100b\properties\ubroker.properties</td>
</tr>
<tr>
<td>3</td>
<td>UB Basic Broker: asbroker1</td>
</tr>
<tr>
<td>3</td>
<td>UB Basic serverType: AS</td>
</tr>
</tbody>
</table>

- **UBroker.ThreadPool** — Logs messages about the pool of threads managed by the broker. These threads are used to control the client requests and the server processes. This entry type will log messages when adding, removing, and communicating with these threads. Information is logged at logging level 2 (Basic) and higher.

- **UBroker.AutoTrim** — Logs messages about automatic server thread trimming by the broker based on the `autoTrimTimeout` property. Information is logged at logging level 2 (Basic) and higher.

- You should turn on the following log entry types only if Progress Software Corporation Technical Support requests that you do so:
  - **UBroker.ClientFSM** — Logs messages about the state of the client thread as it processes the requests, from the moment it receives a connection request to the end of the request. Information is logged at logging level 2 (Basic) and higher.
  - **UBroker.ServerFSM** — Logs messages about the state of the server thread as it processes the requests, from the moment it receives a connection request to the end of the request. Information is logged at logging level 2 (Basic) and higher.
  - **UBroker.ClientMsgStream** — Logs messages about messages exchanged between the broker and client threads in binary format. Information is logged at logging level 2 (Basic) and higher.
  - **UBroker.ServerMsgStream** — Logs messages about messages exchanged between the broker and server threads in binary format. Information is logged at logging level 2 (Basic) and higher.
  - **UBroker.ClientMsgQueue** — Logs messages about the client thread as it processes queued messages. Information is logged at logging level 2 (Basic) and higher.
- **UBroker.ServerMsgQueue** — Logs messages about the server thread as it processes queued message. Information is logged at logging level 2 (Basic) and higher.

- **UBroker.ClientMemTrace** — Traces messages being processed by the client threads. Information is logged at logging level 2 (Basic) and higher.

- **UBroker.ServerMemTrace** — Traces messages being processed by the server threads. Information is logged at logging level 2 (Basic) and higher.

- **UBroker.Stats** — Logs statistics about the number of requests, plus maximum, minimum, and average request wait and duration times. Information is logged at logging level 2 (Basic) and higher.

- **UBroker.All** — Logs all **UBroker** entry types.
Web Services Adapter (WSA) and Web Service logging

The WSA log file and Web service SOAP fault response messages provide Web service error information. You control the amount of information provided using the loggingLevel, serviceLoggingLevel, and serviceFaultLevel properties. The following sections describe:

- Setting the WSADefault log entry type
- Setting the loggingLevel property
- Setting the serviceLoggingLevel property
- Setting the serviceFaultLevel property
- Understanding Web service information in WSA logs

Setting the WSADefault log entry type

Specifying the logging for Web Services Adapter (WSA) provides information based on logging level. The WSADefault log entry type provides server-related messages for a single WSA instance. You can set the WSADefault log entry type by using Progress Explorer or directly editing the ubroker.properties file.

Setting the loggingLevel property

The WSADefault log entry type provides server-related messages for a single WSA instance based on the following logging levels:

- **Level 2 (Basic)** — Logs processing requests and very severe errors. Use Level 2 in a production environment.

  **Note:** During production, scan the background event counters looking for errors. Raise the logging level to 3 or 4 to evaluate the errors and determine the problem. When the problem is resolved, return the logging level to 2.

- **Level 3 (Verbose)** — Logs general access problems, startup property values, user authorization errors, request IDs, HTTP error responses, and WSDL retrieval errors. Use Level 3 in a development environment.

- **Level 4 (Extended)** — Logs HTTP and SOAP requests and responses. Use Level 4 to debug.

The WSA instance logs error messages in the `instance-name.wsa.log` file. This file resides in your OpenEdge working directory.

You can set the loggingLevel property using the Progress Explorer, the wsaman utility, or directly editing the ubroker.properties file. This persistent value takes affect when the WSA is started. You can also set a temporary value for the loggingLevel property.

**Note:** It is not necessary to stop and restart the WSA to change the logging level.
Setting the `serviceLoggingLevel` property

The Web service also logs error messages in the `instance-name.wsa.log` file. The `serviceLoggingLevel` property affects logged information for a single deployed Web service. You can set the `serviceLoggingLevel` property in the Web service properties file (`*.props`) or by using the `wsaman` utility. This setting takes effect immediately at run time. The `serviceLoggingLevel` property provides information at the following logging levels:

- **Level 2 (Basic)** — Logs severe errors that affect the Web service as a whole and user authentication errors. Use Level 2 when the Web service is running in production.

  **Note:** During production, raise the logging level of only the Web Service being debugged.

- **Level 3 (Verbose)** — Logs Web service request execution, SOAP message processing errors, and user authentication success. Use this value during Web service development to provide more information for each Web service request error.

- **Level 4 (Extended)** — Logs error detail and request parameter values. Use Level 4 in a development environment.

Setting the `serviceFaultLevel` property

Errors while processing a Web service client request generate a SOAP fault message. The amount of information returned from SOAP fault messages is set by the `serviceFaultLevel` property for the Web service. You specify the amount of information provided with SOAP fault messages by setting the `serviceFaultLevel` property for a single Web service. You set the `serviceFaultLevel` property in the Web service properties file (`*.props`) or by using the `wsaman` utility. This setting takes effect immediately at run time. The `serviceFaultLevel` property provides information at the following logging levels:

- **Level 2 (Basic)** — Logs general error information. Use Level 2 when the Web service is running in production.

- **Level 3 (Verbose)** — Logs Web service request execution, SOAP message processing errors, and user authentication success. Use Level 3 when the Web service is in development or when more detail is required while running in production.

  **Note:** All Web service logging and fault levels are controlled individually for each Web service to further reduce processing overhead.
Understanding Web service information in WSA logs

When the WSA starts up, each WSA instance receives a unique, alphanumeric identifier called the WSA ID. The WSA ID appears in the log file after the “ID”, as follows:

```
ID f83c04d3ca9b076a:648016:1067934305::7fff
```

When the WSA instance receives a request from a Web service, the WSA instance assigns the request a unique alphanumeric identifier called request ID. When the WSA instance logs information about a Web service request, the WSA includes the request ID in the following format, where \texttt{wsaid-value} is the WSA ID and \texttt{reqid-value} is the request ID:

```
(reqid:wsaid-value#reqid-value)
```

The client uses the WSA ID and the request ID to find more detailed information in the corresponding entries of the WSA log file.

The following log (with headers suppressed) was generated for WSADefault entry type at logging level 2 (Basic):

```
1 wsal Starting WSA adapter wsal, version 10.1A1) ID f83c04d3ca9b076a:648016:1067934305::7fff (10620)
1 wsal Runtime properties set for WSA
2 wsal Admin-Provider Deploying Web Service application: GetCustName
   GetCustName 4GL-Provider   Error in SOAP request execution: Connect Failure: Application Service GetCustName Unknown at NameServer at Host localhost Port 5162. (8234) (10926)
```

For more information on Web Services Adapter logging see \textit{OpenEdge Development: Web Services}.

For more information on using the wsaman utility, see \textit{OpenEdge Application Server: Administration}. For more information on the serviceLoggingLevel and serviceFaultLevel properties, see the Web service properties reference sections of \textit{OpenEdge Application Server: Administration}. 
WebSpeed Messenger logging

Specifying the WebSpeed Messengers (MsgrTrace) log entry type turns on logging for the WebSpeed Messengers. Information is logged at the following logging levels:

- **Level 2 (Basic)** — For CGIIP, logs the start and end of the request, and the values of the CONTENT_LENGTH, PATH_INFO, and QUERY_STRING variables. For other Messengers, logs the environment variables.

- **Level 3 (Verbose)** — Same as logging level 2, plus the CGIIP environment variables, and the environment variables in binary format for other Messengers.

- **Level 4 (Extended)** — Same as logging level 3, plus the environment variables in binary format for CGIIP. Logging level 4 shows all messages generated at all logging levels.

The following log (with headers suppressed) was generated for CGIIP with the MsgrTrace entry type at logging level 4 (EXTENDED):

```
3 ENV ------- CONTENT_LENGTH=0
3 ENV ------- GATEWAY_INTERFACE=CGI/1.1
3 ENV ------- HTTP_ACCEPT=image/gif, image/x-xbitmap, image/jpeg, image/pjpeg, application/vnd.ms-excel, application/vnd.ms-powerpoint, application/msword, application/x-shockwave-flash, */*
3 ENV ------- HTTP_ACCEPT_LANGUAGE=en-us
3 ENV ------- HTTP_CONNECTION=Keep-Alive
3 ENV ------- HTTP_HOST=test
3 ENV ------- HTTP_ACCEPT_ENCODING=gzip, deflate
3 ENV ------- HTTPS=off
3 ENV ------- SCRIPT_NAME=/scripts/cgiip.exe
3 ENV ------- SERVER_PORT=80
3 ENV ------- SERVER_PORT_SECURE=0
3 ENV ------- SERVER_PROTOCOL=HTTP/1.1
3 ENV ------- SERVER_SOFTWARE=Microsoft-IIS/5.1
2 ENV ------- CONTENT_LENGTH= 0
2 ENV ------- PATH_INFO= /WService=wsbroker1/workshop
2 CGI TERM-RQ End Request
```

For more information on WebSpeed Messenger logging see *OpenEdge Application Server: Administration*. 
This chapter is a resource for information about other diagnostics tools and aids available in the OpenEdge product suite and supporting product documentation. It contains information about the following types of diagnostics:

- Abnormal termination dump files
- How the AVM handles failure conditions
- Run-time diagnostics
- Analyzing procedures and queries
Abnormal termination dump files

An abnormal termination can result in some combination of the following dump files:

- procore file
- protrace file
- core file

Note: To analyze the contents of a protrace file, you need the assistance of Progress Software Corporation Technical Support.

procore file

A procore file is a text file that contains:

- A list of recent ABL (Advanced Business Language) messages, by message number
- An ABL procedure stack trace that includes line numbers from the debug listing file within each procedure

OpenEdge writes the procore file to a temporary directory, if you specify the Temporary Directory (-T) startup parameter; otherwise, OpenEdge writes the procore file to the current working directory. Example 7–1 is a sample procore file.

Example 7–1: Sample procore file

```
_12/18/01 13:44:57  [784]
Progress Recent Message(s): (5635) (5407) (5407) (5407) (5407) (5407)
(5407) (5407) (5407)
*** 4GL Call Stack ***
  4: foo InfiniteLoop.p (InfiniteLoop.p)
  4: foo InfiniteLoop.p (InfiniteLoop.p)
  4: foo InfiniteLoop.p (InfiniteLoop.p)
  4: foo InfiniteLoop.p (InfiniteLoop.p)
  4: foo InfiniteLoop.p (InfiniteLoop.p)
  4: foo InfiniteLoop.p (InfiniteLoop.p)
... (many more of these) ...
  1: InfiniteLoop.p (InfiniteLoop.p)
  1: D:\pcspot\dir1\p89453r.ped (D:\pcspot\dir1\p89453r.ped)
  588: adecomm/_runcode.p (adecomm/_runcode.r)
  3796: ExecuteRun adeedit/_proedit.p (adeedit/_proedit.r)
  10550: RunFile adeedit/_proedit.p (adeedit/_proedit.r)
  2323: USER-INTERFACE-TRIGGER adeedit/_proedit.p (adeedit/_proedit.r)
  11727: adeedit/_proedit.p (adeedit/_proedit.r)
  453: _edit.p (\\ruddles\i_91d_nt\d1c\gui\_edit.r)
```

This resulted from running a program in the Procedure Editor that contains an infinite loop. Line numbers appear at the beginning of a line, followed by a colon.
protrace file

When an OpenEdge process terminates abnormally, OpenEdge automatically creates a text file named protrace in the current directory. You can also force creation of the protrace file for a running program by using a command line utility (see the “Generating a protrace file for a running program” section on page 7–11). To analyze the contents of a protrace file, you need the assistance of Progress Software Corporation Technical Support.

The protrace file contains:

- A stack trace of the ABL Virtual Machine (AVM) or other OpenEdge process (such as a database server or utility) that terminated abnormally
- A stack trace of the executing ABL program itself, where applicable
- A list of the persistent procedures or classes that are in memory, with their handle IDs
- A list of startup parameters in effect for the ABL session
- Symbolic information (when available)

Example 7–2 is a sample protrace file.

Example 7–2: Sample protrace file

```
PROGRESS stack trace as of Tue Jan  6 13:15:16 2009
Command line arguments are
/dlc/bin/_progres -1 -p test.p
Startup parameters:
-pf /dlc/startup.pf,(end .pf),-1,-p test.p

(1) utrace() +0x134 from: /dlc/bin/_progres
(2) drsigs() +0x6e4 from: /dlc/bin/_progres
(3) drExitOnTerm() +0x30c from: /dlc/bin/_progres
(4) drExitOnTerm() +0x558 from: /dlc/bin/_progres
(5) _setuid() +0x60 from: /usr/lib/libc.so.1
(6) _select() +0x2ec from: /usr/lib/libc.so.1
(7) rnSocketSelect() +0x12c from: /dlc/bin/_progres
(8) wvResetCurItem() +0x1e4 from: /dlc/bin/_progres
(9) wvReadKey() +0x8c from: /dlc/bin/_progres
(10) ioHandlePause() +0x338 from: /dlc/bin/_progres
(11) iopause() +0x108 from: /dlc/bin/_progres
(12) rniopaus() +0x230 from: /dlc/bin/_progres
(13) rniexec_entry() +0x618 from: /dlc/bin/_progres
(14) rniexec() +0x5f4 from: /dlc/bin/_progres
(15) rnrq() +0x120 from: /dlc/bin/_progres
(16) main() +0x410 from: /dlc/bin/_progres
(17) _start() +0x108 from: /dlc/bin/_progres

** ABL Stack Trace **
--> myproc test.p (test.p) at line 4

** Persistent procedures/Classes **
```
core file

A core file is specific to UNIX. It is a binary file that requires a UNIX debugger such as dbx. A core file contains:

- A stack trace of the AVM executing ABL code
- Hex representation of the parameters to each routine

On some systems, an executable’s permissions do not allow core file generation.
How the AVM handles failure conditions

Table 7–1 summarizes the types of failures you might encounter and the diagnostic information that results.

Table 7–1: Program failures and resulting dump files

<table>
<thead>
<tr>
<th>This type of failure</th>
<th>Provides this diagnostic information</th>
</tr>
</thead>
<tbody>
<tr>
<td>The AVM detects a fatal system error, such as an out-of-memory condition.</td>
<td>A procore file. Additionally, if the message is marked as coredump:</td>
</tr>
<tr>
<td></td>
<td>• Windows — protrace file</td>
</tr>
<tr>
<td></td>
<td>• UNIX — protrace and core files</td>
</tr>
<tr>
<td>An exception occurs in OpenEdge Java code (for example, broker, NameServer,</td>
<td>A stack trace written to the log file. The broker continues to run for threads associated with other clients.</td>
</tr>
<tr>
<td>WebSpeed Messenger).</td>
<td></td>
</tr>
<tr>
<td>There is a memory violation.</td>
<td>• Windows — protrace file; Dr. Watson log, if set in the registry</td>
</tr>
<tr>
<td></td>
<td>• UNIX — procore, protrace, and core files</td>
</tr>
<tr>
<td>OpenEdge executable hangs; you must terminate it using the kill command or the</td>
<td>• Windows — None (usually, waiting for an event that never occurs in an infinite loop; or a GPF occurs that hangs during failure processing)</td>
</tr>
<tr>
<td>Task Manager.</td>
<td>• UNIX — protrace file, if you send a SIGUSR1 to the process as part of the kill operation</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Run-time diagnostics

This section identifies various types of information that you can capture while the application is executing. Developers and technical support personnel should find this information useful.

Example 7–3 shows sample code execlog.p.

Example 7–3: Sample executable procedure

```plaintext
/* execlog.p */
DEFINE VARIABLE ix AS INTEGER NO-UNDO.
FOR EACH customer FIELDS (name) NO-LOCK BY customer.name:
    DISPLAY customer.name.
    ix = ix + 1.
END.
RUN internalA (ix).
RUN execlog2.p (OUTPUT ix).
DISPLAY ix.
QUIT.

PROCEDURE internalA:
    DEFINE INPUT PARAMETER ii AS INTEGER NO-UNDO.
    DISPLAY "Number of Customers is " ii.
END.

/* execlog2.p */
DEFINE OUTPUT PARAMETER ix AS INTEGER NO-UNDO.
DO ix = 10 TO 20:
    DISPLAY ix.
END.
```

Collecting r-code usage statistics

When you use statistics startup parameters, OpenEdge writes statistics at the end of the session. You can use the SHOW-STATS statement in concert with the startup parameters to write statistics at specific times during execution. The statistics collected with the SHOW-STATS statement do not include the report of all startup parameters and their values that you get with the Statistics (-y) startup parameter.

Statistics-gathering mechanisms include these various startup parameters:

- **Statistics (-y)** — Use this startup parameter to collect procedure access and usage statistics throughout the OpenEdge session. This parameter also sends a report of all startup parameters and their values to the output file.

- **Statistics with CTRL-C (-yc)** — When you use this startup parameter, press CTRL-C rather than using the SHOW-STATS statement to control when to collect statistics during execution.

- **Segment Statistics (-yd)** — Use this startup parameter to write segment statistics, such as the number of segments and their total size, to the output file.

- **Statistics with Cross-reference (-yx)** — Use this startup parameter to collect procedure call statistics.
Example 7–4 shows the -y startup parameter statistics generated on execution of execlog.p. (See Example 7–3 for sample code of execlog.p.)

Example 7–4: Sample -y startup parameter statistics

Fri Aug 22 09:19:19 2003

Progress Startup Parameters:

- pf C:\Progress\OpenEdge\startup.pf, -cpinternal ISO8859-1, -cpstream ISO8859-1, -cpcoll Basic, -cpcase Basic, -mdy, -numsep 44, -numdec 46, (end .pf), -db sports, -1, -y

Progress client startup options:

- A = 0 | -d = mdy | -D = 100 | -h = 7
- hs = 0 | -Mpte = 0 | -Mxs = -1 | -nb = 90 | -Nb = 0
- NL = 0 | -o = printer | -p = (null)
- q = 0 | -q = 0 | -s = 40 | -T =
- t = 1 | -TB = 8 | -TM = 8 | -yy = 1950 | -25 = 0

DataServer startup options:

- nojoinbysqldb = 0
- SQLlogging = 0
- noSQLbyserver = 0
- noindexhint = 0

Database: sports

- l = 1 | -a = (null)
- B = 100 | -c = 20 | -cl = 0 | -cp = (null)
- cs = 8 | -da = 0 | -db sports
- dt = (null) | -g = (null)
- H = (null) | -i = 1 | -I = 25 | -L = 8192 | -ld = sports
- Ma = 0 | -MF = 0 | -Mi = 1 | -Mm = 1024 | -Mn = 5
- Mr = 1012 | -n = 1 | -N = | -O = -1 | -R = 1
- RO = 0 | -S = (null)

Execution buffer map: 09:19:32

<table>
<thead>
<tr>
<th>Size</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>2250</td>
<td>adecomm/_pwwinst.r</td>
</tr>
<tr>
<td>9798</td>
<td>adecomm/_pwexit.r</td>
</tr>
<tr>
<td>3232</td>
<td>adecomm/_kvlist.r</td>
</tr>
<tr>
<td>1867</td>
<td>adecomm/_uniqfil.r</td>
</tr>
<tr>
<td>1837</td>
<td>adecomm/_wfrun.r</td>
</tr>
<tr>
<td>8639</td>
<td>adecomm/_toollic.r</td>
</tr>
<tr>
<td>34355</td>
<td>adecomm/_runcode.r</td>
</tr>
<tr>
<td>2202</td>
<td>adecomm/_osprefix.r</td>
</tr>
<tr>
<td>7589</td>
<td>adecomm/_mnkvals.r</td>
</tr>
<tr>
<td>982</td>
<td>adecomm/_osfext.r</td>
</tr>
<tr>
<td>7033</td>
<td>_login.r</td>
</tr>
</tbody>
</table>
### Example 7–4: Sample -y startup parameter statistics (2 of 2)

<table>
<thead>
<tr>
<th>Times</th>
<th>Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reads from temp file:</td>
<td>0</td>
</tr>
<tr>
<td>Writes to temp file:</td>
<td>0</td>
</tr>
<tr>
<td>Loads of .r programs:</td>
<td>26</td>
</tr>
<tr>
<td>Saves of compilation .r's:</td>
<td>0</td>
</tr>
<tr>
<td>Compilations of .p's:</td>
<td>2</td>
</tr>
<tr>
<td>Checks of files with stat:</td>
<td>107</td>
</tr>
</tbody>
</table>

Memory usage summary:

<table>
<thead>
<tr>
<th>Current</th>
<th>Max Used</th>
<th>Limit (Bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stack usage (-s):</td>
<td>60</td>
<td>40944</td>
</tr>
<tr>
<td>Local buffer usage:</td>
<td>1952</td>
<td>30016</td>
</tr>
<tr>
<td>R-code Execution Buffer:</td>
<td>514984</td>
<td>514984</td>
</tr>
</tbody>
</table>

Segment Descriptors Usage: (numbers)

<table>
<thead>
<tr>
<th>Max Used</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>288</td>
<td>480</td>
</tr>
</tbody>
</table>

---

**Note:** The database statistics appear because the startup parameter connects to a database (-db sports, -1).
Example 7–5 shows the -yd r-code segment statistics generated on execution of execlog.p. (See Example 7–3 for sample code of execlog.p.)

**Example 7–5: Sample r-code segment statistics**

<table>
<thead>
<tr>
<th>Segment</th>
<th>Read/Write</th>
<th>Times</th>
<th>Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>execlog.p</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>execlog2.p</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Per procedure segment information

<table>
<thead>
<tr>
<th>File</th>
<th>Segment</th>
<th>#Segments</th>
<th>Total-Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>execlog.p</td>
<td>Initial</td>
<td>1</td>
<td>424</td>
</tr>
<tr>
<td></td>
<td>A-Code: 1</td>
<td>1</td>
<td>836</td>
</tr>
<tr>
<td></td>
<td>E-Code: 1</td>
<td>1</td>
<td>160</td>
</tr>
<tr>
<td></td>
<td>Debugger</td>
<td>1</td>
<td>180</td>
</tr>
<tr>
<td></td>
<td>Int-Pro: 1</td>
<td>1</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>Frame: 1</td>
<td>1</td>
<td>460</td>
</tr>
<tr>
<td></td>
<td>Frame: 2</td>
<td>1</td>
<td>400</td>
</tr>
<tr>
<td></td>
<td>Frame: 3</td>
<td>1</td>
<td>400</td>
</tr>
<tr>
<td></td>
<td>Text: 1</td>
<td>1</td>
<td>175</td>
</tr>
</tbody>
</table>

| execlog2.p | Initial  | 1         | 280        |
|            | A-Code: 1 | 1         | 320        |
|            | E-Code: 1 | 1         | 144        |
|            | Debugger  | 1         | 88         |
|            | Frame: 1  | 1         | 400        |
|            | Text: 1   | 1         | 38         |

Example 7–6 shows the -yx statistics generated on execution of execlog.p. (See Example 7–3 for sample code of execlog.p.)

**Example 7–6: Sample procedure call statistics**

Thu Jan 03 15:21:40 2002

<table>
<thead>
<tr>
<th>Caller</th>
<th>Callee</th>
<th>Load</th>
<th>Size</th>
<th>Calls</th>
<th>Rd</th>
<th>Bytes</th>
<th>Reread</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;top&gt;</td>
<td>execlog</td>
<td>3291</td>
<td></td>
<td>1</td>
<td></td>
<td>0</td>
<td>0</td>
<td>1953</td>
</tr>
<tr>
<td>execlog</td>
<td>execlog2</td>
<td>1270</td>
<td></td>
<td>1</td>
<td></td>
<td>0</td>
<td>0</td>
<td>16</td>
</tr>
</tbody>
</table>

For detailed information on statistics startup parameters, see *OpenEdge Deployment: Startup Command and Parameter Reference*. For a description of the SHOW-STATS statement, see *OpenEdge Development: ABL Reference*. 
**Analyzing ABL code**

Use the following resources and tools, in addition to the OpenEdge Debugger, to analyze your ABL code:

- Debug Alert startup parameter
- Enhanced logging features
- **STARTUP-PARAMETERS** attribute of the SESSION system handle
- ProSpy Plus

**Debug Alert startup parameter**

The Debug Alert (-debugalert) startup parameter places a Help button on alert dialog boxes displayed by a client application that provides access to a Stack Trace dialog box and the Debugger. For more information, see the “Debugging from alert dialog boxes” section on page 2–14.

**Enhanced logging features**

Use the enhanced logging features available in OpenEdge to monitor and control all aspects of logging, including the extent and type of information logged, and the size and retention of log files. For more information, see Chapter 5, “Logging in OpenEdge.”

**STARTUP-PARAMETERS** attribute of the SESSION system handle

Use the **STARTUP-PARAMETERS** attribute of the SESSION system handle to obtain a comma-separated list of all startup parameters specified for the current OpenEdge session. The character string returned includes startup parameters from the following potential sources:

- Default startup parameter file ($DLC/startup.pf)
- File specified by the $PROSTARTUP environment variable
- Startup parameters specified on the command line
- Startup parameters specified in a parameter file (.pf)

Example 7–7 shows the STARTUP-PARAMETERS attribute output generated by executing execlog.p. (See also Example 7–3.)

**Example 7–7: Sample STARTUP-PARAMETERS output**

```
-pf C:\Progress\OpenEdge\startup.pf,-cpinternal ISO8859-1,-cpstream ISO8859-1,-cpcoll Basic,-cpcase Basic,-d mdy,-numsep 44,-numdec 46,(end .pf),-db sports,-l
```

See OpenEdge Development: ABL Reference for detailed information on the STARTUP-PARAMETERS attribute.
**ProSpy Plus**

ProSpy Plus is a debugging tool you can use to record a stack trace of ABL execution at runtime. It also records the instantiation of classes (generated by the NEW statement) and the invocation of methods defined within classes (generated by the SUPER and DELETE OBJECT statements or the INVOKE() method). You can turn tracing on and off at the beginning and end of execution, with the click of a button. The results of tracing, which include all procedures, triggers, publish, subscribe, and unsubscribe executions, as well as user defined functions executed during the tracing period, appear in a hierarchical treeview interface. This allows a user to navigate through a stack trace to see as much or as little, execution information as they need or want.

To learn more about this tool, consult the online help for ProSpy Plus.

**Generating a protrace file for a running program**

You can force the creation of a protrace file, which contains stack traces and other information, for an OpenEdge process that is currently executing. OpenEdge automatically writes this file when a program terminates abnormally, but in some cases you might want to generate it while the program is running. For more information about the file, see the "protrace file" section on page 7–3.

You use the script `proGetStack.bat` (Windows) or `proGetStack` (UNIX) for this purpose. To run the script, enter the following at a command prompt:

```
proGetStack  process_ID
```

Generating a protrace file in this way does not stop execution of the OpenEdge session.

**Note:** On Windows, the protrace file generated by the `proGetStack.bat` script does not include an AVM stack trace.
Analyzing procedures and queries

Use the following resources and tools to analyze your procedures and queries:

- **XREF option of the COMPILE statement**
- **INDEX–INFORMATION attribute of the query object handle**

**COMPILE XREF option**

The XREF option of the COMPILE statement provides a variety of static data about an ABL procedure, including:

- Other procedures that are **RUN**
- Text strings that exist in the procedure
- Code pages, include files, and shared variables used
- Events published, subscribed, and unsubscribed to
- Database tables accessed
- Indexes used for a particular database query

Example 7–8 shows the XREF option output generated by executing execlog.p.
(See Example 7–3 for sample code of execlog.p.)

**Example 7–8: Sample XREF option output**

```
execlog.p execlog.p 1 COMPILE execlog.p
execlog.p execlog.p 1 CPINTERNAL iso8859-1
execlog.p execlog.p 1 CPSTREAM ibm850
execlog.p execlog.p 1 STRING "ix" 2 NONE UNTRANSLATABLE
execlog.p execlog.p 3 STRING "Customer" 8 NONE UNTRANSLATABLE
execlog.p execlog.p 3 ACCESS sports.Customer Name
execlog.p execlog.p 3 SEARCH sports.Customer Name WHOLE-INDEX
execlog.p execlog.p 4 ACCESS sports.Customer Name
execlog.p execlog.p 4 STRING "x(20)" 5 NONE TRANSLATABLE FORMAT
execlog.p execlog.p 9 STRING "->,>>,>9" 10 NONE TRANSLATABLE FORMAT
execlog.p execlog.p 14 STRING "ii" 2 NONE UNTRANSLATABLE
execlog.p execlog.p 15 STRING "Number of Customers is " 23 NONE TRANSLATABLE
execlog.p execlog.p 15 STRING "x(23)" 5 NONE TRANSLATABLE FORMAT
execlog.p execlog.p 15 STRING "->,>>,>9" 10 NONE TRANSLATABLE FORMAT
execlog.p execlog.p 16 STRING "ii" 2 LEFT TRANSLATABLE
execlog.p execlog.p 16 STRING "                         ----------------" 42
execlog.p execlog.p 16 PROCEDURE internalA,,INPUT ii INTEGER
execlog.p execlog.p 16 STRING "INTERNALA" 9 NONE UNTRANSLATABLE
execlog.p execlog.p 16 STRING "ix" 2 LEFT TRANSLATABLE
execlog.p execlog.p 16 STRING "----------------" 16 NONE UNTRANSLATABLE
execlog.p execlog.p 16 STRING "Name" 4 LEFT TRANSLATABLE
execlog.p execlog.p 16 STRING "Name" 4 NONE UNTRANSLATABLE
execlog.p execlog.p 16 STRING "----------------" 22 NONE UNTRANSLATABLE
execlog.p execlog.p 16 STRING "Name" 4 NONE UNTRANSLATABLE
execlog.p execlog.p 8 RUN execlog2.p
```

For detailed information on the XREF option, see *OpenEdge Development: ABL Reference.*
INDEX-INFORMATION attribute of the query object handle

The INDEX-INFORMATION attribute provides data on a dynamic query similar to what XREF provides on a static query. For example, given a dynamic query q1, where the QUERY-PREPARE string is:

```plaintext
FOR EACH customer WHERE customer.custnum < 3, EACH order OF customer, EACH orderline
```

The query returns these attribute values:

```plaintext
q1:INDEX-INFORMATION[1] = "Cust-Num"
q1:INDEX-INFORMATION[1] = "Cust-Order"
q1:INDEX-INFORMATION[1] = "WHOLE-INDEX,order-line"
```

For detailed information on the INDEX-INFORMATION attribute, see OpenEdge Development: ABL Reference.

To obtain additional query information and statistics use the QryInfo log entry type. For detailed information see the “Query information logging” section on page 6–35.
# Index

## Symbols
- (underscore) files 3–50, 4–6

## Numbers
4GLMessages log entry type 5–13
4GLTrace log entry type 5–13
4GLTrans log entry type 5–14

## A
ABL debugger control
features 1–6
ABL lines
executable and non-executable 1–12
ABL message logging
log entry types 5–13
log entry types detail 6–3
message format 6–3
ABL stack trace pane 3–4
ABL trace logging 6–4
log entry types 5–13
log entry types detail 6–4
message format 6–4
return message format 6–6
ABL transaction logging
log entry types 5–14
log entry types detail 6–7
message format 6–7
Accelerator keys
described 3–13
Active procedures
defined 1–11
Add Watch dialog box 3–22
AIA logging
log entry types 5–14
log entry types detail 6–9
message format 6–9
AiaDefault log entry type 5–14
AiaMgmt log entry type 5–14
AiaProp log entry type 5–14
AiaRqst log entry type 5–14
AiaUBroker log entry type 5–14
Alert-boxes
debugging 2–14
SESSION handle 4–8
Analyzing ABL code 7–10
Analyzing procedures and queries 7–12
Application control 1–3
Application mode
DEBUGGER handle 4–4
defined 2–2
exiting 2–3
hiding the invoking procedure 4–6
Applications
stacking 2–9
AppServer logging
  log entry types 5–14
  log entry types detail 6–10
  message format 6–10
ASDefault log entry type 5–14
ASPlumbing log entry type 5–14
Asynchronous remote procedures
debbuging 1–15
Attach to Process dialog box 3–23
Attachable mode
debbug ready 2–5, 2–6, 3–24
defined 2–4
detaching 2–18
r-code requirements 2–5

B

BLOB data type 3–6
Breakpoint indicator
defined 3–4
Breakpoint management
features 1–6
Breakpoints 3–25
  adding to procedure 3–39, 3–42
  adding watchpoint to watch 3–44
  conditional 3–41
defined 1–4, 3–25
  edit 3–37
  edit watchpoint 3–37
  error-based 3–42
  procedure names and line numbers 3–40
  setting watchpoints 3–43
  watchpoint conditions 3–44
  watchpoint expressions 3–44
Breakpoints dialog box 3–25
  brkrLogAppend property 5–8
  brkrLogEntryTypes property 5–17
  brkrLogFile property 5–7
  brkrLoggingLevel property 5–19
  brkrLogThreshold property 5–10
  brkrNumLogFile property 5–11

C

Clear Log File (-clearlog) startup parameter 5–8
CLEAR-LOG( ) method 5–8
-clealog startup parameter 5–8
-clientlog startup parameter 5–7
CLOB data type 3–6
CLOSE-LOG( ) method 5–9
Code path analysis
features 1–5
Command entry
menu options 3–13
Commands
  proDebugConfig 2–6
  proDebugEnable 1–7
COMPILE XREF option 7–12
Conditional breakpoints 3–41
core dump file 7–4
CRC. See Cyclic redundancy check
Current procedure
defined 1–13
Cyclic redundancy check 3–49

D

Data
debbuger context 1–12
Data analysis
features 1–5
Data management
features 1–5
Data manipulation
features 1–5
Data menu 3–17
Data types
  BLOB 3–6
  CLOB 3–6
  DATETIME 3–6
  LONGCHAR 3–6
Database connection logging
  log entry types 5–14
  log entry types detail 6–11
  message format 6–11
Dataview dialog box 3–26
  Array tab 3–29
  Attributes tab 3–27
  Fields tab 3–28
  Value tab 3–30
DATETIME data type 3–6

DB.Connects log entry type 5–14

Debug Alert (-debugalert) startup parameter 7–10

Debug listing
  defined 3–3
  displaying 3–3
  name 3–12

Debug listing files 3–48
  creating 3–48
  deleting 3–48
  format 3–3
  generating 3–49
  r-code 3–49
  source code 3–49
  locating 3–49

Debug menu 3–15

Debug ready 2–5
  Attach to Process dialog box 3–24
  Debugger window 2–5, 3–24
  proDebugConfig command 2–6
  Ready Attachable Debugger
  (-debugReady) startup parameter 2–6
  -debug startup parameter 2–13
  -debugalert startup parameter 7–10

Debugger
  features 1–3, 1–5, 1–6
  functions 1–3
  modes of operation 2–2
  overview 1–9
  starting from alert boxes 2–14
  starting from an ABL procedure 2–17
  starting from the ADE Desktop 2–12
  starting from the AppBuilder 2–11
  starting from the command line 2–13
  starting from the Procedure Editor 2–10
  starting in attachable mode 2–18
  starting with the -debug startup parameter 2–13
  system requirements 1–2

Debugger context 1–11
  active procedures 1–11
  callback procedures 1–12
  current procedure 1–13
  data 1–12
  defined 1–11
  execution status 1–12
  focus 1–13
  inactive procedures 1–11
  persistent procedures 1–12
  procedure call stack 1–13
  procedures 1–11

Debugger dialog boxes 3–22
  Add Watch 3–22
  Attach to Process 3–23
  Breakpoints 3–25
  Dataview 3–26
    Array tab 3–29
    Attributes tab 3–27
    Field tab 3–28
    Value tab 3–30
  Dynamic Object Tracking 3–32
  Control Monitoring tab 3–32
  View Objects tab 3–34
  Edit Breakpoint 3–36
    At Line tab 3–36
    On Error tab 3–36
    Watchpoint tab 3–36
  Find 3–37
  New Breakpoint 3–38
    At Line tab 3–38
    On Error tab 3–38
    Watchpoint tab 3–39
  Open 3–44
  Preferences 3–45
    Attachable tab 3–46
    Font tab 3–45
    Settings tab 3–45
  Select Process 3–47

Debugger files 3–48
  attachable mode location 3–49
  listing files 3–48
  listing generation 3–49
  Procedure files 3–49

DEBUGGER handle
  application mode 4–4
  attributes and methods 4–2
  blocking the invoking procedure 4–6
  breakpoints 4–4
  code path analysis 4–4
  DEBUG method 4–6
  debugging tools 4–6
described 4–1
  INITIATE method 4–4
  invoking procedure 4–4
  SET-BREAK method 4–4
  stand-alone mode 4–6
  starting the Debugger 4–4
  subprocedure debugging 4–5

Debugger window
  ABL stack trace pane 3–4
  accelerator keys 3–13
  Data menu 3–17
  debug listing 3–3
  Debug menu 3–15
  Diagnostics menu 3–17
dialog boxes. See Debugger dialog boxes
  Edit menu 3–14
  File menu 3–13
  Help menu 3–18
  layout 3–2
Index

listing indicators 3–4
menu bar. See Menus
Menus 3–13
overview 3–1
panes 3–3
Run to Line command 3–4
Search menu 3–14
source code pane 3–3
status bar 3–21
text selection 3–4
title bar 3–12
tool bar 3–19
toolbar 3–19
variables pane 3–5
View menu 3–15
viewing arrays 3–5
viewing BLOB data type 3–6
viewing CLOB data type 3–6
viewing DATETIME data type 3–6
viewing LONGCHAR data type 3–6
viewing ProDataSet objects 3–8
viewing Progress.Language.ProObject datatype 3–6
watches pane 3–8
Window menu 3–17

Debugger-application interaction 1–9
application control 1–10
debugger control 1–9

Debugger-client interaction 1–9

Debugging
Asynchronous remote procedures 1–15
asynchronous requests 1–15
distributed debugging 1–14
enabling 1–7
remote debugging 1–15

Debugging modes 2–2
application mode 2–2
attachable mode 2–18
DEBUGGER handle 4–4
stand-alone mode 2–3

Debugging sessions
defined 1–1
overview 1–9
-debugReady startup parameter 2–6

Diagnostics menu 3–17

Distributed debugging 1–14
applications 1–14
compatibility issues 1–15
definition 1–14
environment 1–14
remote debugging 1–15

Dump files
core 7–4
procore 7–2
protrace 7–3, 7–11

Dynamic object logging 6–13
log entry types 5–15
log entry types detail 6–13
message format 6–18

Dynamic object monitoring
features 1–6

Dynamic Object Tracking dialog box 3–32
Control Monitoring tab 3–32
View Objects tab 3–34

DynObjects.Class log entry type 5–15
DynObjects.DB log entry type 5–15
DynObjects.Other log entry type 5–15
DynObjects.UI log entry type 5–15
DynObjects.XML log entry type 5–15

E

Edit Breakpoint dialog box 3–36
At Line tab 3–36
On Error tab 3–36
Watchpoint tab 3–36

Edit menu 3–14

Enabling
debugging 1–7

Error-based breakpoints 3–42

Event logging
generation 6–20
information logged 6–22
log entry types 5–16
log entry types detail 6–20
logged events 6–21
message formats 6–26
sample logs 6–30
stack 6–20

Executable line
defined 1–12

Execution monitoring 1–5

Execution status 1–12
F

Failure conditions 7–5

File access logging
  log entry types 5–15
  log entry types detail 6–32
  message format 6–32

File menu 3–13

FileID log entry type 5–15

Filenames
  logging 5–12

Files
  debug listing 3–48
  procedure. See Procedure files

Find dialog box 3–37

G

Garbage collection
  and Step Into command 3–15, 3–19

Generating query information 6–38

H

Help menu 3–18

I

Ignored operation logging
  log entry types detail 6–33

Inactive procedures
defined 1–11

INDEX-INFORMATION attribute of query
  object handle 7–13

Indicators
  breakpoint 3–4
  line pointer 3–4

Interrupt function
defined 1–4

L

Line pointer indicator
defined 3–4

Lines
  executable and nonexecutable 1–12

Listing
  indicators 3–3

Listing generation 3–49

Listing management
  features 1–6

Listing name 3–3, 3–12

Log entry types
  4GLMessages 5–13
  4GLTrace 5–13
  4GLTrans 5–14
  AiaDefault 5–14
  AiaMgmt 5–14
  AiaProp 5–14
  AiaRqst 5–14
  AiaUBroker 5–14
  ASDefault 5–14
  ASPlumbing 5–14
  DB.Connects 5–14
  DynObjects.Class 5–15
  DynObjects.DB 5–15
  DynObjects.Other 5–15
  DynObjects.UI 5–15
  DynObjects.XML 5–15
  FileID 5–15
  MsgrTrace 5–15
  NSPlumbing 5–16
  ProEvents.UI.Char 5–16
  ProEvents.UI.Command 5–16
  ProEvents.UI.Other 5–16
  QryInfo 5–16
  SAX 5–16
  UBroker.All 5–16
  UBroker.AutoTrim 5–16
  UBroker.Basic 5–16
  UBroker.ClientFSM 5–16
  UBroker.ClientMemTrace 5–16
  UBroker.ClientMsgQueue 5–16
  UBroker.ClientMsgStream 5–16
  UBroker.ServerFSM 5–16
  UBroker.ServerMemTrace 5–16
  UBroker.ServerMsgQueue 5–16
  UBroker.ServerMsgStream 5–16
  UBroker.Stats 5–16
  UBroker.ThreadPool 5–16
  WSADefault 5–16

Log Entry Types (-logentrytypes) startup
  parameter 5–17, 5–18

Log File Name (-clientlog) startup
  parameter 5–7

Log files 5–6
  clearing 5–7
  closing 5–9
  rolling over 5–12
  size threshold 5–10
  writing user messages 5–8

Index–5
Log Size Threshold (-logthreshold) startup parameter 5–10
logAppAppend property 5–8
LOG-ENTRY-TYPES attribute 5–17
logEntryTypes property 5–17
-logentrytypes startup parameter 5–17, 5–18
logFile property 5–7, 5–11
LOGFILE-NAME attribute 5–7
logged objects 6–13

Logging categories
ABL messages 6–3
ABL trace 6–4
ABL transaction 6–7
AIA 6–9
AppServer 6–10
Database connection 6–11
Dynamic object 6–13
Events 6–20
File access 6–32
Ignored operation 6–33
NameServer 6–34
Query information 6–35
SAX parser 6–50
Unified Broker 6–51
Web Services Adapter 6–53
WebSpeed Messenger 6–56

Logging infrastructure 5–2
Logging Level (-logginglevel) startup parameter 5–19
Logging levels 5–18
LOGGING-LEVEL attribute 5–19
loggingLevel property 5–19
-logginglevel startup parameter 5–19
LOG-MANAGER handle
attributes and methods 5–3
LOG-MANAGER system handle
CLEAR-LOG( ) method 5–8
CLOSE-LOG( ) method 5–9
LOG-ENTRY-TYPES attribute 5–17
LOGFILE-NAME attribute 5–7
LOGGING-LEVEL attribute 5–19
LOG-THRESHOLD attribute 5–10
NUM-LOG-FILE attribute 5–11
WRITE-MESSAGE( ) method 5–8
LOG-THRESHOLD attribute 5–10
logThreshold property 5–10
-logthreshold startup parameter 5–10
LONGCHAR data type 3–6

M
Menu accelerator keys 3–13
Menu bar. See Menus
Menus 3–13
accelerator keys 3–13
data 3–17
diag 3–15
diagnostics 3–17edit 3–14
file 3–13
help 3–18
search 3–14
view 3–15
window 3–17
Message formats
ABL message logging 6–3
ABL trace logging 6–4, 6–6
ABL transaction logging 6–7
AIA logging 6–9
AppServer logging 6–10
Database connection logging 6–11
Dynamic object logging 6–18
Event logging 6–26
File access logging 6–32
NameServer logging 6–34
Query information logging 6–47, 6–48
SAX parser logging 6–50
Unified Broker logging 6–51
Web Services Adapter logging 6–55
WebSpeed Messenger logging 6–56
Mnemonics 3–13
MsgrTrace log entry type 5–15

N
NameServer logging
log entry types 5–16
log entry types detail 6–34
message formats 6–34
New Breakpoint dialog box 3–38
At Line tab 3–38
On Error tab 3–38
Watchpoint tab 3–39
No Evaluation of Properties (-noevalprops)
startup parameter 3–7, 3–8, 3–9
-noevalprops startup parameter 3–7, 3–8, 3–9

Nonexecutable line
defined 1–12

NSPlumbing log entry type 5–16

Number of Log Files (-numlogfiles) startup parameter 5–11

NUM-LOG-FILES attribute 5–11

numLogFiles property 5–11

-numlogfiles startup parameter 5–11

O

Objects
ProDataSet 3–8
Progress.Language.ProObject 3–6
tracking 3–32

Open and incremental execution 1–4

Open dialog box 3–44

P

Panes 3–3

Persistent procedures
debugger context 1–12

Preferences dialog box 3–45
Attachable tab 3–46
Font tab 3–45
Settings tab 3–45

Procedure call stack 1–13
defined 1–3

Procedure execution
features 1–4

Procedure files 3–49
CRC values 3–49
generating source code listings 3–49
hidden 3–50
r-code listing generation 3–49

Procedure interruption
features. See Breakpoint management features

Procedure names
leading underscore (_) 1–13

Procedure termination
features 1–5

Procedures
debugger context 1–11
persistent
making active 1–12

procore dump file 7–2

ProDataSet object 3–8

proDebugConfig command 2–6

proDebugEnable command 1–7

ProEvents.UI.Char log entry type 5–16

ProEvents.UI.Command log entry type 5–16

ProEvents.UI.Other log entry type 5–16

proGetStack script 7–11

Progress Explorer setting log characteristics 5–20

Progress.Language.ProObject datatype 3–6

Properties
brkrLogAppend 5–8
brkrLogEntryTypes 5–17
brkrLogFile 5–7
brkrLoggingLevel 5–19
brkrLogThreshold 5–10
brkrNumLogFiles 5–11
disabling evaluation of 3–7, 3–8, 3–9
logAppend 5–8
logEntryTypes 5–17
LogFile 5–7, 5–11
logging settings 5–20
loggingLevel 5–19
logThreshold 5–10
numLogFiles 5–11
srvLogWatchDogInterval 5–12
srvrLogAppend 5–8
srvrLogEntryTypes 5–17
srvrLogFile 5–7
srvrLoggingLevel 5–19
srvrLogThreshold 5–10
srvrNumLogFiles 5–11

ProSpy Plus 7–11

protrace dump file 7–3, 7–11

Q

QryInfo log entry type 5–16

Query information logging 6–35
code constructs 6–38
identifying indices 6–41
information logged 6–40
Index

log entry types 5–16
log entry types detail 6–35
message formats 6–48
query plan 6–40
query statistics 6–42
sample logs 6–47
starting logging 6–36

R
R-code
requirements for attachable debugging mode 2–5
usage statistics 7–6
Ready Attachable Debugger (-debugReady)
startup parameter 2–6
Remote debugging
definition 1–15
Rolled-over log files 5–12
Run to Line command 3–4
Run-time diagnostics 7–6

S
Sample logs
event logging 6–30
first pre-pass query output 6–49
query plan output 6–48
query statistics output 6–48
second pre-pass query output 6–49
SAX log entry type 5–16
SAX parser logging
log entry types 5–16
log entry types detail 6–50
message format 6–50
sample log 6–50
Search menu 3–14
Select Process dialog box 3–47
SESSION handle
alert boxes 2–14, 4–8
described 4–1
starting the Debugger 4–8
STARTUP-PARAMETERS attribute 7–10
Stack trace 2–14
Session management 1–6
Source code pane 3–3
displaying 3–3
indicators 3–4
label 3–3, 3–12
text selection 3–4
Specifying
component logging characteristics 5–2
log entry types 5–16
log filename 5–6
log settings with Progress Explorer 5–20
log size threshold 5–10
logging level 5–18
retained log files 5–11
srvLogWatchDogInterval property 5–12
srvrLogAppend property 5–8
srvrLogEntryTypes property 5–17
srvrLogFile property 5–7
srvrLoggingLevel property 5–19
srvrLogThreshold property 5–10
srvrNumLogFiles property 5–11
Stacking applications 2–9
Stand-alone mode
DEBUGGER handle 4–4
hiding the invoking procedure 4–6
defined 2–3
Starting the Debugger
from alert boxes 2–14
from an ABL procedure 2–17
from the ADE Desktop 2–12
from the AppBuilder 2–11
from the command line 2–13
from the Procedure Editor 2–10
in attachable mode 2–18
with the -debug startup parameter 2–13
Startup parameters
Attachable Debugger (-debugReady) 2–6
Clear Log File (-clearlog) 5–8
Debug Alert (-debugalert) 7–10
Debugger (-debug) 2–13
Log Entry Types (-logentrytypes) 5–17, 5–18
Log File Name (-clientlog) 5–7
Log Size Threshold (-logthreshold) 5–10
Logging Level (-logginglevel) 5–19
Number of Log Files (-numlogfiles) 5–11
STARTUP-PARAMETERS attribute 7–10
Statistics 7–6
Status bar 3–21
System handles
- DEBUGGER 4–2
- LOG-MANAGER 5–3
- SESSION 4–8

System requirements 1–2

T

Text selection
source code pane 3–4

Title bar 3–12

Toolbar 3–19

Transaction monitoring
features 1–6

Trigger blocks
debugger context 1–11

U

UBroker.All log entry type 5–16

UBroker.AutoTrim log entry type 5–16

UBroker.Basic log entry type 5–16

UBroker.ClientFSM log entry type 5–16

UBroker.ClientMemTrace log entry type 5–16

UBroker.ClientMsgQueue log entry type 5–16

UBroker.ClientMsgStream log entry type 5–16

UBroker.ServerFSM log entry type 5–16

UBroker.ServerMemTrace log entry type 5–16

UBroker.ServerMsgQueue log entry type 5–16

UBroker.ServerMsgStream log entry type 5–16

UBroker.Stats log entry type 5–16

UBroker.ThreadPool log entry type 5–16

Unified Broker logging
log entry types 5–16
log entry types detail 6–51
message format 6–51

Usage statistics 7–6

V

Variables pane 3–5

View menu 3–15

W

Watch
Add Watch option 3–8
defined 3–8
drag and drop watches 3–11
supported ABL functions 3–10
valid formats 3–9
watching ABL functions 3–10

Watches pane 3–8

Watchpoints
adding watchpoint to watch 3–44
conditions 3–44
defined 3–25
edit 3–37
expressions 3–44
setting 3–43

Web Services Adapter logging
log entry types 5–16
log entry types detail 6–53
message format 6–55

WebSpeed Messenger logging
log entry types 5–15
log entry types detail 6–56
message format 6–56

Window layout 3–2

Window menu 3–17

Window settings
features 1–6

WRITE-MESSAGE( ) method 5–8

WSADefault log entry type 5–16